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Harga Rp. 4.800,- (Pulau Jawa), Rp. 5.300,- (Luar Jawa)
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TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

EDISI LEBIH TEBAL DAN
LETAK KUPON

Yth. Redaksi PCplus, Salam
hangat selalu untuk sleuruh crew
PC+. Edisi 146 yang katanya dalam
rangka ulang tahun PC+ yang
ketiga saya acungkan jempol
untuk tebalnya..Udah lama kan
nggak nerbitin 40 halaman
dengan harga yang tetap...and
kertasnya juga bagus... But ada
yang nggak enak nih, kok tempat
untuk kupon kuis ditaruh di
tempat yang kurang pas karena di
baliknya kan artikel
plusDownload. Sayang sekali kan
soalnya saya salah satu pelanggan
setiamu yang selalu mengoleksi
setiap edisinya. Segitu aja and
bravo PCplus

Dalfianto
dfian@hotmail.com

Red: Edisi 146 bukan dalam rangka
ulang tahun ke-3, tapi dalam rangka
menyambut pameran Indocomtech.
Edisi ulang tahun akan terbit di nomor
149, rencananya halaman lebih tebal
dari 40 halaman. Thanks untuk
apresiasinya. Kupon di edisi ini sudah
digeser ke bagian bawah, tentu saja
merespon masukan dari Anda, Bung
Dalfi.

CD LINUX
Menurut PCplus di mana saya

dapat mendapatkan CD yang
berisi cara penggunaan Linux?

kalau PCplus punya, di mana saya
bisa mendapatkannya?

some132@myself.com

Red: Kami memang menerbitkan CD
Linux. Tapi maaf sekali, berhubung
cetak terbatas, untuk saat ini CD
tersebut hanya diedarkan melalui
workshop-workshop dan belum dijual
secara komersial.

PELANGGAN SOLO
BERTANYA

Salam Plus Plus. Hello
Bung&Mbak Redaksi, sebagai
pelanggan setia tabloid ini, saya
ingin menanyakan beberapa hal,
yaitu:
1. Apakah PCplus selalu

menyertakan CD atau bonus
lainnya pada setiap
terbitannya? Sebab saya
berlangganan di agen dan tidak
pernah menerima
bonus dari PCplus.

2. Kenapa di Kota Solo tidak
pernah diadakan workshop?
Penggemar Anda
di Solo iri lho!

3. Saya usul agar PCplus
menyertakan CD lengkap di
setiap terbitannya. Contoh: bila
setiap terbit mengupas dunia
Linux, maka sertakan software
agar pelanggan jadi pintar.

4. Kemarin saya upload Web di
Geocities & sukses, namun saat
saya check

gambarnya tidak ikut muncul
(gambar  jpeg, gif, Bmp, dan
lain-lain). Tolong untuk edisi
minggu depan Anda kupas
secara tuntas berikut trouble-
shot-nya, PCplus edisi kemarin
tentang dreamweaver + upload-
nya kurang detail, Web saya
juga ada musiknya namun tidak
keluar bahkan error page.

5. Rekan saya membutuhkan
alamat e-mail Human Technol-
ogy (Human Body Repair)
terutama yang membutuhkan
sukarelawan untuk uji coba
tubuh, mohon PCplus memberi
alamat e-mail-nya.

Akhir kata, sekian dan terima
kasih atas bantuannya, selalu sehat
dan sukses untuk PCplus juga semua
crew Redaksi, salam.

Dari Pelanggan Solo
++PCplus MaNiAc2003

Adib Susanto
existindo@plasa.com

Red: 1. Tidak. 2. Belum ketemu kontak
dengan penyelenggara lokalnya. Anda
mau? Kirimkan penawaran kerja sama
ke jimmy@e-pcplus.com. 3. Usul
masih sulit direalisasikan mengingat
PCplus terbit setiap minggu. 4.
Kemungkinan besar, gagalnya karena
proses upload tidak sempurna. 5. Kami
sarankan untuk menggunakan fasilitas
mesin pencari seperti Google, Yahoo,
dan sebagainya.

HARGA DITURUNKAN!
Saya adalah seorang

penggemar kamu, meski nggak
selalu beli :). Saya cuma mau usul aja
sedikit. Tapi jangan kesinggung
yach. Kalo bisa harganya diturunin
donk biar pas ama kantong
mahasiswa, apalagi yang ngekost.
Khan kasian kalo nggak bisa bayar
kost karena harus beli PCplus. Saya
tertarik dengan dunia bawah tanah
komputer, tolong donk dimuat
artikel yang membahas masalah
tersebut, kayak masalah virus,
worm, dan trojan. BTW, kok
sekarang makin jarang aja artikel
virusnya ya....Usul lagi, jangan
banyak iklan deh. Emang sih bisa
dapat pemasukan dari iklan, tapi
diimbangilah. Terakhir, rubrik ponsel
dihapus aja. Kurang bagus (menurut
saya sih), terus diganti sama rubrik
download/trik aja. Itu aja deh..

Aziiz
Jawa Barat

Red: Maaf, tapi jangan kesinggung,
untuk saat ini sulit menurunkan harga
PCplus. Usulan yang lain kami tampung
untuk kami bicarakan di sidang Redaksi.
Thanks.

RUBRIK PLUSPONSEL DAN
HADIAH KUIS

Halo rekan-rekan di Redaksi,
saya mau usul nih. Rubrik
plusPonsel sebaiknya tetap
diadakan, namun yang dibahas
hanyalah perkembangan

teknologinya saja, jangan
membahas tentang harga dan
ringtone yang hubungannya gak
terlalu penting bagi dunia TI.

Trus gimana kalo PCplus juga
membahas software-software yang
bersifat free namun fungsinya gak
kalah dengan software-software
komersil, dan usul lagi nih kalo' bisa
ngadain kuis yang hadiahnya ada
hubungannya dengan dunia TI atau
bisa langganan PCplus selama
beberapa periode donk!! Jgn yang
hadiahnya kaos ama topi melulu,
kan orang-orang juga jadi pada
males ngirimnya.

Fajar Ismael
blazer17147@centrin.net.id

Red: Terima kasih masukannya untuk
usulan rubrik. Hadiah kuis akan kami
pertimbangkan untuk diubah lebih
menarik.

BERLANGGANAN PCPLUS
Salam hormat, Semoga dalam

menjalankan tugas sehari-hari,
seluruh dewan direksi, staf dan
karyawannya senantiasa mendapat
perlindungan dan limpahan rahmat
dari Tuhan Semesta Alam, sehingga
kesuksesanlah yang selalu
diperoleh. Amien.

Bagi saya pribadi, PCplus benar-
benar sangat dibutuhkan. Akan
tetapi karena termasuk susah dicari
dan ditambah lagi dengan waktu
saya yang sangat sempit untuk
mencarinya, saya sering ketinggalan
bahkan terkadang tidak kebagian.
Untuk itulah, atas saran Bapak Ir.
Yahya Kurniawan, kami
menyampaikan hal ini dengan
maksud menyampaikan pesan
untuk berlangganan rutin
(walaupun saya tahu pada edisi
yang lalu banyak saran dari
pembaca yang ingin berlangganan
juga dan "ditolak"). Sekali lagi, hal
ini benar-benar saya butuhkan.
Demikian permohonan saya,
dengan besar harapan dapat
dikabulkan, dan terima kasih.

Drs. Wakhrudin
Guru Komputer SDN Percontohan

Menteng 01
wakhrudin@yahoo.com.sg

Red: Wah, mohon maaf sekali Pak
Wakhrudin. Kami memang tidak
menangani langganan secara langsung.
Apabila Bapak ingin berlangganan,
kami sarankan melalui agen koran
terdekat.

RUBRIK PLUSPONSEL DAN
COVER

Mudah-mudahan surat saya ini
dimuat. Langsung saja yah.
1. Begini, saya membaca beberapa

opini rekan-rekan pembaca
PCplus di plusMail mengenai
usul dihapusnya dan
dipertahankannya rubrik
plusPonsel serta dimuatnya
plusGame. Kalau boleh saya
ingin menanggapi. Saya sendiri
tidak begitu tertarik dengan

rubrik plusPonsel, namun bila
banyak di antara pembaca
yang ingin rubrik ini
dipertahankan ya boleh saja.
Mungkin sebetulnya
formatnya saja yang dirubah,
sebaiknya menampilkan
perkembangan signifikan
dalam hal ponsel dan tetek-
bengeknya, bukan
menampilkan harga-harga
ponsel. Dan rubrik ini saya kira
tidak perlu dimuat secara
teratur, hanya kalau ada topik
menarik seperti
perkembangan itu tadi.

2. Sebaliknya, saya setuju sekali
terhadap opini beberapa
pembaca tentang dimuatnya
kembali plusGame secara
teratur setiap edisi. Saya kira
yang membuat komputer PC
jaman sekarang teknologinya
bertambah maju adalah
perkembangan game itu
sendiri. Contohnya,
perkembangan teknologi
kartu grafis, bukankah untuk
menyesuaikan teknologi
game? Jadi saya kira game
sudah menjadi bagian yang
tak terpisahkan dari sebuah PC
masa kini. Jadi saya setuju
kalau rubrik plusGame
kembali dimuat secara teratur
dalam setiap edisinya, bila
memungkinkan ditambah
porsinya. Jangan-jangan malah
pembaca PCplus malah beralih
membeli media lain hanya
untuk mencari rubrik game-
game terbaru (saya membaca
opini Bung Anton pada edisi
145). Atau, biar adil
bagaimana kalau dua-duanya
dijadikan rubrik tetap, dan
konsekuensinya halaman
PCplus bertambah dan harga-
nya dipas-pasin Rp 5000,-. Saya
kira harga segitu bisa ditolerir
oleh pembaca PCplus.

3. Mengenai cover, saya juga
tidak terlalu ambil pusing bila
menampilkan gambar wanita.
Hanya saja tampilannya selama
ini kurang kreatif sehingga
model-model tersebut
kelihatan seperti menjadi
obyek saja.

Begitu saja, opini dari saya.
Mohon pihak PCplus tidak
tersinggung bila ada kata-kata
yang kurang berkena. Harapan
saya semoga PCplus bertambah
maju, jaya, dan semakin plus
bicara soal komputer. Thanks.

Nur Adi I
nur_adi_i@yahoo.com

Red: Terima kasih masukannya Mas
Nur. Usulan Anda untuk
mempertahankan plusPonsel disertai
usulan kontennya memang masuk
akal dan kami akan mendiskusikannya
di jajaran Redaksi PCplus. Begitu juga
halnya masukan rubrik plusGame.
Thanks juga masukannya tentang
cover.

“Small is Beautiful”

Ungkapan ini sangat populer di kalangan penggiat LSM dan aktivis
tahun 80-an. Dipopulerkan oleh E.F Schumacher, kalimat tersebut
merupakan sebuah judul buku yang diterbitkan pertama kali tahun 1973.
Buku tersebut dianggap merupakan sebuah monumen yang berisi kritik
meyakinkan terhadap problem ekonomi yang dikembangkan oleh Barat,
dan menjadi sebuah cara pandang baru dalam melihat apa yang
dikembangkan oleh para teknokrat Barat dan implikasinya bagi dunia
modern. Secara revolusioner, pendekatan dalam buku “Small is Beautiful”
adalah pendekatan yang revolusioner.

Mini barebone system yang diulas di PCplus kali ini boleh dikatakan
juga merepresentasi ungkapan “Small is Beautiful” ini serta mengandung
semangat yang hampir mirip. Mengapa? Produk ini dikembangkan oleh
para insinyur di Asia, sementara teknologi atau model sistem PC yang
diperkenalkan oleh vendor-vendor Barat selama ini masih terpaku pada
bentuk PC yang konservatif. Model ini membawa pula pada pola investasi
komputer PC yang selama ini dilakukan oleh korporasi seperti bank,
kantor asuransi, jasa, dan sebagainya. Barebone boleh dikatakan
merupakan reformasi (supaya tidak berlebihan bila dikatakan revolusi) dari
penggunaan sumber daya pada sebuah sistem PC. Dari segi bahan baku
yang digunakan, barebone system jauh lebih sedikit dibandingkan sistem
PC biasa. Penyusutannya bisa mencapai 40 persen.

Dari sisi yang lain, barebone system juga terlihat unik. Bentuknya
memang menyerupai PC biasa, tetapi mobilitasnya sudah mendekati
notebook. Tapi ia sama sekali tak mengambil bentuk atau teknologi atau
model sedikit pun dari notebook. Sasaran dari pengguna barebone ini
sendiri juga bukan orang-orang yang bergerak mobile seperti halnya
pengguna notebook, melainkan orang-orang yang ingin ringkas dan
praktis.

Untuk lebih lengkapnya, Anda pasti harus membaca ulasan utama
PCplus edisi ini. Rubrik lain tentu juga bisa Anda simak. Apa saja itu?
Silakan langsung dibuka saja karena ini kolom ini bukan kolom daftar isi!

Selamat menikmati!
Salam hangat dari Palmerah

Redaksi
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Kini, Isi Ulang proXL
Bisa Dilakukan di
ATM BII. Sebenarnya pengisian
ulang pulsa pra bayar proXL sudah bisa
dilakukan di ATM BII, cuma belum
otomatis. Pelanggan masih harus
memasukkan 14 digit nomor HRN yang
diberikan. Sekarang, semuanya sudah
otomatis. Pelanggan cukup memasukkan
nomor proXL mereka.

Nilai pulsa yang diberikan beragam,
yaitu pulsa senilai Rp. 25.000, Rp. 50.000,
Rp. 75.000, Rp. 100.000, Rp. 150.000, Rp.
200.000, Rp. 300.000, dan Rp. 500.000.
Kusnadi Sukarja, Direktur Pemasaran dan
Penjualan dari Excelcom mengatakan, “Isi
ulang elektronik yang disediakan oleh BII
cukup istimewa karena merupakan transaksi isi ulang elektronik pertama yang dapat dilakukan di ATM
dengan denominasi (nilai pulsa) yang rendah.” Di samping nilai pulsa, pelanggan juga akan dikenai
pajak sebesar 10% dari nilai pulsa. (alx)

Integrasi VIA K8T800 dengan Maxtoruntuk Sistem
Prosesor Berbasis AMD Athlon 64. VIA Technologies, Inc.
mengumumkan integrasi chipset K8T800 dengan hard drive DiamondMax® dan MaXLineTM Serial ATA
(SATA) untuk mendukung penggunaan sistem prosesor berbasis AMD AthlonTM 64, AMD Athlon 64 FX
dan AMD OpteronTM yang dirancang untuk pasar desktop, server, dan workstation multi-prosesor.

Menurut Richard Brown, Associate Vice President, VIA Technologies, Inc., integrasi ini akan
mempercepat penggunaan teknologi Serial ATA/RAID di atas platform AMD64. Saat ini VIA K8T800 telah
banyak digunakan oleh para produsen motherboard. Drive SATA keluaran Maxtor telah tersedia di
pasaran dengan kapasitas mulai dari 80 GB hingga 200 GB untuk DiamondMax yang disediakan bagi
para pengguna desktop berkinerja tinggi, dan kapasitas hingga 250 GB untuk MaXLine yang disediakan
bagi pengguna perusahaan. MaXLine dan DiamondMax menawarkan tingkat transfer data yang lebih
tinggi, koneksi yang lebih handal dengan integrasi RAID sederhana dan instalasi HDD yang lebih cepat
dibandingkan dengan drive ATA paralel. (raa)

Demand more, Get More, Enjoy More – Strategi
Hewlett Packard untuk Memimpin Segmen
Pelanggan TI. Indonesia merupakan negara berkembang yang memiliki banyak pasar
usaha kecil dan menengah (UKM). Menurut Budi Sabekti, Sales Director HP Indonesia, di Indonesia
terdapat kira-kira 38 juta perusahaan dari berbagai skala, mayoritas adalah UKM, namun hanya 5 juta
yang mengenal komputer untuk menjalankan bisnisnya. Hal tersebut disampaikannya dalam HP Journal-
ist Workshop 2003 yang diadakan di Yogyakarta pada tanggal 2-4 Oktober 2003. Meskipun
perkembangan teknologi melaju dengan pesat, masih sulit bagi masyarakat Indonesia untuk bersahabat
dengan teknologi, yang biasanya dikaitkan dengan harga mahal.

Strategi HP merupakan pendekatan yang ditujukan bagi seluruh segmen pengguna – orang
rumahan, data center, home office, UKM, pengguna mobile dan enterprise. Sesuai dengan motto-nya,
“HP Deliver More”, HP berusaha menawarkan produk berteknologi tinggi dengan harga lebih murah
dan kulitas yang terbaik. (raa)

Pemenang Grafis Desain Adikarya
Desain Indonesia 2003

DESAIN KORPORAT DAN PROMOSI
1. Logo dan Aplikasi: Hermawan Tanzil (United Can)
2. Kalender: Irwan Harnoki (Kalender 2002)
3. Majalah: Zinnia Nizar (PS Magazine)
4. Buku: Harry Roseno (Diary Extreme Exp)
5. Poster: Hermawan Tanzil (ABN Amro)

DESAIN KEMASAN
1. Hiburan : Emil (Positive Potret)

MAHASISWA
1. Junaidy Widjaja (Agenda dan Tiket, Bina Nusantara)
2. Arnold Sandjaya (Cina Benteng, Bina Nusantara)
3. Varian Mico (Buku Cerita Rakyat, Bina Nusantara)

CA BrightStor Data Availability,
Sahabat Para Administrator
BackUp. Tiap administrator di sebuah perusahaan pasti
memiliki masalah yang serupa – berkutat dengan tugas-tugas yang
berhubungan dengan dukungan TI, masalah trouble shooting,
harddisk crash, atau e-mail server yang down. Yang membedakan
sulit tidaknya penyelesaian masalah mereka adalah tool apa yang
dimiliki oleh perusahaan tempatnya bekerja. Bisa dibayangkan
betapa pusingnya seorang administrator jika kebetulan semua
masalah tersebut terjadi di hari yang sama, belum tentu tugasnya

selesai dalam satu hari. Ini menjadi inspirasi CA dalam menciptakan
BrightStor Data Availability. Teknologi utama dari produk ini ada
tiga – BrightStor ARCserve Backup, BrightStor Mobile Backup dan
BrightStor High Availability Manager.

BrightStor ARCserve Backup menawarkan fitur pengelolaan
dan penyimpanan data untuk kegiatan eBusiness, solusi ini bisa
berjalan di atas platform Windows, Netware dan Linux. BrightStor
Mobile Backup merupakan solusi otomatis untuk melakukan
backup dan penyimpanan data dalam platform remote/mobile
computing, backup berjalan otomatis sehingga user tidak perlu
memrosesnya. BrightStor High Availability Manager melindungi
aset bisnis dengan cara mereplikasi data penting ke server lokal
atau server lain yang berbeda lokasi, memberi akses data dan
aplikasi nonstop untuk melindungi server dari kegagalan OS atau
gangguan jaringan. (raa)

Kerja Sama SAP–Accenture untuk
Sediakan Solusi TI Perbankan dan
Asuransi Global. Produk dan layanan TI yang akan
dikembangkan meliputi solusi standar, custom solution, dan
business process outsourcing, yang dirancang untuk meningkatkan
efisiensi, meminimalisasi biaya operasional dan meningkatkan
kinerja bisnis. Solusi ini menawarkan dukungan luas bagi fungsi
bisnis yang meliputi pengelolaan klaim dan administrasi kebijakan
asuransi, core banking operation dan manajemen resiko
perusahaan.

Kedua perusahaan sepakat untuk mengintegrasikan solusi
peranti lunaknya menggunakan SAP NetWeaverTM, sebuah
platform integrasi aplikasi terbuka SAP yang mampu mendorong
turunnya biaya implementasi dan mempercepat RoI (Return on
Investment) klien. Mereka juga akan memasarkan dan meng-
implementasi solusi cross-industry SAP untuk mengatur proses bisnis
seperti keuangan dan Human Capital Management (HCM). (raa)

ARE/PCplus

Penandatanganan kerja sama antara PT Bank Internasional
Indonesia dengan Excelcomindo Pratama untuk isi ulang
proXL melalui ATM BII dilakukan pada tanggal 2 Oktober lalu.

ARE/PCplus



4 |

plusAktual IV • 08 - 14 Oktober 2003
PCplus 147

KPU Adakan Lelang Ulang Tender TI untuk Pemilu
2004. KPU dan PT Telkom telah menandatangani naskah Perjanjian Kerjasama tentang Penyediaan
Jaringan dan Jasa Layanan Telekomunikasi untuk Pemilu 2004. Belum habis keheranan publik atas
keganjilan tender TI di KPU, kini KPU kembali membuat publik bertanya-tanya mengapa proses lelang
harus diulang. Menurut jadwal semula, seharusnya proses tender sudah memasuki masa sanggah
terhitung sejak tanggal 2 Oktober 2003 kemarin. Sebelumnya, tanggal 1 Oktober 2003, KPU telah
mengumumkan lima penawaran yang lolos sebagai finalis. Kelima penawaran itu diajukan oleh PT
Asaba Computer Center, PT Pernadi Wiraperkasa, konsorsium PT Berca Hardaya Perkasa dengan PT
Indosat Megamedia dan PT Citra Tirza Astari Jaya, konsorsium PT Integrasi Teknologi Tbk. dengan PT
Intikom Berlian Mustika, PT Harrisma Agung Jaya, PT Multidata Rancana Prima dan PT Nusantara
Compnet, dan konsorsium PT Swadarma Duta Data dengan PT Transmarco Data System. Saat publik
sedang menanti siapa yang akan keluar sebagai pemenangnya, tanggal 3 Oktober 2003 KPU
menerbitkan surat undangan yang di dalamnya menyatakan bahwa Panitia Pengadaan Barang dan Jasa
membatalkan proses lelang karena tidak ada peserta yang memenuhi syarat, Panitia akan mengadakan
proses lelang ulang.

Jadwal tahap proses tender sudah pasti akan mundur. Itu berarti akan semakin mepet pula waktu
yang disediakan bagi pemenang tender untuk menyelesaikan proyeknya. Hal ini sebenarnya membuat
publik semakin curiga akan kemungkinan benarnya tender ini mengarah ke satu merek tertentu seperti
yang telah diisukan. (raa)

AAM Luncurkan InfoStep untuk Layanan Informasi.
PT Anugrah Argon Medica (AAM), perusahaan distribusi produk alat kesehatan dan farmasi dengan
pangsa terbesar di Indonesia, meluncurkan InfoStep sebagai alat penunjang pengambilan keputusan
bisnis yang cepat, akurat dan proaktif. Ada lima komponen di dalamnya – InfoFlash, InfoMail, infoLink,
InfoCube dan InfoBiz.

InfoFlash memanfaatkan teknologi SMS, pengguna bisa mengirimkan SMS dengan keyword
tertentu untuk mengakses informasi singkat tentang stok, penjualan dan harga secara real time
langsung ke database ERP dan SCM AAM secara otomatis kapan dan di mana saja. InfoMail merupakan
layanan informasi yang dikirim harian via e-mail. InfoLink adalah layanan informasi AAM yang bisa
diakses secara online melalui www.aamlink.com yang menyediakan informasi mengenai berita terkini
dalam industri farmasi, market intelligence dan laporan bisnis. InfoCube merupakan solusi business
intelligence system yang diinstal langsung di kantor, perusahaan tidak perlu membangun data ware-
house dan business intelligence. InfoBiz, komponen terakhir, berupa laporan-laporan rutin mingguan
atau bulanan yang diberikan oleh Business Manager AAM ke penggunanya. AAM memilih server HP-UX
9000 series, HP Itanium2 dan HP Proliant untuk menunjang operasional bisnisnya dan Oracle E-Business
Suite sebagai solusi untuk aplikasi ERP (Enterprise Resources Planning) dan SCM (Supply Chain Manage-
ment). (raa)

Universitas Kristen Duta Wacana (UKDW) yang Fakultas Teknik
Informatikanya tercatat pada papan atas Badan Akreditasi Perguruan
Tinggi menjadi ajang event workshop Linux yang diselenggarakan
PCplus di Jogjakarta. Pembicara yang terlibat merupakan kombinasi
kontributor-mahasiswa UKDW-Redaksi PCplus. Saat sesi terakhir,
jumlah peserta workshop tercatat 149 orang. Banyak di antara
peserta merupakan pelajar. Beberapa orang bahkan berasal dari
kalangan umum yang sudah berusia lanjut. Pada saat itu mulai dirintis
(dan segera dinyatakan berdiri), Komunitas Linux Yogyakarta dengan
sekretariat di Fakultas Teknik Informatika UKDW. (vin)

Walaupun banyak peserta yang terpaksa menggunakan satu komputer
untuk empat orang, semangat dan antusiasme mengikuti langkah demi
langkah instalasi dual boot Linux – Windows serta orientasi sistem
operasi Linux di Surabaya tetap besar. Saat sesi terakhir workhop
pada tanggal 30 September, jumlah peserta tercatat lebih dari 200
orang. Kegiatan PCplus di Surabaya ini didukung oleh mitra-mitra
seperti ASUS, Seagate, Samsung, Hi-Tech Mall, serta Komunitas
Linux Surabaya. (vin)
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Zyrex luncurkan Zyrex®Cruiser TX-
700. Produk baru ini merupakan notebook berbasis teknologi
Mobile Intel® CentrinoTM yang merupakan gabungan dari teknologi
Intel®Pentium M Processor, Intel 855 chipset dan Intel® PRO/Wireless
2100 Network Connection. Zyrex®Cruiser TX-700 dilengkapi dengan
kemampuan koneksi LAN nirkabel, memungkinkan penggunanya
tetap terhubung ke Internet tanpa kabel di area hotspot. Notebook
ini memiliki bobot 2,2 kg tanpa baterai, dilengkapi dengan chipset
Intel 855GM  (Montara-GM), On die 1MB L2 cache, 14.1” XGA LCD,
USB 2.0, IEEE 1394 port, Integrated LAN dan 56 K modem,
spesifikasinya Intel Pentium 4 Processor 1.3GHz, 128MB DDR-266, Intel
PRO/Wireless 2100 LAN, 20GB HDD dan 24x CDROM. (raa)

Suasana
Indocomtech 2003,
booth-booth yang
ditampilkan terlihat
jauh lebih mewah
dibandingkan dengan
tahun lalu.
Antusiasme para
pengunjung lumayan
besar terlihat dari
besarnya jumlah yang
datang. Booth yang
banyak dilirik adalah
yang menampilkan
teknologi wireless,
kamera digital, dan
PDA. Booth yang
menjual CD MP3 dan
software bajakan pun
tak luput dari incaran
para pengunjung
yang hadir. (raa)
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Mengenal
Speaker Aktif

Cakrawala Gintings
cakra@e-pcplus.com

P

Speaker aktif semakin
lama semakin menjadi

komponen yang
umum untuk

melengkapi PC.
Sebenarnya kalau kita
melihat ke belakang,
penggunaan speaker

sebagai pelengkap PC
sudah terjadi.

Memang tingkat
kebutuhannya belum

seperti sekarang.
Wajar saja mengingat

tidak ada lagi
mainboard masa kini

yang tidak dilengkapi
sound card onboard.

ada masa
lampau banyak
mainboard tidak
dilengkapi dengan

kartu suara onboard. Pada masa
itu solusi suara pada PC banyak
menggunakan sound card yang
add-on.
Sound card-sound card tersebut
banyak yang masih memiliki
penguat akhir terpasang
padanya. Sound card seperti ini
mampu untuk men-drive
speaker yang sesuai secara
langsung tanpa bantuan
penguat tambahan.
Perkembangan lebih lanjut
membuat fungsi penguat akhir
ini dihilangkan dari sound card.
Ini membuat sound card masa

kini membutuhkan speaker aktif
ataupun penguat eksternal untuk
dapat menghasilkan suara
dengan baik.

Speaker + Penguat
Sesuai namanya, speaker

aktif memiliki penguat terpasang
padanya. Oleh karena itu,
speaker aktif selalu
membutuhkan pasokan daya
untuk penguat. Dengan
menggunakan speaker aktif,
tidak perlu lagi mencari speaker
(biasa) yang memiliki power
handling yang sesuai dengan
keluaran dari penguat akhir
suatu sound card. Salah satu
kekurangan dari speaker aktif ini
adalah pada harganya yang
relatif lebih mahal karena terdiri
dari speaker dan penguat.

Karena terdiri dari speaker
dan penguat, kualitas dari
speaker aktif ini dipengaruhi oleh
kualitas dari speaker dan
penguat yang digunakan. Bila
penguat yang digunakan sangat
bagus tetapi speaker yang
digunakan sangat jelek misalnya,
suara yang dihasilkan tidak akan

bagus juga. Demikian juga
sebaliknya.

Salah satu properti dari
speaker aktif yang sering kali
diperhatikan adalah daya
maksimum yang bisa diterima
oleh speaker yang digunakan.
Kemampuan ini tentunya ada
hubungannya dengan penguat
yang digunakan. Power handling
yang besar berarti akan
membutuhkan penguat yang
memiliki power output
yang besar pula.
Satuan yang
digunakan untuk
mengukur daya
adalah watt.
Biasanya besarnya
daya tersebut
dinyatakan dalam
format A watt
(RMS). Bila ternyata
besarnya daya
tersebut dinyatakan
dalam format lain,
misalnya A watt
(PMPO), sebaiknya Anda
mencari tahu berapa nilai daya
tersebut dalam format RMS.
Masalahnya, nilai PMPO ini

sering kali tidak dapat
dibandingkan, apalagi bila
produsennya berbeda.

Secara umum memang
dengan daya yang semakin besar,
suara yang dihasilkan akan
semakin keras. Perlu diingat
bahwa yang menghasilkan suara
itu adalah
speaker.

Daya itu tadi
kasarnya bisa

dianggap

sebagai penggerak speaker
itu. Oleh karena itu besar
kecilnya suara yang dihasilkan
juga dipengaruhi oleh
seberapa efisien speaker itu
mengubah daya tadi menjadi
suara. Ibarat lampu, sebuah
lampu hemat energi dengan
watt yang sama akan
menghasilkan cahaya yang
lebih terang dibandingkan
dengan sebuah lampu pijar
biasa.

Sebenarnya properti yang
termasuk paling penting dari
suatu speaker aktif adalah
kualitas dari suara yang
dihasilkannya.

Untuk satu hal ini, suatu uji
dengar merupakan salah satu
faktor penilaian terpenting.
Jangan lupa untuk memperhati-
kan juga kualitas kartu suara
yang digunakan. PC+

ARE/PCplus
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Situs-situs Pemenang Adikarya
Desain Indonesia 2003

Alex Pangestu
alex@e-pcplus.com

Bubu Award, yang
sebelumnya sudah

dua kali
diselenggarakan,

yaitu pada tahun 2001
dan 2002, merupakan
kompetisi web design

di Indonesia.  Pada
tahun ini, Bubu

Award tetap
diselenggarakan,
namun dirangkai

dengan penghargaan
terhadap graphic

design. Kombinasi ini
yang dinamakan

Adikarya Desain Indo-
nesia 2003.

dikarya
Desain Indo-
nesia tahun ini
mengambil tema

“Bangga Indonesia”.
Maksudnya, ajang ini meminta
agar designer Indonesia, baik
itu web designer atau graphic
designer, untuk memasukkan
sentuhan budaya Indonesia di
dalam kreativitas mereka. Selain
itu, Shinta W. Dhanuwardoyo,
CEO Bubu Internet, mengatakan
bahwa tema itu merefleksikan
misi untuk menghargai bakat

orang-orang yang terlibat
dalam bidang web design dan
graphic design yang
pertumbuhan antusiasme serta
kreativitasnya terus
menampakkan kemajuan.

Khusus web design,
penilaian dilakukan oleh juri
dari dalam maupun luar negeri.
Penunjukkan juri yang demikian
ini bertujuan agar Bubu Award
benar-benar penghargaan yang
kompeten, tidak asal menilai.

Pada tanggal 14 Agustus
2003 pengumuman pemenang
Bubu Award kelas korporat
diumumkan. Dan pada tanggal
3 Oktober lalu, seluruh
pemenang Bubu Award
diumumkan, termasuk kelas
korporat. Acara di Hard Rock
Café itu banyak dihadiri oleh
praktisi web design maupun
web design. Membuka acara itu
adalah J.B. Kristiadi, Sekretaris
Kementrian Kominfo.

Bubu Award juga meng-
anugerahi Yuni Cahya sebagai
best female web designer dan
Babaflash-Indonesia sebagai
Best of The Best.

Di rubrik plusPortal kali ini,
PCplus menampilkan situs-situs
yang diberikan kehormatan
untuk bertahta sebagai juara
pada masing-masing kategori.
PCplus mengucapkan selamat
kepada para pemenang. PC+

A

Gigih Budi Abadi
(bubu.cbn.net.id/gigih)

Pemenang Web Design Adikarya
Desain Indonesia 2003
Kategori Korporat :
E-commerce : PD Octa Utama (www.oxone-online.com)
Commerce : Citibank Indonesia (www.citibank.com/indonesia)
Pemerintahan : Dinas Informasi dan Komunikasi Kabupaten Purwakarta
(www.purwakarta.go.id)
Pendidikan : STIKOM (www.stikom.edu)
Berita dan Hiburan : Weddingku.com (www.weddingku.com)
Organisasi : Babaflash-Indonesia (www.babaflash.com)
Best of The Best : Babaflash-Indonesia (www.babaflash.com)

Kategori Individual :
• HTML :
Pemenang I : Aditya Triantoro (bubu.cbn.net.id/aditya)
Pemenang II : Wahyu Subrata (bubu.cbn.net.id/wahyu_h)
Pemenang III : Diki Andeas (bubu.cbn.net.id/diki)

• Flash :
Pemenang I : Gigih Budi Abadi (bubu.cbn.net.id/gigih)
Pemenang II : Yuni Cahya (bubu.cbn.net.id/yuni)
Pemenang III : Imelda Gunawan (bubu.cbn.net.id/imelda)Diki Andeas (bubu.cbn.net.id/diki)

Kategori pemerintahan: Dinas Informasi dan Komunikasi Kabupaten
Purwakarta (www.purwakarta.go.id)

Wahyu Subrata (bubu.cbn.net.id/wahyu_h)

Kategori e-commerce: PD Octa Utama (www.oxone-online.com)

Yuni Cahya (bubu.cbn.net.id/yuni)

Imelda Gunawan (bubu.cbn.net.id/imelda)

Kategori pendidikan: STIKOM (www.stikom.edu)

Aditya Triantoro (bubu.cbn.net.id/aditya)
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Agar Jangan Lupa Waktu
Saat Berinternet

Y.J. Thurana
thurana@e-pcplus.com

S

Dan ketika melihat
jam yang terletak di

system tray
komputernya,

terkejutlah dia.
“Masak sih aku sudah

online selama lebih
dari 4 jam? Rasanya

paling baru satu dua
jam-an. Mana materi
data dan file yang di-

download belum
selesai, lagi,” katanya

dalam hati. Maka
dengan berat hati ia

pun mematikan
koneksi Internetnya.

Setelah itu telepon
langsung berdering.

“Dari tadi kok
teleponnya online

terus? Ada kabar
penting nih, tapi

sepertinya sekarang
sih sudah

terlambat...,” kata
suara yang di

seberang sana.

ituasi di atas
sepertinya cukup
menggambarkan
masalah kita bersama,

para pengguna Internet dial-up
lewat saluran telepon. Atau
dengan kata lain masalah
bersama dari hampir semua
pengguna Internet Indonesia,
yaitu masalah waktu dan
ketergantungan pada saluran
telepon. Belum lagi masalah
lain yang tidak terlihat di cerita
tadi, yaitu biaya berinternet.

SOLUSI PEMBATASAN
WAKTU

Jadi yang harus kita
lakukan dalam mengatasi
masalah di atas adalah dengan
melakukan kegiatan berinternet
dari tempat lain yang biayanya
lebih murah seperti warnet,
misalnya. Atau bagi mereka
yang memiliki koneksi Internet
dari kantor, berbahagialah!

Solusi lain adalah dengan
membatasi penggunaan
Internet kita dengan
menambahkan semacam
Internet timer yang akan selalu
mengawasi dan mengingatkan
kita akan waktu dan biaya
penggunaan Internet yang
sudah kita lakukan. Kalau perlu,
bahkan mematikan koneksi
Internet jika sang pengguna
bandel berinternet melebihi
jatahnya.

Dalam beberapa tahun
terakhir ini saya menggunakan
satu Internet timer yang sangat
baik, memiliki fasilitas yang
teramat sangat lengkap,
sehingga sulit untuk pindah ke
lain hati. Bagi mereka yang
penasaran, pada kesempatan ini
akan dibahas (lagi) mengenai
Magitime.

Program ini memang
“nggak ada matinya”. Begitu
istilah yang digunakan oleh
salah satu pembaca yang
mengomentari tulisan saya
mengenai Magitime di PCplus
kira-kira satu tahun yang lalu.

Ketika itu program gratisan ini
masih berada pada versi 3.

Sekarang, versi 5 second
edition-nya dengan segala
kemampuan tambahan yang
baru, dengan ukuran file yang
hanya 1,41MB saja (cukup untuk
dimuat pada satu floppy disk),
sudah tersedia dan bisa diambil
di alamat: http://geocities.com/
magistone37/magitime.zip.

Atau jika Anda sudah
memiliki versi 5 dan ingin meng-
upgrade, file upgrade-nya
berukuran lebih kecil (830KB) dan
alamat download-nya di: http://
geocities.com/magistone37/
magitime.zip.

Silakan ambil dan install, lalu
kita bisa melanjutkan
pembahasannya.

MAGITIME VERSI 5
Mari kita mulai dari fungsi

yang paling dasar untuk sebuah
Internet Connection Timer, yaitu
tentu saja menghitung berapa
lama waktu Anda berinternet
dan berapa besar biaya yang
harus dikeluarkan.

Setelah penginstallan selesai,
ikon Magitime (bulat-merah)
akan muncul di system tray.
Tanpa pengaturan apapun, dia
akan sudah bisa bekerja dengan
baik. Setiap kali Anda melakukan
koneksi ke Internet Magitime
akan aktif, ditandai dengan
berubahnya warna ikon ke
kuning (ketika sedang melakukan
dial-up) lalu hijau (setelah
terkoneksi).

Sebuah papan pengumuman
kecil berwarna kuning akan
muncul di atas system tray setiap
kali satu batasan tercapai.
Misalnya setiap 1 jam atau setiap
pen-download-an data sebesar
10MB, tergantung pengaturan
yang Anda lakukan (Gambar 1).

Selain itu, setiap kali koneksi
terputus, papan pengumuman
yang sama akan muncul dengan
rangkuman waktu dan biaya
serta detail lain mengenai besar
data yang keluar masuk
(Gambar 2).

Dengan melakukan klik
kanan Anda akan bisa mengakses
semua menu yang tersedia.
Lakukanlah pengaturan dari sini
(Gambar 3).

Untuk fungsi waktu dan
biaya, mulailah dari menu [Call
Settings]. Sebuah jendela kecil
akan muncul dengan dua macam
pengaturan yang bisa dilakukan
(Gambar 4). Start Counting
Call memberikan pilihan pada
kita mengenai kapan seharusnya
mulai menghitung biaya. Untuk

amannya, pilihlah After Making
Call sehingga begitu modem
mengangkat telepon,
penghitungan dimulai. Pilihan
After Connection akan memulai
penghitungan setelah koneksi
tersambung. Abaikan pengaturan
yang lain, lalu klik OK.

Lanjutkan pengaturan
dengan menu [Expense Settings].
Setelah jendelanya terbuka
(Gambar 5), klik Edit untuk
mengatur kondisi pertama sesuai
dengan yang Anda inginkan.
Tampilan jendela akan berubah
dengan beberapa pengaturan
yang bisa Anda ubah-ubah
(Gambar 6). Kotak Amount diisi
dengan berapa biaya yang harus
dikeluarkan untuk koneksi
Internet, dilanjutkan dengan
pilihan satuan waktu di kotak di

bawahnya. Pilihlah Per Hour
karena pilihan lainnya tidak sesuai
dengan kondisi di sini. Berhubung
tidak ada pengaturan terpisah
antara biaya ISP dan telepon,
biaya yang diisikan adalah jumlah
dari keduanya. Sebagai gambar-
an, biaya sambungan Internet dari
TelkomNet Instan adalah sekitar
Rp. 9,000.00 per jam.

Pada kotak Period pilihlah
pengaturan mengenai kapan
kondisi ini berlangsung. Untuk ISP
yang menetapkan biaya yang flat
(sama rata) Anda tidak perlu
pusing memikirkan ini. Atur saja
pada posisi Every Day. Jika ada
perbedaan harga, misalnya diskon
selama bulan promosi, pilihlah
Period dan masukkan pengaturan
tambahan. Atau jika harga lebih

murah pada hari-hari tertentu,
pilihlah Weekday dan pilih hari
yang dimaksudkan. Buat Condi-
tion tambahan untuk pengaturan
hari tambahan.

Hal yang sama berlaku untuk
pengaturan Time. Jika tarif yang
sama berlaku setiap saat, pilihlah
For Whole Day. Jika malam hari
lebih murah, pilihlah Between
dan masukkan waktu antaranya
misalnya 23.00 to 06.00.

Untuk kondisi Indonesia pada
umumnya, Anda bisa
mengabaikan pengaturan lainnya
kecuali mungkin pada Connec-
tion Settings. Jika Anda
berlangganan pada lebih dari 1

ISP dan menggunakan lebih dari
1 koneksi telepon dengan biaya
yang berbeda-beda, aturlah
disini koneksi yang mana yang
berlaku. Untuk pengaturan
koneksi yang lain, buatlah
Condition yang lain pula.

Klik [OK] setelah semua
pengaturan selesai. Jendela akan
kembali ke bentuk awal. Klik
[Add] untuk menambahkan
Condition lainnya dengan
pengaturan harga dan waktu
yang berbeda. Klik Delete untuk
menghapus Condition yang
tidak diinginkan.

Langkah berikutnya adalah
tombol [Settings] yang kalau
ditekan akan memunculkan
empat pilihan. Satu diantaranya
sudah dibahas sebelumnya yaitu

Call Settings. Sedangkan tiga
pilihan lainnya adalah: Holiday
Settings (untuk pengaturan
perhitungan yang berbeda pada
hari raya tertentu), Countdown
Settings (untuk mengatur
penghitungan mundur dalam
waktu koneksi), dan Specifiy
Decimal Separator (untuk
mengatur penulisan satuan biaya
dan lainnya).

Masih banyak yang bisa
diceritakan mengenai program
yang satu ini. Tetapi setidaknya
fungsi dasarnya sudah
terangkum di sini. Untuk yang
lainnya, harap bersabar sampai
kesempatan berikutnya. PC+

Gambar 1

Gambar 2

Gambar 3

Gambar 4

Gambar 5

Gambar 6
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Motorola Jaringan GSM 900/1800
C350 Layar Warna 4096 warna,
Rp. 1.125.000 96 x 65 pixel

SMS/EMS/MMS SMS/EMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus Exchangeable covers
Dimensi/Berat 98 x 42 x 18 mm/

80gr
Bicara/Stand-by 3.5 jam / 180 jam

Motorola Jaringan GSM 900/1800
C359 Layar Warna 4096 warna
Rp. 1.125.000 SMS/EMS/MMS SMS/EMS

Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus Exchangeable covers
Dimensi/Berat 98 x 42 x 18 mm /

80gr
Bicara/Stand-by 3.5 jam / 180 jam

Motorola Jaringan GSM 900/1800
E365 Layar 65000 warna,
Rp. 2.900.000 128 x 160 pixel

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus Built-in Camera
Dimensi/Berat 107 x 45 x

19.5 mm / 100gr
Bicara/Stand-by 10 jam 40 menit/

150 jam

Motorola Jaringan GSM 900/1800
T720 Layar 4096 warna,
Rp. 1.775.000 120 x 160 pixel

SMS/EMS/MMS SMS/EMS
Polyphonic -
GPRS/WAP/HSCSD GPRS/WAP
Plus -
Dimensi/Berat 36 x 19 x 10mm /

100gr
Bicara/Stand-by 3 jam / 165 jam

Nokia 3100 Jaringan GSM 900/1800
Rp. 1.900.000 Layar 4096 warna,

128 x 128 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP/HSCSD
Plus Glow In The Dark /

Camera (Separated)
Dimensi/Berat 42.8 x 101.8 x

15.2 / 85gr
Bicara/Stand-by 3 jam / 240jam

Nokia 3300 Jaringan GSM 900/1800
Rp. 2.600.000 Layar 4096 warna,

128 x 128 pixel
SMS/EMS/MMS SMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP/HSCSD
Plus Digital music player /

recorder
Dimensi/Berat 144 x 63 x

20mm / 125gr
Bicara/Stand-by 180 jam - 230 menit

/ 230 jam

Nokia 3530 Jaringan GSM 900/1800
Rp. 1.150.000 Layar 4096 warna,

96 x 65 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1
Plus Exchangeable cover
Dimensi/Berat 118 x 49.6 x

17.1mm / 108gr
Bicara/Stand-by 2 jam 30 menit -

4 jam 30 menit /
13 hari

Nokia 3650 Jaringan GSM 900/1800/1900
Rp. 3.000.000 Layar 4096 warna,

176 x 208 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Midi/Wav Ringtone
GPRS/WAP/HSCSD GPRS/HSCSD
Plus Built in camera
Dimensi/Berat 130x57x26mm/130gr
Bicara/Stand-by 3 jam - 4 jam /

150 jam - 200 jam

Nokia 5100 Jaringan GSM 900/1800/1900
Rp. 2.350.000 Layar 4096 warna,

128 x 128 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD -
Plus Rubber cover,

Exchangeable cover
Dimensi/Berat 108.5x49.5x22mm/104gr
Bicara/Stand-by 2 jam - 5 jam /

150 jam - 300 jam

Nokia 6100 Jaringan GSM 900/1800/1900
Rp. 2.275.000 Layar 4096 warna,

128 x 128 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus -
Dimensi/Berat 105.5 x 47.5 x

22.5mm / 92gr
Bicara/Stand-by 2 jam 20 menit -

3 jam  50 menit /
60 jam - 170 jam

Nokia 6108 Jaringan GSM 900/1800/1900
Rp. 2.900.000 Layar 65000 warna,

128 x 128 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP/HSCSD
Plus Built-in hand

recognition
Dimensi/Berat 106x4634x26mm/100gr
Bicara/Stand-by 3 jam - 7 jam /

170 jam - 410 jam

Nokia 6610 Jaringan GSM 900/1800/1900
Rp.2.175.000 Layar 4096 warna,

128 x128
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1/

HSCSD
Plus -
Dimensi/Berat 106x45x17.5mm/84gr
Bicara/Stand-by 2 jam - 5 jam /

150 jam - 300 jam

Nokia 6800 Jaringan GSM 900/1800/1900
Rp. 2.850.000 Layar 4096 warna,

128 x128 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP/HSCSD
Plus Flip Keyboard
Dimensi/Berat 119x55x23mm/122gr
Bicara/Stand-by 3 jam - 7 jam /

7 hari - 15 hari

Nokia 7210 Jaringan GSM 900/1800/1900
Rp. 2.700.000 Layar 4096warna,

128x128 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP/HSCSD
Plus Exchangeable cover
Dimensi/Berat 106x45x17.5mm/83gr
Bicara/Stand-by 2 jam - 5 jam /

150 jam - 300 jam

Nokia 7250 Jaringan GSM 900/1800/1900
Rp. 3.100.000 Layar 4096 warna

128 x 128 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD WAP 1.0
Plus Exchangeable cover,

Built in camera
Dimensi/Berat 105x44x19mm / 92gr
Bicara/Stand-by 2 jam - 5 jam /

150 jam - 300 jam

Nokia 7650 Jaringan GSM 900/1800
Rp. 3.525.000 Layar 4096 warna,

full graphic
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1
Plus Built in camera
Dimensi/Berat 114 x 56 x 26mm/

154gr
Bicara/Stand-by 4 jam / 150 jam

Samsung Jaringan GSM 900/1800
SGH-C100 Layar 65000 warna,
Rp. 1.650.000 128 x 128 pixel

SMS/EMS/MMS SMS/EMS
Polyphonic Ya
GPRS/WAP/HSCSD WAP 1.1
Plus -
Dimensi/Berat 111 x 45 x 17mm /

76gr
Bicara/Stand-by 3 jam / 145 jam

Samsung Jaringan GSM 900/1800 /1900
SGH-S300 Layar 65.000 warna,
Rp. 2.800.000 128 x 128 pixel

(internal), 256
warna (eksternal)

SMS/EMS/MMS SMS/EMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus Dual Color Screen
Dimensi/Berat 80x40x20 mm / 76gr
Bicara/Stand-by 3.5 jam / 150 jam

Samsung Jaringan GSM 900/1800
SGH-T200 Layar 65.000 warna,
Rp. 2.750.000 128 x 160 pixel

SMS/EMS/MMS SMS/EMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus Automatic Open

Folder
Dimensi/Berat 88.5 x 46.2 x

22.8 mm / 104gr
Bicara/Stand-by 4 jam / 83 jam

Samsung Jaringan GSM 900/1800
SGH-T400 Layar 65.000 warna,
Rp. 2.550.000 128 x 144 pixel

SMS/EMS/MMS SMS/EMS
Polyphonic Ya
GPRS/WAP/HSCSD WAP 1.2
Plus -
Dimensi/Berat 80 x 42 x

21.5mm / 80gr
Bicara/Stand-by 150 menit  -

 335 menit /
120 - 220 jam

Samsung Jaringan GSM 900/1800
SGH-T500 Layar Warna 65.000 warna,
Rp. 3.050.000 128x160 pixel

SMS/EMS/MMS SMS/EMS
Polyphonic Ya
GPRS/WAP/HSCSD WAP 1.2
Plus Phone for ladies
Dimensi/Berat 76.3 x 44.2 x

22.7mm / 80gr
Bicara/Stand-by 3 jam / 120 jam

Samsung Jaringan GSM 900/1800
SGH-V200 Layar Warna 65.000 warna,
Rp. 3.500.000 128x160 pixel

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2
Plus Built-in camera
Dimensi/Berat 91 x 48 x

23 mm  / 96gr
Bicara/Stand-by 4 jam / 100 jam

Siemens S57 Jaringan GSM 900/1800/1900
Rp. 2.225.000 Layar 256 warna,

101 x 80 Pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1
Plus Camera

(separated)
Dimensi/Berat 101 x 46 x

19mm / 85gr
Bicara/Stand-by 6 jam / 300 jam

Siemens Jaringan GSM 900/1800
SL55 Layar 4096 warna,
Rp. 3.300.000 101 x 80 pixel

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP
Plus -
Dimensi/Berat 81.6 x 44.5 x

21.9 mm / 79gr
Bicara/Stand-by 210 menit / 200 jam

Siemens M50 Jaringan GSM 900/1800
Rp. 980.000 Layar 4096 warna,

64 x 101 pixel
SMS/EMS/MMS SMS/EMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1
Plus -
Dimensi/Berat 109 x 46 x 23mm /

97gr
Bicara/Stand-by 6 jam / 260 jam

Siemens M55 Jaringan GSM 900/1800/1900
Rp. 1.725.000 Layar 4096 warna,

101 x 80 pixel
SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD GPRS/WAP 1.2.1
Plus Camera (separated)
Dimensi/Berat 101 x 46 x 21mm /

83gr
Bicara/Stand-by 300 menit / 250 jam

Sony Jaringan GSM 900/1800/1900
Ericsson P800 Layar 4096 warna,
Rp. 5.125.000 640 x 480 pixel

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic MP3
GPRS/WAP/HSCSD GPRS/WAP/HSCSD
Plus PDA, built in

camera, handwriting
recognition

Dimensi/Berat 117 x 59 x 2mm /
158 gr

Bicara/Stand-by 13 jam / 400 jam

Sony Jaringan GSM 900/1800
Ericsson T310 Layar 4096 warna,
Rp. 1.225.000 101 x 80 pixel

SMS/EMS/MMS SMS/EMS/MMS
Polyphonic Ya
GPRS/WAP/HSCSD WAP 1.2.1
Plus Camera

(separated)
Dimensi/Berat 99 x 43 x 17.7mm

/ 75gr
Bicara/Stand-by 1.5 jam - 5 jam /

60 jam - 180 jam



| 9

plusPonsel IV • 08 - 14 Oktober 2003
PCplus 147

SE Z600:
Ponsel Clamshell

Pertama dari
Sony Ericsson

F.X. Bambang Irawan
fbi@e-pcplus.com

S

Sony Ericsson
tergelitik juga untuk
memunculkan hand-

set dengan desain
clamshell (lipat).

Produk clamshell
pertama yang

meluncur dari vendor
ini adalah Z600.

elain
berinovasi
dalam soal desain,
Z600 juga meneruskan

fitur andalan QuickShare, yang
pertama kali diperkenalkan
pada ponsel T610. Fitur ini
digunakan untuk saling berbagi
gambar dengan
pengguna lain secara
mudah dan cepat.
Untuk kepentingan
ini, produk yang
diposisikan juga
sebagai ponsel
untuk imaging ini
juga dilengkapi
dengan kamera
built-in. Layarnya
sudah mampu
menampilkan 65.356
warna.

Akan tanggung
jika ponsel imaging ti-
dak dilengkapi dengan kemam-
puan multimedia. Oleh karena-
nya, Sony Ericsson mem-bundle
produknya ini dengan kapa-
bilitas MMS dan GPRS, menjadi-
kannya sekaligus juga berposisi
sebagai ponsel yang afdol
untuk keperluan messaging.

Untuk lebih memperkaya
kapabilitas ini, Z600 juga
dilengkapi dengan Bluetooth
yang dapat digunakan untuk
sinkronisasi ke peranti lain,

misalnya PC. Gambar
yang dijepret dengan
kamera ponsel ini
bisa langsung
dikirim dengan
Bluetooth ke PC.

Karena
berdesain lipat,
maka handset ini
jadi bisa
menyuguhkan
display eksternal
yang berada di
permukaan luar.
Tampilan pada
display ini terdiri dari

caller ID, waktu, jaringan, dan
status baterai. Uniknya, cover
depan dan belakang ponsel ini
bisa diganti-ganti. Tak tanggung-
tanggung, cover-nya dirancang
oleh Sony Digital Design dan
diberi brand Style-Up IST-22.
Cover ponsel jadi bisa disesuaikan

dengan mood atau dandanan
Anda.

Fitur menarik lainnya adalah
pada keypad. Papan pencet yang
mereka sebut dengan multiaction
keypad memungkinkan
pemencetan beberapa tombol
dipencet sekaligus. Ini
dimaksudkan untuk bisa
mendukung kenyamanan
bermain game dengan Z600.
Dengan keypad seperti ini kita
bisa melakukan aksi seperti
menembak dan bergerak
sekaligus.

Kalau mau sensasi main lebih
heboh lagi, tersedia aksesori
Gameboard EGB-10 yang
berbentuk seperti joystick konsol
game. Gameboard yang harus
ditempelkan ke punggung Z600
ini mempunyai tombol
pengendali 8 arah di bagian kiri
dan 4 tombol aksi di bagian
kanan. Nikmat untuk memainkan
game V-Rally yang tersedia.
Game ini merupakan permainan
yang ngetop di Sony PS2. Ponsel
ini mendukung game berbasis

Java maupun Mophun (yang
sudah jamak terdapat pada
berbagai handset Sony Ericsson).

Bagi yang suka berkreasi
dengan musik, ponsel ini
menyediakan fitur Music DJ,
sebuah aplikasi untuk
menggubah musik dalam 4 track,
dan menjadikannya ringtone.

Sebuah eksplorasi
desain  kembali

diambil oleh Nokia.
Ponsel keluaran

terbaru, Nokia 7600,
mempunyai bentuk

yang unik dan
futuristik. Bentuknya
mirip seperti ketupat,

meski tak ada
hubungannya sama

sekali dengan momen
lebaran yang sebentar

lagi menjelang.

evolusi
bentuk ini
melengkapi inovasi
desain yang telah

dilakukan Nokia antara lain
pada ponsel-ponsel Nokia 5510,
3100, N-Gage, 6800, dan 3650.
Layar N7600 yang mampu
menampilkan 65,536 warna ini
berada di tengah-tengah dan
keypad mengelilingi keempat
seginya, kanan-kiri-atas-bawah.
Casing-nya mengerucut di
sudut-sudut kiri atas dan kanan
bawah, sedang di kedua sudut
seberangnya melengkung
mulus.

Ponsel yang bobotnya
hanya sekitar 123 gram dengan
ukuran 87 x 78 x 18,6 mm ini
didudukkan dalam posisi

Nokia 7600:
Ponsel Berbentuk Ketupat

sebagai ponsel
mobile imaging,
dikhususkan
terutama untuk
keperluan
pencitraan. Ya,
tidak
mengherankan
mendengarnya,
karena memang
ponsel sekarang
sudah bergeser antara
lain ke arah tersebut.
Maka ia dilengkapi
dengan built-in digital
camera yang dapat
digunakan untuk membidik
video (beserta audionya)
maupun gambar diam. Durasi
untuk video maupun audio sudah
cukup panjang, mencapai 2,5
menit.

Selain pada jaringan GSM
900/180MHz, ponsel ini juga
dapat beroperasi secara dual
mode pada jaringan WCDMA
(Wideband Code Division
Multiple Access). WCDMA adalah
teknologi wireless mobile
generasi ketiga yang
menawarkan kecepatan data dan

kualitas layanan yang jauh lebih
tinggi untuk berbagai perangkat
nirkabel. Lebih baik daripada
jaringan mobile yang ada
sekarang. Menggunakan ponsel
ini dalam jaringan WCDMA, kita

F.X. Bambang Irawan
fbi@e-pcplus.com

R

dapat mengirim dan menerima
klip video dan gambar selama
panggilan berlangsung.

Musik juga merupakan
kenyamanan yang ditawarkan
Nokia 7600. Disediakan fitur

music player MP3/AAC terpadu
yang mampu memutar lagu
sampai 50 menit dengan
kualitas mendekati CD. Lagu-
lagu ini dapat disimpan dalam
memori internalnya. Musik dan
layanan lainnya dapat di-
download menggunakan
layanan mobile. Atau bisa juga
dilakukan secara lokal yaitu dari
PC melalui inframerah,
Bluetooth, atau koneksi USB
yang tersedia.

Fitur-fitur lain dari ponsel
ini adalah nada dering
polifonik, dukungan aplikasi
Java, dan kecepatan koneksi
data sampai 384 kilobits per
detik dalam jaringan WCDMA.
Ponsel ini memiliki waktu
bicara sampai 4 jam dalam
jaringan GSM dan sampai 2,9
jam dalam jaringan WCDMA.
Waktu siaganya sampai 12,5
hari dalam kedua jaringan
tersebut.

Belum diketahui pada
harga berapa ponsel ini akan
dilepas. Mari kita tunggu
tanggal peluncurannya di
Indonesia. PC+

ISTIM
EW

A

Untuk menghasilkan suara nada
dering polyphonic 32 kanal
suara yang sempurna,
disediakan sebuah speaker
khusus.

Ponsel ini baru saja datang
ke pasaran di Indonesia dan
akan dijual pada harga sekitar 3
sampai 3,5 juta rupiah. PC+

IS
TI

M
EW

A

IS
TI

M
EW

A

Z600 ini bisa dijadikan
“konsol game” dengan
menambah Gameboard
EGB-10.

Nokia 7600: Beroperasi di jaringan GSM dan WCDMA.
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Menonaktifkan Screensaver
di Welcome Screen

Menyembunyikan
Informasi Pribadi pada

Dokumen Word

Melindungi Setting Color
Internet Explorer

Welcome screen merupakan “ucapan” selamat datang yang ditampilkan oleh
Windows XP ketika startup. Pada komputer multiuser, Windows tidak akan langsung
masuk ke desktop, melainkan akan “menahan” tampilannya di welcome screen ini
hingga ada salah satu user yang melakukan login. Demikian pula ketika Anda
melakukan Switch User atau Log Off, Windows akan kembali ke welcome screen.

Apabila dalam waktu 10 menit tidak ada user yang login, maka sebuah
screensaver akan dijalankan. Screensaver yang biasanya muncul adalah screensaver
berlogo Windows XP. Sayangnya screensaver ini tidak dapat dinonaktifkan dari
Display Properties, karena setting screensaver yang berada di Display Properties
hanya berlaku untuk account user, tidak untuk welcome screen.

Satu-satunya jalan untuk menonaktifkan screensaver pada welcome screen ini
adalah melalui registry. Berikut ini langkah-langkahnya:
1. Jalankan Registry Editor dengan mengklik [Start]>[Run...], kemudian ketik

regedt32.exe.
2. Masuklah ke subkey: HKEY_USERS\.DEFAULT\Control Panel\Desktop\.
3. Carilah String value (REG_SZ) bernama ScreenSaveActive pada bagian kanan

window.
4. Klik dua kali string value tersebut kemudian ubah nilainya menjadi 0.
5. Tutup Registry Editor, kemudian restart PC.

Apabila Anda ingin mengembalikan ke setting semula, masuk kembali ke subkey
di atas, kemudian kembalikan value ScreenSaveActive menjadi bernilai 1.

Steven Andy Pascal
steven@e-pcplus.com

Coba Anda buka Windows Explorer, kemudian cari salah satu dokumen yang
dibuat dengan Microsoft Word yang Anda miliki. Perhatikan pada Status Bar,
terdapat sebuah informasi mengenai pembuat dokumen tersebut. Sekarang klik kanan
file tersebut, lalu klik. Ketika window Properties terbuka klik tab [Summary] dan
lihat bagian Author:, di sana juga tertulis nama pembuat dokumen.

Bagi beberapa orang mungkin informasi pembuat dokumen tadi cukup
mengganggu. Maka dari itu Anda dapat menghilangkannya. Caranya?
1. Jalankan program Microsoft Word.
2. Buka window Options dengan mengklik [Tools]>[Options...].
3. Pada window tersebut masuklah tab [Security].
4. Tandai checkbox

[Remove personal
information from
this file on save]
yang terdapat di
Privacy options.

5. Terakhir, klik [OK].
Mulai sekarang,

orang lain tidak akan
mengetahui siapa
pencipta dari dokumen
yang telah Anda buat.
Sekalipun Anda
mengisikan nama pada
Author, Manager,
Company di
[File]>[Properties]>[Summary],
nama-nama tersebut
akan terhapus ketika
Anda menyimpan
dokumen. Selamat
mencoba.

Steven Andy Pascal
steven@e-pcplus.com

Di dalam tab [General] Internet Options, terdapat tombol [Colors]. Di
dalamnya terdapat pilihan untuk mengatur warna dari Internet Explorer, kita bisa
mengatur warna background dan teks Internet Explorer.
Di dalamya juga terdapat pilihan untuk mengatur warna dari link yang terdapat pada
halaman Web. Agar setting tersebut tidak bisa diubah oleh orang lain, lakukanlah
langkah-langkah berikut ini:
1. Buka Registry Editor.
2. Masuk ke key

HKEY_CURRENT_USER\SOFTWARE\Policies\Microsoft\Internet Explorer\Control
Panel.

3. Pada panel sebelah kanan klik kanan dan pilih [New]>[DWORD Value] dan beri
nama Colors.

4. Klik ganda DWORD Value tersebut dan isikan 1.
5. Tutup Registry Editor.

Setelah itu coba Anda buka Internet Options dan klik tombol [Colors] pada tab
[General], maka pilihan yang mengatur warna background Internet Explorer akan
ter-disable, tetapi pilihan yang mengatur warna Link masih bisa diubah. Agar pilihan
untuk mengubah warna link tersebut ter-disable juga, lakukanlah cara di atas. Hanya
saja beri nama DWORD Value-nya Links. Selamat mencoba.

Fadlan Setiaji
aji-edl@plasa.com

Memasukkan Banyak Baris
pada Satu Cell

di Microsoft Excel
Ada dua cara memasukkan lebih dari satu baris ketika Anda mengetik pada
satu cell di Excel. Tekan [Alt]+[Enter] ketika Anda sedang mengetik atau mengedit
pada suatu cell di Excel. Biasanya, bila Anda tidak melakukan hal di atas, maka bila
teks yang Anda ketik atau edit melebihi ukuran cell-nya, akan seolah-olah melewati
cell tersebut. Namun bila Anda menekan [Alt]+[Enter] maka akan langsung ke baris
ke-2 dari cell tersebut.
Cara yang kedua adalah:
1. Klik cell yang Anda inginkan.
2. Pada menu [Format], klik [Cells], kemudian klik tab [Alignment].
3. Pilih [Wrap Text] dengan men-centang pada checkbox.

Hasilnya adalah, kelebihan teks yang Anda ketik tidak akan keluar dari cell,
melainkan akan langsung ke baris ke-2 dari cell.

Rahadi Hendrastono
rahadi.h@lycos.com
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Membuat Efek Cahaya
Aura dengan Adobe

Photoshop 7.0

Membuka Unknown
File dengan Notepad

Kita sering menjumpai ekstensi-ekstensi yang belum dikenal oleh
komputer, sebagai contoh .nfo, .diz, dan sebagainya. Walaupun sebenarnya ada
program khusus untuk membukanya, tetapi sebagian besar file tak dikenal ini dapat
dijalankan di Notepad.
Daripada Anda harus repot membuka Notepad kemudian membuka file tersebut
atau memasang program khusus tersebut, akan lebih efektif jika Anda mengatur
agar Notepad dijalankan ketika menemukan unknown file ini. Bagaimana cara
membuatnya demikian? Ikuti langkah berikut.
1. Jalankan Registry editor dengan mengetikkan regedit pada [Start]>[Run...].
2. Masuklah ke key HKEY_CLASSES_ROOT\Unknown\shell.
3. Buatlah subkey baru ([Edit]>[New]>[Key]) dengan nama sesuai selera Anda,

misalnya Notepad.
4. Pada subkey tersebut, klik ganda data (default) dan isikan nilainya dengan judul

yang ingin Anda tampilkan di menu konteks, misalnya &Notepad.
5. Kemudian buatlah sub-subkey baru dibawah subkey Notepad tersebut, dan beri

nama Command.
6. Klik ganda data (Default), kemudian isikan nilainya dengan notepad.exe %1.

Untuk membuat hasilnya, cobalah menjalankan beberapa unknown file. Setelah
trik ini dibuat, Anda juga dapat menampilkan file yang telah diketahui asosiasinya ke
Notepad. Caranya cukup mudah, sorot file tersebut, tahan [Shift]. Kemudian tekan
[Enter] atau klik ganda file tersebut. Selamat mencoba.

Rizki Kurniawan
some132@myself.com

Pada OS (operating system) berbasis Web, misalnya Windows 98,
tersedia fitur Active Desktop di mana Anda dapat mengintegrasikan Web dengan
desktop. Sehingga Anda dapat memasangkan elemen Web, misalnya wallpaper, HTML
atau halaman Web ke desktop, sehingga Anda dapat mengupdatenya dengan mudah.

Cara ini memang bermanfaat bagi Anda yang menggunakan komputer sendiri,
tetapi bila tidak? Misalkan jika komputer berada di warnet, mungkin ada beberapa user
iseng memasang wallpaper Web yang tidak selayaknya ditampilkan atau wallpaper Web
dengan virus VB didalamnya. Sebenarnya Anda dapat menonaktifkan fitur active
desktop ini dengan mudah. Anda cukup melakukan sedikit manipulasi registry, berikut
langkah-langkahnya.
1. Jalankan Registry editor, yaitu dengan mengetikkan regedit pada

[Start]>[Run...].
2. Masuklah ke key

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\
Policies\Explorer.

3. Buatlah data Binary ([Edit]>[New]>[Binary value]) dengan nama
NoActiveDesktop.

4. Klik ganda data tersebut, kemudian isikan nilainya dengan 01 00 00 00.
5. Restart Windows.

Sekarang fitur Active desktop sudah di-disable, untuk mengembalikan ke semula,
Anda cukup mengganti nilainya ke 00 00 00 00 atau menghapus data tersebut. Selamat
mencoba.

Rizki Kurniawan
some132@myself.com

Men-disable Active
Desktop

Anda yang suka
dengan dunia klenik mungkin
sudah biasa mendengar istilah
Aura, atau seberkas cahaya
yang memantul dari suatu objek
atau manusia. Nah, jika Anda
ingin membuat foto yang
mengeluarkan efek aura Anda
bisa mencobanya dengan
program Adobe Photoshop
7.0 atau versi yang terdahulu.
Meskipun objek (seperti gambar
binatang atau gambar manusia)
bukanlah orang sakti yang bisa
mengeluarkan sinar dari sisi
tubuhnya. Langsung saja.
• Buka program Adobe

Photoshop.
• Pilih [File]>[New], pada

Preset size pilih ukuran
640 x 480

• Pada Mode pilih RGB Color
dan pada Contents pilih

White lalu klik [OK].
• Tekan tombol [D] pada

keyboard dan klik [Paint
bucket tool] dan bawa ke

lembar kerja untuk
selanjutnya di klik, sehingga
lembar kerja yang tadinya
berwarna putih kini
berwarna hitam.

• Buka file gambar manusia,
binatang, kotak, bola, dan
sejenisnya yang Anda
punya, pada contoh ini
akan digunakan contoh
objek/gambar patung.

• Tekan tombol [V] pada
keyboard atau klik [Move
Tool] pada toolbox,
kemudian klik gambar yang
baru dibuka (dalam kasus
ini gambar patung) dan
seret (drag) ke lembar kerja
yang telah dihitamkan, atur

posisi di tengah dan ukuran
sesuai selera.

• Klik [Create a new layer]
pada panel Layer (bisa melalui
menu [Window] pilih [Layers]).

• Klik panel Channel kemudian
klik [Load channel as selection].

• Klik kembali [Layer].
• Klik menu [Edit] pilih [Fill…]

pada kotak yang muncul isi
Use: White, untuk mode
pilih Normal, untuk Opacity
isi 100%, klik [OK].

• Klik menu Select pilih
Deselect (bisa juga dengan
menekan [Ctrl]+[D] pada
keyboard).

• Klik menu [Filter] pilih [Blur]
lalu [Radial blur].

• Isi kotak yang muncul,
Amount seret ke kanan
sampai angka 100. Untuk Blur
method pilih Zoom dan

Quality pilih Good atau
sesuai selera, kemudian atur
posisi blue center (dengan
perkiraan) agar pas di tengah
objek (dalam kasus ini gambar
patung) Klik [OK].

• Gambar patung akan terlihat
memancarkan sinar aura, agar
lebih keras efek-nya ulangi
langkah di atas sampai
diperoleh efek aura sesuai
yang diinginkan, untuk
mengulangi langkah di atas
agar lebih singkat cukup
dengan menekan tombol
[Ctrl]+[F] pada keyboard.

• Klik Layer mask thumbnail.

• Untuk membersihkan objek
yang memancarkan sinar
aura (dalam kasus ini
gambar patung) lakukan
dengan Brush tool,
penyapuan dengan Brush
tool dilakukan hanya pada
bagian dalam objek agar
sinar aura hanya tampak di
luar objek yang
mengeluarkan sinar
tersebut.

• Hasil akhir bisa disimak pada
gambar.

I Nengah Mahardhika
ngesik@telkom.net
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Serial ATA sudah
menjadi standar pada
mainboard masa kini.

Fungsi Serial ATA ini
bahkan sudah

terintegrasi pada
sebagian chipset

terbaru. Selain
menggunakan fasilitas

Serial ATA yang
terintegrasi pada

southbridge, sebagian
produsen mainboard

masih memberikan
tambahan dengan

menggunakan chip
eksternal. Ini membuat

mainboard tersebut
memiliki 4 atau lebih

Serial ATA.

engan
tersedianya
Serial ATA pada
mainboard yang

umumnya 2 buah, pengguna PC
setidaknya bisa menambahkan
dua buah harddisk (saat ini Serial
ATA lebih ditujukan pada
harddisk) lagi pada sistemnya
meskipun Parallel ATA-nya sudah
digunakan seluruhnya.
Sayangnya harddisk Serial ATA
belum tersedia seumum harddisk
Parallel ATA, di samping itu
harganya juga relatif lebih
mahal. Hal ini membuat Serial
ATA pada mainboard sering kali
belum digunakan sama sekali
oleh pengguna.

Gunakan Untuk
Harddisk Parallel ATA
Tambahan

Sebagian pengguna PC
sudah menggunakan Parallel ATA
yang tersedia pada mainboard-
nya secara keseluruhan dan
masih ingin menambah harddisk
lagi. Solusi yang terbaik memang
langsung saja membeli harddisk
Serial ATA, tentunya dengan
asumsi pada mainboard yang
digunakan memang terdapat
Serial ATA.

Sayangnya, kadang kala
harddisk tambahan yang
diinginkan itu bisa saja
merupakan harddisk lama dari PC
lain. Harddisk lama ini tentu saja
menggunakan Parallel ATA. Di
samping itu, bisa saja pengguna
yang ingin menambah harddisk
tersebut tidak membutuhkan
harddisk dengan kapasistas yang
besar. Masalahnya, harddisk
Serial ATA dari beberapa
produsen tersedia mulai dari
ukuran 80GB.

Memang ada semacam
anggapan untuk harddisk bahwa
semakin besar semakin bagus,
sayangnya harganya juga
semakin mahal.

Salah satu alternatif adalah
membuat Serial ATA tersebut
menerima harddisk Parallel
ATA. Ini bisa dilakukan dengan
menggunakan konverter
Parallel ATA ke Serial ATA.
Dengan menggunakan
konverter seperti ini, seseorang
bisa memasang harddisk
Parallel ATA-nya pada Serial
ATA di mainboard tanpa
masalah.

Cakrawala Gintings
cakra@e-pcplus.com

D

Urusan bandwidth belum
perlu dipermasalahkan
berhubung kinerja dari harddisk
IDE masa kini masih bisa
ditangani dengan baik oleh

UltraATA/100
sekalipun. Konverter

semacam ini tentunya
menggunakan chip

yang memang dirancang
untuk itu dan tentunya

akan membutuhkan pasokan
daya. Tambahan daya ini juga
bukan masalah.

Menggunakan konverter
seperti ini juga memungkinkan
pengguna untuk

menghubungkan peralatan ATAPI
seperti halnya CD-ROM Drive
pada Serial ATA.

Salah satu perbedaan antara
Serial ATA dengan Parallel ATA
adalah masalah Master Slave. Bila
Parallel ATA mendukung Master
dan Slave maka Serial ATA hanya
mendukung satu peralatan saja.
Sebagian konverter
membutuhkan jumper pada
peralatan yang digunakan untuk

Konverter Parallel
ATA ke Serial ATA

diatur pada Master untuk dapat
bekerja. Dari yang pernah PCplus
coba, meletakkan jumper pada
posisi Slave memang membuat
harddisk tidak terdeteksi.

Menggunakan solusi
konverter ini memang menarik,
sayangnya solusi ini kelihatannya
tidak populer. Hal ini bisa
membuat mencari konverter ini
membutuhkan usaha ekstra. PC+

Salah satu konverter Parallel
ATA ke Serial ATA yang
disertakan bersama mainboard
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Kill Win

Buat Font
dari Tulisan Tangan

Font Creator Program

Banyak sekali font
yang disediakan oleh Windows.
Bahkan setelah menginstal
Microsoft Office, font yang
sudah ada ditambah lagi. Kalau
bosan dengan font yang
disediakan, berbagai situs di
Internet menyediakan font yang
bisa di-download secara gratis.
Tapi kalau merasa kurang
personal dengan font dari
Windows, Office, atau Internet,
Font Creator Program bisa digu-
nakan untuk menciptakan font
dari tulisan tangan kita sendiri.

Apa saja yang diperlukan
untuk membuat font dari tulisan
tangan sendiri? Yang pertama
adalah Font Creator Program
yang bisa di-download dari
www.high-logic.com dengan
ukuran 4,1MB. Software tidak
gratis ini memiliki masa
percobaan selama 30 hari. Font
Creator Program dihargai US$50.

Alat bantu lain yang harus
ada adalah scanner atau kamera
digital, dan software pengolah
gambar seperti Adobe
Photoshop.

Menyiapkan
Karakter-karakter

Setelah seluruh “peralatan
perang” tersedia, mari kita
mulai pekerjaan kita.
1. Ambil secarik kertas. Tulis

semua karakter yang ada di
keyboard (0-9, A-Z, a-z, dan
simbol-simbol).

2. Scan kertas dengan
karakter-karakter itu

dengan scanner. Atau bisa
juga dengan dipotret dengan
menggunakan kamera digital.
Beberapa kamera digital
menyediakan fitur untuk
memotret teks. Jika dipotret,
alangkah baiknya jika kertas
tersebut dipotret benar-benar
tegak lurus dengan kertas.

3. Buka file yang dihasilkan
dengan Adobe Photoshop.
Pilah tiap karakter, kemudian
disimpan dalam sebuah file
terpisah.

Menggunakan Font
Creator Program

Sekarang Adobe Photoshop-
nya bisa ditutup. Yang kita
gunakan sekarang adalah Font
Creator Program.
4. Buka Font Creator Program.

Klik [File]>[New]. Isikan nama
[Font Family Name], [Char-
acter Set] dan [Font Style].
Klik [OK] kalau sudah.

5. Sekarang di layar muncul satu
set font yang belum dimodifi-
kasi. Klik ganda huruf yang
ingin diubah, misalnya a.

6. Muncul boks baru dengan
grid. Klik [Tool]>[Import
Image]. Pada boks [Import
Image], klik [Load…]. Cari file
untuk huruf a, lalu klik [Open].

7. Atur [Threshold] dan [Filter]
sampai sesuai dengan
keinginan. Kalau sudah, klik
[Generate].

8. Pada boks yang ber-grid,
muncul karakter a buatan
kita. Kita bisa memodifikasi

ukurannya dengan men-drag
kotak-kotak yang ada pada
garis putus-putus yang
mengelilingi karakter.

9. Ulangi langkah 5 sampai 8 un-
tuk karakter-karakter lainnya.

Menyimpan dan
Menginstal Font
10. Jangan lupa untuk

menyimpan font yang telah
kita buat. Usahakan font
disimpan beberapa kali untuk
mencegah hal-hal yang tak
terduga. Jangan sampai sudah
capai-capai, di tengah
pekerjaan, PC ngehang, yang
mengakibatkan pekerjaan
harus diulang. Untuk
menyimpan, klik [File]>[Save
As…]. Font yang keluaran
Font Creator Program
langsung ber-extension TTF.

11. Sebelum diinstal, ada baiknya
font di “test drive” dulu
supaya yakin bahwa font
yang dihasilkan benar-benar
sip. Klik [Tools]>[Test…].

12. Setelah lulus “test drive”,
sekarang font tulisan tangan
itu tinggal diinstal agar dapat
digunakan di berbagai
aplikasi Windows. Klik
[Tools]>[Install].

Selesai sudah. Sekarang tuli-
san tangan kita bisa digunakan
untuk membuat dokumen di
berbagai aplikasi di Windows.

Alex Pangestu
alex@e-pcplus.com

Pisah huruf dengan Adobe Photoshop. Masing-masing
huruf disimpan dalam sebuah file.

Kill Win adalah sebuah
software untuk mematikan PC
yang tidak hanya membantu
kita mematikan PC, tapi juga
mer-reset dan me-loggoff
Windows. Bahkan bisa
digunakan untuk menutup
semua window yang terbuka,
masuk ke command prompt dan
menutup semua folder. Semua
itu dapat dilakukan hanya
dengan klik kanan. Freeware
yang dapat di-download di
www.bk-soft.com dengan
ukuran 321KB ini, setelah kita
instal, akan muncul pada system
tray.

Cara menggunakannya
sangat mudah, namun
sebelumnya kita harus
melakukan setting. Klik kanan
pada ikon Kill Win di system
tray lalu pilih [Setting]. Kita bisa
mengatur menu apa saja yang

ditampilkan ketika kita klik
kanan ikon Kill Win pada system
tray.

Sebagai contoh, jika kita
ingin menutup semua jendela
yang terbuka, klik kanan ikonnya
dan pilih [Close all windows].
Dan jika kita ingin agar semua
jendela yang terbuka akan
menutup setelah beberapa
menit, klik kanan ikon Kill Win
dan pilih [Timer Settings]. Pada
[Period] isikan setelah berapa
menit Anda ingin agar semua
jendela menutup, pada pilihan
[Action] pilih [Close All Win-
dows] dan klik [Start]. Dan jika
Anda memberi centang pada
pilihan [Beep 30 sec before
countdown ends], maka
sepanjang 30 detik sebelum Kill
Win menutup semua jendela
akan terdengar suara “tik”. Atau
jika ingin agar Kill Win menutup

semua jendela pada jam dan
menit yang Anda inginkan, isikan
saja pada pilihan [Time] jam dan
menit berapa Kill Win menutup
semua jendela yang terbuka. Hal
tersebut dapat anda coba dengan
Action lainnya seperti [Shut-
down windows], [Logoff], [Reset],
[Close all folder], [DOS Box],

[DOS Mode], dan [Shutdown all
procedures].

Dan masih banyak lagi
kelebihan lain dari Kill Win
seperti me-load script saat start
up, mengeksekusi Action dengan
Hot Keys, mengeksekusi Action
lewat Windows Explorer atau My
Computer, memutar suara ketika

Shutdown Tool
yang Komplet

mengeksekusi Action, dan
berbagai kelebihan lainnya.
Namun untuk mendapat
kelebihan lain itu, Anda harus
membeli Kill Win Pro, bukan Kill
Win versi gratis.

Fadlan Setiaji
aji-edl@plasa.com

Huruf yang sudah diimpor ke Font Creator Program.
Ukuran dan posisinya kadang harus diubah.

Huruf yang sudah jadi bisa dites dulu.
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VoptXP

Defragmentasi
Harddisk

dan TuneUp
Jika komputer terasa
berjalan lambat daripada
biasanya, maka Anda dapat
mencurigai beberapa hal. Salah
satunya adalah apakah isi
harddisk Anda mengalami
fragmentasi cukup parah.

Untuk mengatasi harddisk
yang terfragmen ini, Anda
dapat menggunakan software
dari Windows, yaitu disk
defragmenter. Masalahnya,
software itu begitu
menyebalkan karena waktu
untuk melakukan defrag cukup
lama. Jika Anda mempunyai

Norton Utilities, Anda dapat
menggunakan Speed Disk-nya.
Atau jika tidak, Anda dapat
mencoba yang lain, salah satunya
adalah VoptXP yang dapat dicari
di www.goldenbow.com
dengan lisensi shareware.

Software ini selain dapat
melakukan defrag lebih cepat,
VoptXP juga memiliki fitur-fitur
lain, diantaranya pencarian file,
melakukan clean-up, tuneup
koneksi Internet dan sistem, serta
pengaturan virtual memory.

Pada fitur clean-up, VoptXP
membersihkan cookies, history,

Internet temporary file, url cache,
web content, temporary file dan
x free space yang menghapus
secara tuntas data-data yang
Anda hapus. Tersedia juga fitur
schedule, di mana Anda dapat
menjadwalkan kapan
defragmentasi akan dijalankan.

Selain itu, ada juga fitur LAN
user dan Net Status. Pada LAN
user, Anda dapat melihat siapa

Menambah
Koleksi Icon

Software ini bukan
software untuk membuat ikon
secara manual, melainkan
membuat ikon dari berbagai
sumber yang mendukung untuk
dijadikan ikon. Software ini
bernama SuperIcon 3.5 yang
bisa di-download dari
www.iconexplorer.com.

Apa saja yang bisa menjadi
sumber SuperIcon 3.5 untuk
menghasilkan ikon? Ini dia:
• Ikon file EXE, DLL, OCX,

CPL, ICL, ICO, ANI, dan CUR
yang ada di dalam harddisk.

• File-file gambar. Ada banyak
format file gambar yang

mampu dijadikan sumber
untuk menghasilkan ikon.
Contohnya adalah BMP, JPG,
TIF, GIF, dan format-format
lainnya.

• Halaman situs. Semua gambar
yang ada di sebuah halaman
situs bisa langsung disihir
menjadi ikon.

• Tampilan layar. Tampilan layar
di sini bisa satu layar penuh,
window tertentu atau bagian
tertentu dari window.

• Mencari ikon dari direktori
maupun harddisk.
SuperIcon mengajak agar

penggunanya saling berbagi

SuperIcon 3.5 dengan fitur sharing ikon. Selain
mem-publish, SuperIcon juga bisa
digunakan untuk men-download
ikon dari server yang sudah
terdaftar. Selain itu, SuperIcon
sendiri juga menyediakan ikon-
ikon default mereka.

SuperIcon memiliki masa
pemakaian yang terbatas untuk
versi gratisnya. Masa pemakaian

itu hanya selama 30 hari.
SuperIcon versi lengkapnya
dapat dibeli dengan harga yang
bervariasi, tergantung berapa
license yang dibeli. Untuk lebih
jelas mengenai harga, kunjungi
situsnya atau lihat di Help-nya.

Alex Pangestu
alex@e-pcplus.com

Membasmi
Spybot

Spybot Search and Destroy

saja yang terkoneksi ke jaringan
LAN Anda. Sedangkan pada Net
Status, akan menampilkan dan
memonitor Internet dan atau
proses network. Dari fitur Net
Status ini, Anda dapat
mengetahui apakah PC Anda
sedang di-hack oleh seseorang
atau tidak.

Rizki Kurniawan
rizki.kurniawan.132@students.itb.ac.id

Jika terhubung ke
Internet, demi keamanan
dan kenyamanan, sebaiknya hard-
disk Anda diperiksa dulu untuk
mengetahui ada tidaknya spybot
atau adbot, yaitu bot yang mam-
pu mencuri informasi kegiatan
kita ber-Internet atau bot yang
bertugas menampilkan iklan.

Biasanya bot itu menyim-
pan cookies atau file sementara
yang tersimpan pada
C:\Windows\Cookies,
C:\Windows\Local
Settings\Temporary Internet
Files, C:\Windows\Temp atau
pada C:\Windows\Temporary
Internet Files. Daripada repot-

repot menghapus satu per satu,
Anda bisa menggunakan soft-
ware Spybot Search and Des-
troy. Setelah Spybot Search and
Destroy menemukan cookies atau
file yang mencurigakan, Spybot
Search and Destroy akan meng-
hapusnya atau menggantinya
dengan file yang kosong.

Di antara spybot yang men-
jengkelkan, bot  terkenal yang se-
cara otomatis dihapus Spybot
Search and Destroy adalah: Au-
reate, CLPRS, Comet Cursors, eZula
HotText, Gator, GoHip, Radiate,
WebHancer dan WildTangent.
Software Spybot Search and
Destroy juga dapat menyertakan

Anda dalam milis pembuat
software ini Milisnya adalah http:/
/groups.yahoo.com/group/
PepiMK_Software.

Hal terakhir yang dilakukan
Spybot Search and Destroy adalah
menghapus informasi situs-situs
yang pernah Anda kunjungi, file-
file yang pernah Anda buka, soft-
ware yang pernah dijalankan se-
belumnya dan cookies. Dengan de-

mikian spybot yang tidak kita ke-
tahui pun tidak akan dapat me-
ngirimkan informasi pribadi ini.

Software ini mendukung
tiga jenis browser yaitu: Inter-
net Explorer, Netscape Commu-
nicator dan Opera. Program ini
dapat di-download gratis dari
http://spybot.eon.net.au/.

Andhi Irawan
andhiirawan@hotmail.com
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Mini Barebone
System

M

Istilah mini barebone
system ataupun

barebone system bagi
sebagian pembaca

boleh jadi masih
merupakan istilah yang

asing atau setidaknya
jarang didengar.
Barebone system

adalah suatu istilah
yang mewakili sebuah

sistem dasar yang
biasanya hanya

dilengkapi dengan
mainboard, casing dan

power supply.

emang, sebagian
produsen barebone
system melengkapi
produknya dengan

tambahan komponen lain,
namun syarat dari barebone
system adalah setidaknya
dilengkapi dengan ketiga
komponen di atas. Sementara itu
mini barebone system sesuai
namanya adalah barebone
system yang memiliki ukuran
yang mini, lebih kecil dari ukuran
sistem yang biasa. Mini barebone
system ini kadang kala disebut
juga dengan mini PC atau sejenis
itu.

Ukuran yang mini ini
memiliki beberapa kelebihan dan
kekurangan. Salah satu
kelebihannya adalah mudahnya
mini barebone system ini untuk
dipindahkan, sementara salah
satu kelemahannya adalah pada
slot untuk add-on card yang
umumnya sedikit jumlahnya.

Ukuran Kecil
Seperti telah dijelaskan di

atas, salah satu hal yang menarik
dari mini barebone system ini

adalah ukurannya yang kecil.
Untuk memperoleh ukuran yang
kecil ini, ketiga komponen yang

Cakrawala Gintings
cakra@e-pcplus.com

harus ada itu tentunya harus
memiliki ukuran yang lebih kecil
dari ukuran yang dimiliki sistem
biasa.

Komponen yang terpenting
dari ketiga komponen tersebut
adalah mainboard seperti halnya
pada sistem yang lain. Mainboard
yang digunakan di sini memiliki
ukuran yang lebih kecil bahkan
dibandingkan dengan
MicroATX.

Dari segi form factor, mini
barebone system ini
menggunakan mainboard yang
setidaknya didasarkan pada
FlexATX. FlexATX ini memiliki
dimensi maksimum yang
diperbolehkan sebesar 9,0 inci x
7,5 inci atau 229 mm x 191 mm.
Bandingkan dengan ATX yang
memiliki dimensi maksimum yang
diperbolehkan sebesar 12,0 inci x
9,6 inci atau 305 mm x 244 mm.

FlexATX ini menawarkan dimensi
yang lebih kecil sekitar 40%
lebih.

Dengan mainboard yang
lebih kecil ini, digunakanlah
casing yang memiliki ukuran
yang lebih kecil dari standar.

Dengan mengatur mainboard
yang digunakan (misalnya
dengan tidak memasang
mainboard pada sisi samping
melainkan pada sisi bawah dari
casing), ukuran dari casing bisa
semakin ditekan.

Tentunya
casing ini harus
masih menyisakan
tempat untuk
memasang
beberapa
komponen lainnya
yang umum
digunakan seperti
harddisk dan CD-
ROM Drive. Di
samping itu,
tempat untuk
memasang kartu tambahan
sesuai dengan slot yang
disediakan juga harus tersedia.

Komponen ketiga tentunya
adalah power supply. Power
supply yang digunakan pada PC
banyak yang menggunakan form
factor ATX. Dengan dimensinya

yang berukuran sekitar 150 mm x
140 mm x 85 mm, penggunaan
power supply seperti ini akan
membutuhkan casing dengan
dimensi yang lebih besar lagi.
Oleh karena itu pada mini
barebone system, power supply
yang digunakan juga memiliki

dimensi yang lebih kecil. Dari segi
form factor, form factor power
supply yang ditujukan untuk
FlexATX adalah SFX. Ada

beberapa dimensi
yang tersedia pada
SFX ini, salah
satunya memiliki
dimensi sebesar
125 mm  x 100 mm
x 50 mm.

Untuk ukuran
daya, daya yang
ditawarkan oleh
power supply
dengan ukuran
yang lebih kecil ini,
juga lebih kecil.
Saat ini yang
digunakan banyak

yang berkisar pada angka 200W.

Komponen Lain
Seperti telah dijelaskan di

atas bahwa dengan
menggunakan mainboard dan

power supply yang memiliki form
factor yang lebih kecil dari ATX,
bisa digunakan casing dengan
ukuran yang lebih kecil.

Satu hal yang harus diingat
adalah bahwa komponen lain
yang digunakan untuk
melengkapi mini barebone

system ini menjadi PC seutuhnya
tidak memiliki ukuran yang lebih
kecil dari ukuran standar.
Komponen yang digunakan
memang komponen standar yang
biasa digunakan pada ATX.

Secara umum komponen
tambahan yang digunakan

adalah prosesor beserta HSF-nya,
memori utama, harddisk, CD-
ROM Drive, dan kadang kala
kartu grafis AGP serta floppy disk
drive bagi yang masih
memerlukan. Pemasangan
keseluruhan komponen ini akan
membuat ruangan pada casing
menjadi padat. Dengan semakin
panasnya komponen PC,
perpindahan panas yang baik ke
sekitar diperlukan. Perancangan
agar terdapat airflow dan
pelepasan panas yang baik
memang diperlukan.

Dari segi slot ekspansi yang
tersedia, tidak semua mini
barebone system dilengkapi
dengan slot AGP. Yang umum
adalah mini barebone system ini
dilengkapi dengan sebuah slot
PCI. Hal ini wajar mengingat
sebagian besar fungsi yang
diperlukan sudah tersedia secara
terintegrasi, seperti halnya kartu
grafis, kartu suara, dan fasilitas
LAN.

Untuk chipset-nya sendiri,
mini barebone system ini juga
tidak ketinggalan memanfaatkan
chipset terbaru seperti halnya
i865G. Meskipun kebanyakan
mini barebone system dilengkapi
dengan kartu grafis onboard,
bukan berarti tidak ada mini
barebone system yang tidak
memiliki kartu grafis onboard.
Mini barebone system seperti ini

ada yang memanfaatkan chipset
terbaru untuk kelas performa
seperti i865PE bahkan i875P.
Penggunaan chipset yang terbaru
ini membuat mini barebone
system masa kini juga telah
dilengkapi dengan fasilitas Serial
ATA. Fitur-fitur yang dimiliki oleh

suatu mini barebone
system juga
dipengaruhi oleh
produsen
pembuatnya. Ada
yang menawarkan
dual fast ethernet ada
juga yang
menawarkan 6 in 1
card reader.

Dari segi
performa, dari analisa
terhadap beberapa
pengujian, bisa
dikatakan bahwa mini
barebone system ini
menawarkan kinerja
yang tidak kalah
dibandingkan sistem
ATX yang sekelas.
Dengan kinerja yang

baik dan ukuran yang mini, mini
barebone system ini bisa menjadi
alternatif yang menarik terhadap
sistem yang biasa. Sayangnya
bagi yang memerlukan banyak
slot ekspansi, mini barebone
system masih belum mampu
mengakomodasinya. PC+

Ukuran yang kecil membuat sistem ini mudah untuk dibawa-
bawa

Tidak semua mini barebone system dilengkapi dengan slot AGP

Umumnya sebuah slot PCI masih tersedia pada mini barebone system

Kartu grafis terbaru juga dapat diterima oleh mini barebone system selama
memiliki slot AGP
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Silvester Sila Wedjo
sila@e-pcplus.com Barebone PC: Alternatif

Buat yang Sensitif Ruang
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Kebutuhan akan PC
yang serba multifungsi,

buat sebagian orang
jelas tak bisa ditawar-

tawar lagi. Namun
demikian, kebutuhan

akan PC yang serbabisa
terkadang membawa

pengaruh yang mau
tidak mau harus

diterima yaitu makin
besarnya ruang yang

harus disediakan agar
semua komponen

pendukung bisa
diakomodasi dalam

satu casing.

Dampaknya
jelas. Bentuk PC
makin lama makin
besar. Para produsen

casing pun mengakomodasi
tuntutan banyaknya perangkat
yang harus ditancapi pada CPU
dengan membuat casing yang
semakin besar.

Masalahnya, tidak semua
pengguna PC menginginkan
sistem dengan CPU yang kelewat
besar. Banyak pengguna,
terutama dari kalangan
kantoran, lebih menginginkan PC
dengan bentuk yang ramping
yang bisa menghemat tempat
secara signifikan. Bisa
dibayangkan bagaimana
penuhnya meja kerja bila PC
dengan CPU yang besar harus
ditaruh di atas meja. Belum lagi
harus menyisakan space lumayan
besar bila monitor yang
digunakan adalah tipe standar
berbasis CRT.

Alasan penghematan tempat

dan kebutuhan akan PC yang
ringkas namun tetap mengusung
fitur-fitur penting inilah yang
mendasari beberapa pabrikan
besar berbondong-bondong
membuat sistem yang disebut
barebone PC atau juga dikenal
sebagai mini barebone PC. Saat
Computex 2003 berlangsung
misalnya, terlihat betul pabrikan-

pabrikan besar merambah masuk
ke bisnis barebone PC ini dengan
tipe dan harga yang sangat
relatif.

Siapa Target
Pasarnya?

Dari sisi segmen pasar yang
dituju, sistem berbasis barebone
yang juga sering disebut sebagai

XPC ini rata-rata diperuntukkan
buat kalangan korporat alias
kantoran yang membutuhkan PC
dengan bentuk yang lebih
ramping dari biasa untuk
menghemat tempat. Kebutuhan
seperti ini memang wajar
mengingat space adalah sesuatu
yang mahal di kota-kota besar.

Menurut Julian Hsu dari

Marketing and Sales Division
Biostar yang ditemui PCplus di
arena Computex 2003 di Taipei,
barebone PC selain digunakan
untuk perkantoran yang memiliki
space terbatas, sekarang ini
cenderung juga digunakan buat
para maniak game yang senang
berkumpul bersama untuk
memainkan suatu game. Alasan
ini cukup masuk akal mengingat
beberapa jenis barebone
dipersenjatai dengan
motherboard dari kelas wahid,
meski beberapa fitur penting ada
yang dikurangi lantaran harus
memenuhi form factor yang lebih
kecil. Dengan bentuk yang lebih
kecil namun dengan performa
lumayan, tentu sistem semacam
ini cukup ideal buat para gamer
yang ingin bermain bersama-
sama di suatu tempat.

Hal Senada juga diungkap
oleh Stephen dari Mostech
Gigadonics, distributor resmi
barebone system merek Shuttle
di Indonesia. Menurutnya, sejak
diperkenalkan sekitar satu tahun
lalu, pasar yang paling antusias
untuk PC jenis barebone ini
adalah dari kalangan korporat.
“Perusahaan asing, bank, dan
perusahaan berskala menengah
adalah pembeli yang paling
banyak,” ungkapnya ketika
dihubungi PCplus. Selain karena
ukurannya yang terkesan ringkas,
desain yang terkesan trendi juga

Mungil, ringkas namun bertenaga adalah ciri khas barebone PC masa kini
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membuat para ekspatriat ter-
tarik menggunakan sistem
semacam ini. Sherly dari Atikom,
distributor barebone merek
Whale juga mengungkap gamba-
ran yang kurang lebih sama. Sela-
ma ini, baru kalangan korporat
saja yang meminati sistem bare-
bone yang ditawarkan pihaknya.
“Ada sih kalangan rumahan, tapi
jumlahnya masih sangat kecil,”
tandasnya ketika ditemui di
arena INDOCOMTECH 2003.

Sementara, Joko Chandra,
Product Manager Alfa Artha
Andhaya, distributor produk
komputer merek MSI di Indonesia
berpendapat bahwa pengguna
barebone lebih luas segmennya.
Menurutnya,  pengguna
potensial barebone adalah user
yang menginginkan bentuk
komputer yang mungil, kompak
dan tidak berkeberatan dengan
harganya yang cukup tinggi.
Maklum, rata-rata sistem
barebone harganya mencapai
200 dolar ke atas. “Dilihat dari

kelas sosial dan ekonominya,
mereka berasal dari kelas
menengah ke atas,” jelasnya
pada PCplus.

Namun demikian, Joko
mengakui saat ini pasar barebone
di Indonesia masih sangat
terbatas dan sangat kecil
dibanding dengan pasar PC
secara global. Sampai saat ini
kebanyakan peminat barebone

adalah mereka para hobies.
Bentuk yang mungil merupakan
fakor utama yang mempengaruhi
mereka untuk membeli
barebone, fungsi merupakan
faktor yang kedua. “Sejujurnya
kami belum mempunyai data
yang pasti mengenai pangsa
pasar dari Barebone MSI. Namun
yang pasti, peminatnya dari hari
ke hari semakin banyak,”
tandasnya setengah berpromosi.

“Kalau di Taiwan atau di

negara Eropa, sistem semacam ini
sangat tepat karena kebutuhan
akan PC yang ringkas jadi
tuntutan,” ungkap Stephen lagi.
Tak heran jika menurutnya sistem
ini diminati di negara-negara
tersebut, baik untuk kalangan
korporat maupun kalangan
rumahan. PCplus sendiri
menyaksikan pada salah satu
pabrik pembuat notebook di
Taiwan yang sudah
memanfaatkan barebone ini di
lini produksinya. Alhasil, ruang
yang digunakan memang lebih

sedikit ketimbang menggunakan
PC berukuran standar.

Stephen mengakui, masih
tingginya harga jual per unit
barebone masih jadi kendala
perluasan pangsa pasar ke
kalangan rumahan. Ia
mencontohkan motherboard
khusus yang disandingkan pada
sistem semacam ini rata-rata
harganya masih di atas 100 dolar.

Padahal dengan chipset yang
sama dengan fitur yang lebih
banyak, motherboard biasa
harganya bisa jauh lebih murah.
Dengan mahalnya harga
motherboard ini, tak heran jika
harga jual termurah sistem
barebone ini masih di atas angka
160-an dolar per unitnya. Merek
Whale misalnya dijual dengan
kisaran sekitar 160 dolar dengan
bundel prosesor Pentium-3,
casing dan power supply 300

watt, mouse, serta
motherboard. Sementara,
merek Shuttle yang
mengusung motherboard,
casing dan power supply
dihargai sekitar 170 dolar
untuk satu-satunya tipe
yang dijual di Indonesia.

Tingginya harga jual
unit barebone ini juga
diakui Alfredo Hui, Direktur
Utama Astrindo Senayasa,
distributor produk merek
Asus di Indonesia. “Wajar
saja harganya sedikit lebih
tinggi, mengingat casing,
pendingin dan
motherboard yang dipakai
didesain secara khusus,”
ungkapnya.

Makin Lama
Makin Variatif

Uniknya, untuk
memperbesar pangsa pasar,

para produsen barebone pun
kemudian merancang beberapa
jenis barebone yang lebih
bersifat multimedia dan lebih
bertenaga agar kalangan
rumahan pun tertarik memiliki
sistem semacam ini. MSI, Asus,
Dell, Whale, dan Gigabyte
misalnya, belakangan
mengeluarkan sistem-sistem
khusus yang membundel
barebone dengan fitur
mulitmedia yang tidak hanya
diperuntukkan buat penggunaan
standar tapi juga untuk

penggunaan aplikasi
multimedia.  MSI, Asus, dan
Gigabyte bahkan merancang
sistem barebone yang dapat
menjalankan aplikasi-aplikasi
tertentu tanpa harus masuk
sistem operasi terlebih
dahulu.

produk  barebone
bikinan  MSI misalnya yang
diberi nama  MEGA PC.
Produk ini mempunyai
positioning produk yang
berbeda dengan Barebone
pada umumnya. Joko
mengaku pihaknya memo-
sisikan produk ini  untuk
para hobies yang membu-
tuhkan dan menyukai
hiburan seperti Radio, CD-
Player, MPEG3 Player.
MEGA PC adalah gabungan
antara Barebone dengan
Hi-Fi.

Belakangan, Asus juga
memperkenalkan DigiMatrix
yang merupakan barebone
multimedia, di samping juga
produk barebone lain semisal
Prodigy, Terminator, dan lain-lain.
Menurut Alfredo Hui, DigiMatrix
yang dibundel tanpa harddisk,
prosesor, dan memori ini
merupakan barebone yang
mengintegrasikan PC dengan
entertainment sekaligus aplikasi

wireless dalam satu sistem.
“dalam sistem ini, pengguna bisa
menikmati DVD, TV, radio, plus
teknologi HI-FI,” ungkapnya lagi.

Menariknya, beberapa jenis
mendukung pula sistem yang
lebih bertenaga. Biostar misalnya
pada beberapa serinya
mengusung motherboard kelas
performace macam nForce 2,
bahkan nForce 3 untuk sistem
berbasis AMD. Bisa jadi langkah
ini untuk mengakomodasi para
pengguna PC yang ingin

menggunakan sistem barebone
namun tetap menginginkan
kemampuan PC kelas perfor-
mance dari komputernya.

Selain fitur dan
kemampuannya, beberapa tipe
juga melengkapi diri dengan
sistem pendingin yang cukup
memadai.

Ini memang bisa
dimengerti mengingat banyak
yang masih ragu soal panas
yang muncul dengan sistem
yang berukuran kecil ini.

Shuttle yang merupakan
perintis sistem barebone ini
misalnya menggunakan sistem
ICE heat pipe technology pada
beberapa tipenya, dimana
menggunakan sistem pendingin
mirip kondensator AC yang
menarik udara panas keluar
dengan mekanisme tertentu.
Alhasil panas yang diusir keluar
bisa lebih baik.

Sebagian besar barebone
juga melengkapi diri dengan
casing aluminium plus desain
khusus sehingga panas bisa
dilempar keluar dengan baik.
Biostar dan Cryptonix juga
mendesain khusus kabel kabel
data sedemikian rupa sehingga
tidak mengganggu aliran udara
dalam casing.

“Barebone Asus juga
menggunakan casing khusus
dengan tata letak yang unik
sehingga panas sistem

dipastikan masih di bawah
ambang batas normal,” ungkap
Alfredo lagi.

Sayangnya, meski terkesan
sangat ringkas, untuk sistem
semacam ini upgrade maupun
penambahan perangkat agak
terbatas. Beberapa seri misalnya
betul-betul full onboard sehingga
sulit buat penggunanya untuk
misalnya mengganti kartu grafis
karena pada sistem tidak
disediakan port AGP. Hanya
beberapa tipe saja yang

motherboard-nya masih
menyediakan port AGP. Untuk
kartu tambahan lainnya juga
agak sulit mengingat rata-rata
barebone yang ada hanya
menyisakan sebuah port PCI
sebagai interface dengan
perangkat kartu tambahan lain.
Ini memang konsekuensi logis
untuk memangkas ukuran
barebone. PC+

Barebone dengan teknologi multimedia dahi HI-FI belakangan jadi fenomena
tersendiri pada barebone PC modern.

Desain casing dan motherboad yang khusus menjadi salah satu penyebab
tingginya harga jual sistem barebone dibanding sistem PC konvensional.

Kompak dan ramping membuat barebone diminati pengguna yang sensitif
ruang.

Desain khusus plus letak komponen yang cermat mampu membuat suhu
ruang dalam barebone tetap dingin meski sedang bekerja untuk aplikasi
berat.
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Vincent Bayu T.B.
vincent@e-pcplus.com Kreasi Kartun

Menggelitik
dan Santun

dengan Adobe PhotoshopB

Kartun merupakan bentuk citra yang diubah dari
bentuk aslinya, didistorsi untuk menonjolkan

sifat-sifat atau karakter tokoh. Kartun yang baik
bisa menjadi “cermin”  refleksi diri bagi tokoh

yang digambarkan, maupun situasi sosial.

anyak orang beranggapan bahwa kartun hanya
bisa dibuat oleh jago lukis. Benarkah demikian? Digital
Imaging yang menjadi alat kerja kita harus bisa
menjawabnya…

Pemisahan Kepala dari Tubuh Tokoh
1. Buatlah seleksi dengan kurva. Gunakan [Pen Tool]. Setiap kali menambahkan titik

kurva, gerakkan sedikit mouse agar ruas garis yang terbentuk tidak menjadi garis
lurus, melainkan garis lengkung yang bisa diedit mengikuti pinggiran gambar.

2. Editlah kurva pada setiap titiknya. Gunakan Direct Selection Tool. Tarik, putar han-
dle point sehingga garis mengikuti pinggiran gambar yang diinginkan.

3. Klik tab [Path] pada palet layer atau dengan klik menu [Window]>[Show Path]. Klik
ikon [Load Path as Selection] di bagian bawah palet Path.

4. Klik menu [Select]>[Feather]. Beri nilai kecil, misalnya 2 agar pinggiran seleksi tidak
terkesan tajam, seperti guntingan. Klik menu [Select]>[Inverse].
Buang bagian gambar yang tidak perlu dengan tombol [Delete] atau klik menu
[Edit]>[Clear].

5. Ubah ukuran kepala. Buatlah lebih besar dari badan yang nanti akan diberikan. Klik
menu [Edit]>[Transform]>[Scale]. Tekan terus tombol [Shift] (agar proporsi panjang
dan lebar gambar tetap) sambil menggeser handle point yang ada di sudut. Jangan
gunakan yang tengah.

Memberi Efek Ilustrasi pada Foto
1. Ubahlah mode warna foto menjadi grayscale (hitam-putih) dengan klik menu

[Image]>[Mode]>[Desaturate] atau [Grayscale].
2. Tingkatkan kontras foto dengan mengatur Levels dan Brightness and Con-

trast. Klik menu [Image]>[Adjust]>[Levels] atau [Brightness and Contrast].
Atur dengan menggeser slider- nya.

3. Terapkan filter Stamp atau Torn Edges. Klik menu [Filters]>[Sketch]>[Stamp]
atau [Torn Edges]. Atur slider sehingga foto menjadi “High-key” (Nada tengah
atau midtone berkurang, tertinggal nada gelap dan terangnya).

4. Sederhanakan bentuk dan garis-garis pada gambar dengan filter Cutout. Klik
menu [Filters]>[Artistic]>[Cutout].

Memasukkan Dialog atau Bodycopy Kartun
Tambahkan dialog yang sarat makna tapi singkat, jelas, dan menggelitik pada

kartun. Gunakan Text Tool untuk menulis. Jangan lupa memilih nada gelap pada
palet Foreground Color untuk warna font. Jangan lupa memberi “balon kata”
atau panah untuk menandai tokoh yang mengucapkan kalimat.

Save pekerjaan Anda….

Menambahkan Elemen-elemen Penunjang Kartun
Tambahkan elemen-elemen penunjang yang bisa menonjolkan karakter tokoh,

situasi dan identitas lingkungan, dan sebagainya. Perlengkapan kerja kesukaan
tokoh atau baju khas tokoh bisa juga ditambahkan. Terapkan kelompok filter
Artistic atau filter-filter Sketch untuk membuat efek ilustrasi.

Mari belajar menjadi kritis dan mengambil sikap lewat kartun. PC+

Buat path
dengan pen Tool

Atur handle
point kurva
path dengan

Direct
SelectionTool

Ikon load path
as selection
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GNU/Linux Knoppix 3.2:
Sistem Operasi Mobile dalam

CD yang “Iptek Minded”

Vincent Bayu T.B.
vincent@e-pcplus.com

M

Sifat open source GNU/
Linux telah

memungkinkan
lahirnya distro (varian)

yang sifatnya alternatif
dan unik, salah satunya

adalah GNU/Linux
Knoppix. Distro ini

dikemas dalam satu
keping CD dan dapat

dijalankan melalui
CDROM tanpa harus

menginstalnya ke
dalam harddisk.

aka, belajar
mengenal Linux tidak
lagi dihambat oleh
permasalahan

penyusunan partisi pada proses
instalasi yang merupakan bagian
terpenting. User juga dapat
menenteng sistem operasi ke
mana saja, bekerja, menyunting,
dan menyimpan data di mana
saja dan kapan saja.

Otomatisasi Mount-
ing Hardware dan
Partisi

Partisi-partisi di dalam
harddisk secara otomatis telah
ter-mount, sehingga kita bisa
mengambil maupun menyimpan
data ke dalam suatu partisi.
Namun demikian, sebelumnya
partisi tersebut harus diubah dulu
supaya bisa ditulisi. Caranya, klik
kanan pada partisi, kemudian
pilih [Change Partition to
Writeable] (Gambar 1).

Jika tanpa instal, tanpa
membuat user, user password,
root password, kita login sebagai
siapa? Lalu, bagaimana cara login
sebagai root? Jawabannya, kita
login sebagai user Knoppix secara
default. Lalu, kita login sebagai
root secara otomatis lewat menu
utama [KDE]>[Knoppix]>[Root
shell] dengan fasilitas yang
bernama Xroot (Gambar 2).
Setiap kali keluar dari sistem,

pengaturan yang telah dilakukan
pada sistem akan dihapus dan
dikembalikan ke kondisi semula.

Konfigurasi Hardware
Konfigurasi hardware dapat

dilakukan dengan tampilan grafis
lewat menu utama
[KDE]>[Knoppix]>[Configure].

Hardware yang paling sering
diatur lewat fasilitas ini adalah
kartu suara, kartu jaringan, mo-
dem, serta printer (Gambar 3).

Varian GNU/ Linux
Debian Tampilan
Desktop KDE dan
Aplikasi Teknis

Knoppix 3.02 menggunakan
desktop KDE dan paduan aplikasi
kantoran antara Koffice dan
OpenOffice. OpenOffice

menawarkan keluasan format
file, mulai dari yang format
standar OpenOffice, Windows 95,

97, 2000, ME sampai XP, format
interchange, dan sebagainya.
Sementara itu, Koffice
merupakan penyunting aplikasi
kantoran yang relatif ringan.

Pada dasarnya, GNU/Linux
Knoppix merupakan turunan dari
distro GNU/Linux yang cukup
eksis, khususnya di Jerman, yaitu

GNU/Linux Debian.
Sesuai dengan ciri
khas GNU/Linux
Debian yang
cenderung berbau
teknis, GNU/Linux
Knoppix
menyertakan
banyak aplikasi
teknis, seperti Grace
(aplikasi
matematika),
Kgeom (aplikasi
matematika

geometri). Bahkan, ada
kelompok aplikasi yang bernama
Edutainment. Salah satu aplikasi
yang menarik adalah Kstars yang
berisi peta tatasurya. Di
dalamnya, kita bisa menjelajah
galaksi-galaksi, melihat berbagai
rasi bintang. Di dalam Kstar user
bisa menampilkan garis
konstelasi rasi bintang, nama rasi,
planet, bintang, benda langit
yang jauh dan tersamar (deep sky
objects), horison pandang, grid

posisi bintang
pada  koordinat
garis lintang dan
bujur Bumi, dan
pilihan
menampakkan
galaksi
Bimasakti. Selain
itu, kita dapat
mengetikkan
nama benda
langit dan
mencarinya
lewat fasilitas
Find Objects.

Peta langit akan bergeser
otomatis, sehingga objek yang
dicari akan terletak di tengah
monitor.

Begitu pula, fasilitas [Set
location] yang dilengkapi peta
daerah waktu beserta jam,
tanggal, bulan, dan tahun saat
kita menggunakan Kstars akan
memperlihatkan peta langit yang
dapat dilihat di atas wilayah
tersebut pada waktu dan tanggal
tersebut (Gambar 4). Hebat,
ya..? Kalau begini caranya, ilmu
pengetahuan dan teknologi bisa
disajikan secara interaktif,
populer, serta akan mampu
menarik minat terhadap iptek.

Aplikasi Grafis: Mulai
dari Manipulasi Foto,
Desktop Publishing
Sampai Desain
Arsitektur

GIMP tentu sudah dikenal
luas sebagai aplikasi penyunting
foto atau gambar di berbagai
distro GNU/Linux. Lebih dari itu,
GNU/Linux Knoppix menyertakan
program penyunting gambar
lain, seperti Kpaint. Sementara
itu, untuk melihat (browser) file
grafis disediakan Kuickshow dan
Kview. File berformat PDF juga
dapat dibuka dan dilihat di GNU/

Linux Knoppix dengan
menggunakan KghostView.

Meskipun belum sehebat
dan selengkap Adobe
Pagemaker, GNU/Linux Knoppix
menyediakan aplikasi penyunting
halaman dan tataletak desktop
publishing yang bernama Scribus.

Desain interior dan arsitektur
yang selama ini sangat familiar
dengan software AutoCAD atau
ArchiCAD dapat mencoba
menggunakan Qcad yang

menggunakan format file
Drawing interchange (DXF), EPS,
serta CXF.

Qcad ditulis dalam versi yang
bisa berjalan di atas sistem
Linux, maupun sistem
Windows (Gambar 5).

Aplikasi Internet
Berbagai fasilitas

Internet yang disediakan
oleh GNU/Linux Knoppix
antara lain Konqueror dan
Mozilla sebagai browser
Internet, Kmail dan
Evolution sebagai e-mail
client, Kchat sebagai
online messenger, dan lain-
lainnya.

KPP berfungsi sebagai dial
up tool, sedangkan ADSL/PPPOE
untuk konfigurasi.

Entertainment dan
Game, Hal yang Tidak
Tabu di Distro Teknis

GNU/Linux Knoppix mengu-
sung berbagai aplikasi hiburan,
misalnya Xine (pemutar VCD) dan
XMMS (pemutar file audio). Un-
tuk menunjang kepuasan dalam
aplikasi hiburan, GNU/Linux
Knoppix bahkan menyodorkan
fasilitas Wine, yaitu emulator

yang memungkinkan game dan
program-program Windows
dijalankan di Linux (Gambar 6).

Fasilitas lain
Selain aplikasi desktop pu-

blishing, teknis dan multimedia,
GNU/Linux Knoppix juga menyer-
takan fasilitas pengembangan,
yaitu berbagai kernel: Bash, Csh,
Sash, Sh. Aplikasi pemrograman
yang digunakan adalah Phyton
2.1 dan 2.2 serta Kdevelop 2.1.

Kesimpulannya, predikat
GNU/Linux Knoppix sebagai
distro Linux yang sangat concern
terhadap pengembangan ilmu

pengetahuan dan teknologi
patut kita acungi jempol. Tentu
saja, dapat kita bayangkan
dukungan ini di "induk" Knoppix
: GNU/Linux Debian. PC+

Gambar 1: Desktop KDE GNU/Linux Knoppix beserta ikon partisi
harddisk yang bisa dibuat writeable.

Gambar 2: Fasilitas Xroot untuk login
sebagai root

Gambar 3: Konfigurasi hardware

Gambar 4: Tampilan peta tata surya langit di atas Jakarta pada
tanggal 6 Oktober 2003 jam 18.30 WIB menurut Kstars.

Gambar 5: Layar sunting Qcad, program desain arsitektur yang
setara dengan AutoCAD.

Gambar 6: Emulator Wine.
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Liquid Chystal Display
yang merupakan salah
satu tipe monitor, saat

ini memang bukan
barang baru.

Keberadaannya sudah
bisa dirasakan sejak

beberapa tahun lalu.
Hanya saja, berhubung

harganya yang masih
selangit, hanya

kalangan tertentu saja
yang mampu

memanfaatkan tipe
yang satu ini.

isa
dibayangkan
mahalnya harga jual
monitor jenis ini jika

satu unit berukuran 15 inci bebe-
rapa bulan lalu harganya bisa
mencapai 400 dolar per unitnya.
Padahal, dengan harga sebesar
itu pembeli bisa mendapatkan
satu unit PC kelas value atau
bahkan kelas mainstream.

Namun, lambat tapi pasti,
harga monitor LCD ini makin
terjangkau. Ada beberapa sebab
yang ditengarai menjadi penye-
bab turunnya harga monitor jenis
ini. Selain pembuatannya makin
massal sehingga ongkos produk-
sinya makin murah, persaingan
antarmerek juga menjadi penye-
bab turunnya harga. Tomasz
Swatowski, Marketing Planning
Departemen dari Albatron yang

LCD: Makin Hebat
Tapi Makin Terjangkau

Silvester Sila Wedjo
sila@e-pcplus.com

juga memasarkan LCD mengakui
fenomena ini ketika ditemui
PCplus pada pameran Computex
2003 di Taipei beberapa saat lalu.
Dengan makin banyaknya pe-
main di pasar LCD ini, ia yakin
dalam beberapa bulan menda-
tang harga jual monitor LCD bisa
lebih terjangkau lagi. Untuk mo-
nitor dengan panjang diagonal
15 inci misalnya, bila beberapa
bulan lalu harganya masih men-
capai angka 390-an dolar, di awal
bulan ini harganya tinggal berki-
sar 275 dolar saja. Sementara, me-
rek BenQ berani mematok harga

sebesar 269 dolar per unit untuk
tipe termurahnya. Bahkan, Acer
untuk tipe AL506 dipatok

seharga 260 dolar per unitnya!
Harga ini jauh lebih murah diban-
ding beberapa bulan sebelumnya.

Merek yang
beredar pun ma-
kin beragam.
Dulu misalnya
hanya beberapa
merek terkenal
saja yang “mema-
dati” pangsa pa-
sar LCD ini macam
LG, Samsung,
Fujitsu, Philips,
Sony, dan lain-
lain. Namun

sekarang, Anda
bisa memilih be-
gitu banyak jenis
dari beragam
merek. Acer mi-
salnya, paling ti-
dak memajang 6
jenis untuk uku-
ran 15 inci dan 17
inci sementara
BenQ menggelar
7 monitor dengan
ukuran yang

sama. Sementara merek lain juga
tak mau kalah dengan mengeluar-
kan beragam model untuk ukuran

15 inci dan 17 inci, tentunya de-
ngan spesifikasi teknis dan kuali-
tas yang beragam pula.

Menariknya, untuk sekarang
ini, pangsa pasar yang diperebut-
kan masih untuk ukuran 15 dan
17 inci. Sementara, untuk di atas-
nya masih sedikit merek yang
bersaing. Menurut Hariman
Surjadi dari Prolink Indonesia, ini
karena pangsa pasar di Indonesia
untuk monitor LCD ini yang keba-
nyakan datang dari kalangan
korporat baru bisa menyerap
ukuran 15 inci dan 17 ichi.
Sementara, untuk ukuran 19 inci
atau lebih masih tergolong sa-
ngat mahal sehingga peminatnya
tidak terlalu banyak. Oleh karena

B

itu, wajar saja jika tipe-tipe yang
berukuran kecil memiliki model
dan jenis yang lebih beragam.

Kualitasnya Juga
Semakin OK

Dalam perkembangannya,
selain dari segi harga makin ter-
jangkau, teknologi yang diberi-
kan oleh para produsen monitor
jenis ini pun makin canggih saja.
Simak saja misalnya beberapa
merek terkenal yang sudah
berani  membanggakan respons
time produk LCD mereka yang
sudah mencapai 16 miliseken.
Dengan respons time sebesar ini
para gamers tidak perlu lagi
merasa cemas monitor LCD yang
dipakai terkesan agak lambat
menampilkan respons gambar
game yang cepat.

Selain itu, pixel pitch,
contrast ratio, resolusi maupun
sudut penglihatan yang diberikan
juga semakin baik sehingga
kualitas gamber juga lebih baik.
Beberapa tipe bahkan dilengkapi
dengan speaker maupun fitur
khusus lainnya plus iming-iming
penghematan energi yang lebih
untuk menarik pembeli.

Kalau Anda sejak lama me-
mimpikan punya monitor yang
hemat ruang semacam ini, mung-
kin sudah saatnya Anda mereali-
sasikannya. Dengan harga yang
relatif sudah terjangkau plus kua-
litas yang sudah jauh lebih maju,
tak ada salahnya Anda beralih
dari layar CRT.

Toh di masa depan monitor
LCD ini akan jadi tren! PC+

Produksinya yang makin massal plus makin
banyaknya produsen membuat harga monitor LCD
makin terjangkau

Kemampuan teknisnya sudah jauh lebih baik
dibanding generasi sebelumnya
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Bagi pembaca yang tertarik untuk
berinteraksi di rubrik ini, silakan
mendaftar dengan mengirimkan

e-mail  kosong ke
mailplus-

subscribe@yahoogroups.com.
Agar keanggotaan Anda segera

diaktifkan, balas e-mail konfirmasi
yang dikirimkan oleh Yahoo ke

alamat e-mail Anda. Setelah
terdaftar, Anda dapat

mengirimkan e-mail pertanyaan
ataupun tukar menukar

pengalaman seputar dunia
komputer. Jangan lupa untuk

memeriksa account e-mail Anda
secara rutin.

Jika Anda tertarik untuk
berdiskusi langsung secara online,

silakan Anda join ke server
DALnet pada channel #chatplus di

mIRC.

PENTING!!!
Kalau Anda ingin menerima

dan membaca e-mail secara digest
(satu e-mail berisi beberapa

message), kirim e-mail kosong ke
mailplus-

digest@yahoogroups.com.
Sebagai informasi, setiap hari

Jum’at hingga Minggu adalah hari
bebas di milis ini. Setiap anggota
dapat mem-posting e-mail diluar

seputar masalah komputer
asalkan tidak mengandung SARA,

pornografi, bajak-membajak
software, flamming, dan

sebagainya. Jika Anda tidak ingin
menerima e-mail OOT (Out Of

Topic), kirim e-mail ke mailplus-
nomail@yahoogroups.com, dan

silakan Anda aktifkan kembali ke
mode normal dengan mengirim e-

mail ke
mailplus-

normal@yahoogroups.com.
•Redaksi

Harddisk 80 Gigabyte

Hi all. Teman saya baru beli
harddisk kapasitas 80GB 7200
rpm, tetapi kok tak terdeteksi ya?
Bagaimana nih? Harddisk terse-
but dipasangkan ke komputer
kelas Pentium-II dengan memori
SDRAM 128MB. sebagai infor-
masi, di situ udah ada harddisk
primary berkapasitas 4,3GB. Ada
yang bisa bantu? Terima kasih
sebelumnya.

Adi

Jawab:
Setahu saya, kapasitas hard-

disk maksimal yang di-support
motherboard kelas Pentium-II
cuma sampai 20GB (CMIIW). Ada
cara untuk mengatasinya, tapi
risikonya cukup gede yaitu
dengan meng-update BIOS.
Moga-moga aja bisa. Coba
kunjungi website produsen
motherboard tersebut dan cari
file untuk update BIOS-nya.

Ada sih, cara lain yang lebih
aman. Pakai Disk Manager ke-
luaran produsen harddisk terse-
but. Cara lain yang nggak berisi-
ko, ya jual lagi aja. Terus beliin
harddisk yang agak kecilan dikit
dan beli CD-RW untuk membakar-
bakar isi harddisk agar tetap ter-
jaga. Sebaiknya memang nggak
usah maksain pakai harddisk gede
banget buat motherboard
kesayangan yang Anda pakai.

Phino, Andi Kurniawan, djoko,

LuckyGuy354, The Gunners

Tidak Bisa Shockwave

Rekan-rekan milis, tolongin
aku dong. Kalau aku memakai

Suhu Standar Athlon
XP 2000+

Teman-teman, suhu standar
untuk Athlon XP 2000+ berapa
sih? Kok di komputer saya
kadang-kadang suhu prosesor
tersebut bisa sampai 63°C?
Padahal saya sudah menukar
heat sink fan standarnya ke
Thermaltake (tapi saya lupa
jenis yang mana euy, yang ingat
pasti, pada heat sink fan
tesebut ada sensor suhunya).

Di casing saya juga sudah
ada empat buah kipas (dua di
depan harddisk, satu di bawah
power supply, dan satu di
samping). Sebagai informasi,
spesifikasi komputer saya
adalah sebagai berikut:
• Prosesor Athlon XP 2000+
• Motherboard soket A (VIA

KT400)
• DDR PC 2100 256MB V-Gen
• Harddisk Seagate Baracudda

ATA IV 40GB 7200rpm
• Kartu grafis PixelView

GeForce-4 MX440 SDR 64MB
• CDRW LiteOn 24/10/48
• DVD AOpen 16x
• Casing Simbadda 2717

Keluhan lainnya, kok pada
komputer saya ini debunya
banyak banget ya? Dalam satu
minggu saja koleksi debunya
sudah bisa bikin bersin-bersin.
Casing tersebut memang saya
letakkan di bawah meja,

dengan suhu ruangan sekitar
27°C (suhu standar kawasan
Bandung Utara). Kalau memang
suhu prosesor komputer saya
tersebut terlalu panas, kira-kira
apa obatnya ya? Saya takutnya
prosesor saya tersebut gosong
karena kepanasan. Makasih
sebelumya.

Yudi

Jawab:
Pertama-tama, coba

cek dahulu pemasangan
heat sink fan apakah
sudah benar (antara
prosesor dengan heat sink
sudah benar-benar
kontak) dan antara
prosesor dengan heat sink
fan sudah diberi thermal
grease/thermal paste?

Kedua, Anda
mengukur suhunya dari
mana? Software atau
BIOS motherboard-nya?
Jika Anda kurang yakin,
coba Anda sentuh heat
sink-nya, kalau memang
63°C itu sudah panas lho
diraba pakai jari.

Masalah debu yang
menumpuk, memang sudah
wajar kalau PC Anda memiliki
banyak fan. Apa lagi tempatnya
di bawah meja. Anda rajin-rajin
saja membersihkan debunya.

Menurut pendapat saya,
kalau suhu prosesor Anda

memang seperti itu, untuk
prosesor tersebut cukup saya rasa
memang terlalu panas. Tetapi,
suhu tergantung juga pada
motherboard dan prosesor
Athlon XP-nya juga lho.

Kemarin saya memasang
Athlon XP 2100+ Thoroughbred

A di Abit NF7-S, suhunya
menembus 45°C dengan heat
sink fan standar dan over voltage
0.05V.

Sedangkan di PC saya,
Athlon XP 1800+ Thoroughbred
B dengan motherboard EpoX
8K5A2, suhunya cuma 35°C
dalam kondisi standar dengan

heat sink fan CM X-Dream.
Coba cek putaran kipas HSF-
nya. Cek juga pemasangan
HSF-nya, siapa tahu kurang
pas.Cek juga Vcore-nya. Apakah
masih standar atau ketinggian.
Kalau sudah beres semua  tetapi
masih panas, coba buka casing-

nya lalu lihat perbedaan
suhunya.

Kalau panasnya masih juga
sama dengan kondisi casing
dibuka, ada kemungkinan
sensor suhunya yang memang
corrupt.

Ronny, Mat Gemboel

Download
Software 3DMark

Rekan-rekan, saya
penasaran ingin menguji kinerja
grafis pada komputer saya. Saya
bermaksud untuk mengetahui
angka untuk uji 3DMark-nya.
Yang saya ingin tanyakan, di
mana ya situs untuk men-

sistem operasi Windows 98, saat
aku buka webpage yang ada
animasi shockwave-nya, aku bisa
menyimpan file dengan ekstensi
*.swf tersebut ke harddisk
setelah aku temukan file-nya di
folder Temporary Internet Files.

Sekarang, saat saya
menggunakan sistem operasi
Windows XP, koq file tersebut
tidak bisa muncul ya? Saya sudah
bolak-balik mencarinya dengan
fasilitas Find, juga tidak bisa.
Adakah di antara rekan-rekan
yang tau caranya? Saya sudah re-
install Shockwave Player tapi
masih tidak bisa juga.

Saya ingin sekali menyimpan
animasi yang bagus-bagus itu,
nggak cuma sekadar menikmati
di web page. Apakah ada
proteksinya agar tidak bisa
dicomot tanpa ijin?

Aguslengky

Jawab:
Bisa kok. Di tempatku aja

bisa. Kalau nggak salah, ekstensi-
nya bukan *.swf. Aku Agak lupa
sih, tapi coba kamu lihat source-
nya. Kalau kamu menggunakan
Internet Explorer, klik opsi
[View]>[Source]. Lalu cari tag
<object>. Setelah ditemukan,
coba kamu lihat nama file-nya
yang tercantum di sana. Setelah
itu baru Anda search di folder
Temporary Internet Files.

LuckyGuy354

Software
made in Indonesia

Rekan-rekan milis, kemarin
ini kan banyak yang resah akibat

ramainya masalah software
original.

Sehubungan dengan itu,
saya ingin tanya nih. Apakah
software buatan Indonesia sudah
ada yang merupakan sistem
operasi? Atau minimal aplikasi
kantoran lah.

Rasanya rindu juga melihat
informasi di software yang
menggunakan bahasa Indonesia.

Maksudnya biar tidak bingung-
bingung lagi baca petunjuknya.

Yudi

Jawab:
Kalau seperti software akun-

tansi, kelihatannya sudah cukup
banyak. Untuk sistem operasi,
setahu saya ada sebuah distro
Linux buatan orang Indonesia.
Namanya Software RI (sebelum-

nya sudah ada juga yang nama-
nya Trustix Merdeka). Sistem ope-
rasi ini dibuat oleh anak negeri
berbasiskan Linux Trustix. Seba-
gian aplikasi yang terbundel de-
ngan Software RI ini interface-nya
sudah berbahasa Indonesia, demi-
kian juga interface saat instalasi.

Adri Febrianto, I Made C.

Wirawan, Kang Durahman

download software 3DMark ini?
Terima kasih sebelumnya. Salam,

Wistiaman

Jawab:
Software ini dapat Anda dapat-

kan di situs www.madonion.com
atau langsung saja ke
www.futuremark.com. Anda

dapat men-download versi gra-
tisnya di sana. Untuk menguji ki-
nerja kartu grafis yang mendu-
kung DirectX 8.1 Anda dapat
menggunakan 3DMark 2001 SE,
sedangkan untuk menguji kartu
grafis yang mendukung DirectX
9.0, Anda dapat menggunakan
3DMark 2003.

Mat Gemboel

✔

+

✔

+

✔

+

✔

+

✔

+
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Menggambar Grafik
dengan PHP

Yahya Kurniawan
yahya@e-pcplus.com

('juli',210);
insert into th2002 values
('agustus',200);
insert into th2002 values
('september',250);
insert into th2002 values
('oktober',225);
insert into th2002 values
('november',235);
insert into th2002 values
('desember',275);

Simpan teks tersebut
misalnya dengan nama laba.sql.
Lalu kita gunakan perintah di
bawah ini untuk memasukkan
data tersebut ke dalam tabel:

# mysql laba < laba.sql

Bila perlu tambahkan path
lengkap dari file laba.sql
tersebut.

Setelah database beserta
data-datanya selesai kita buat,
sekarang kita siap untuk
membuat skrip PHPnya. Skrip
tersebut adalah sebagai berikut:

<?
Header("Content-Type:image/
jpeg");

// --- Koneksi ke MySQL --- //
$host = "localhost";
$user = "user";
$pswd = "password";
$conn = @mysql_connect
($host,$user,$pswd)

or die("Koneksi gagal:
" . mysql_error());
mysql_select_db("laba",$conn);

// --- ambil data --- //
$strSQL = "select * from
th2002";
$qry = @mysql_query
($strSQL,$conn)

or die("Query salah: "
. mysql_error());

// --- alokasi “kanvas” dan
warna  --- //
$img = ImageCreate(700,900);
$warna[0] =ImageColorAllocate
($img,0,255,0);
$warna[1] =ImageColorAllocate
($img,255,0,0);
$warna[2] =ImageColorAllocate
($img,0,0,255);
$warna[3] =ImageColorAllocate
($img,255,0,255);
$warna[4] =ImageColorAllocate
($img,255,255,0);
$warna[5] =ImageColorAllocate
($img,128,128,128);
$warna[6] =ImageColorAllocate
($img,255,128,0);
$warna[7] =ImageColorAllocate
($img,0,150,255);
$warna[8] =ImageColorAllocate
($img,112,0,255);
$warna[9] =ImageColorAllocate
($img,128,255,0);
$warna[10]=ImageColorAllocate
($img,40,255,153);
$warna[11] =ImageColorAllocate
($img,0,153,255);
$hitam = ImageColorAllocate
($img,0,0,0);

Beberapa waktu yang
lalu PCplus pernah

memberikan tutorial
tentang pembuatan

pie chart dengan PHP.
Tentu Anda masih

ingat, bukan? Nah,
sehubungan dengan

hal tersebut ada
seorang pembaca yang

menanyakan
bagaimana kalau

paparan data yang
hendak ditampilkan

bukan berupa pie chart
tapi berupa grafik.

PCplus telah
memberikan janji
kepada pembaca

tersebut bahwa
pembahasan tentang
pembuatan grafik ini

akan dimuat di PCplus.
Nah, inilah dia.

ebagai contoh
pembuatan grafik ini
kita akan ambil sebuah
studi kasus tentang

grafik laba sebuah perusahaan
sepanjang tahun 2002.
Perusahaan tersebut, katakanlah
bernama PT XYZ, memiliki data
akuntansi perhitungan laba
sebagai berikut:

  Bulan    Laba
(dalam jutaan rupiah)

Januari 110
Februari 120
Maret 160
April 140
Mei 170
Juni 200
Juli 210
Agustus 200
September 250
Oktober 225
November 235
Desember 275

Seperti biasa, data tersebut
akan kita simpan ke dalam
database MySQL. Buatlah
database baru sebagai berikut:

mysql> create database laba;

mysql> use laba;

mysql> create table th2002(
-> bulan varchar(10),
-> laba int);

Untuk mempermudah pengi-
sian data, tidak bosan-bosannya
saya mengingatkan agar kita
buat dulu perintahnya dengan
teks editor. Pada teks editor
ketikkan teks sebagai berikut:

insert into th2002 values
('januari',110);
insert into th2002 values
('februari',120);
insert into th2002 values
('maret',160);
insert into th2002 values
('april',140);
insert into th2002 values
('mei',170);
insert into th2002 values
('juni',200);
insert into th2002 values

$putih = ImageColorAllocate
($img,255,255,255);
ImageFill($img,0,0,$putih);

// --- menggambar sumbu
koordinat --- //
ImageLine
($img,40,10,40,310,$hitam);
ImageLine
($img,40,310,800,310,$hitam);

// --- menggambar skala
sumbu tegak --- //
for ($i=0;$i<=300;$i+=50){

ImageString($img,3,10,(300-
$i)+10,"$i",$hitam);
}

// --- menggambar skala
sumbu mendatar --- //
// --- sekaligus balok grafik --- //
$letak = 70;
while ($row=mysql_fetch_row

($qry)){
$bulan =
substr($row[0],0,3);
ImageString
($img,3,$letak,330,
"$bulan",$hitam);
$tinggi =
(300-$row[1])+10;
ImageFilledRectangle
($img,$letak
,$tinggi,$letak+20,310,
$warna[$x]);
$letak+=50;
$x++;

}
ImageJPEG($img);
?>

Jika aplikasi tersebut kita
jalankan, hasilnya akan terlihat
seperti Gambar 1.

Sekarang kita bahas skrip ini.
Bagian pertama adalah koneksi
ke MySQL dilanjutkan dengan pe-
ngambilan data. Rasanya bagian
ini tidak perlu diterangkan lebih
lanjut karena hanya koneksi
biasa. Bagian berikutnya adalah
alokasi “kanvas” dan warna-
warna yang nanti akan
dipergunakan untuk
menggambar grafik. Bagian ini
merupakan bagian mendasar dari
proses menggambar dengan PHP.

Selanjutnya adalah
menggambar sumbu koordinat.
Kita akan menggambar sumbu
koordinat dengan tinggi sumbu y
adalah 300 pixel dan lebar sumbu
x adalah 800 pixel.

Yang perlu diperhatikan
adalah koordinat 0,0 dari sumbu
koordinat terletak di bagian kiri
bawah, sedangkan pada monitor
Anda koordinat 0,0 adalah kiri
atas. Jadi penggunaan koordinat
ini harus diperhatikan dengan
baik. Hal ini nampak pada saat
menggambar skala untuk sumbu
tegak. Skala dari sumbu tegak
akan tertulis setiap rentang 50
angka dimulai dari 0 hingga 300.
Untuk menggambar skala
tersebut kita biasanya
memulainya dari bagian
perpotongan sumbu lalu naik ke
atas, artinya dari skala yang
terkecil ke skala yang terbesar.
Jika hendak diterapkan pada
fungsi ImageString, parameter
untuk sumbu y justru harus
dimulai dari angka yang terbesar
ke angka yang terkecil. Penye-
babnya seperti telah disebutkan
tadi, yaitu karena letak koordinat
0,0 pada monitor Anda dimulai
dari kiri atas, sehingga makin ke
bawah angka koordinatnya
makin besar, padahal kita meng-
gambar dari bawah terlebih da-
hulu. Itu pula sebabnya mengapa
pada saat menggambar skala
sumbu tegak, fungsi Image-
String ditulis sebagai berikut:

ImageString($img,3,10,(300-
$i)+10,"$i",$hitam);

Perhatikan bahwa parameter
untuk sumbu y tertulis (300-
$i)+10. Karena variabel $i makin
lama makin besar, maka nilai
parameter untuk sumbu y ini
makin lama akan makin kecil.
Sedangkan angka 10 adalah
batas atas dari gambar kita.
Maksudnya supaya gambar
tersebut tidak “menempel” tepat
di bagian atas, tapi ada jarak
sebesar 10 pixel.

Hal yang sama akan berlaku
saat kita menggambar balok

grafik. Jadi saat menuliskan
angka koordinat untuk bagian
atas balok, fungsi
ImageFilledRectangle yang
digunakan adalah sebagai
berikut:

$tinggi = (300-$row[1])+10;
ImageFilledRectangle(
$img,$letak,$tinggi,
$letak+20,310,$warna[$x]);

Jika Anda ingin
menggambar grafik yang akan
menggambarkan kumulatif dari
laba setiap bulannya (misalnya
sekarang bulan Maret, maka laba
kumulatif adalah laba dari bulan
Maret ditambah laba bulan
Februari ditambah laba bulan
Januari), maka Anda dapat
menambahkan sebuah variabel
yang dapat digunakan untuk
menyimpan nilai kumulatif tadi.
Variabel tersebut akan
ditambahkan di bagian
menggambar skala sumbu
mendatar sekaligus balok grafik,
sehingga bagian tersebut akan
menjadi sebagai berikut:

$letak = 70;
$kum = 0;
while ($row=mysql_fetch_row

($qry)){
$bulan =
substr($row[0],0,3);
ImageString($img,3,
$letak,330,"$bulan"
,$hitam);
$kum += $row[1];
$tinggi = (300-
$kum)+10;
ImageFilledRectangle
($img,$letak,
$tinggi,$letak+20,310,
$warna[$x]);
$letak+=50;
$x++;

}

Tentunya Anda harus menye-
suaikan tinggi kanvas serta tinggi
sumbu tegak dari grafik tersebut
supaya mampu menampung
gambar grafik kumulatif.

Nah, selamat belajar
membuat grafik. PC+
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Belum lama ini AMD
“akhirnya”

meluncurkan prosesor
terbaru yang sudah

mulai bergeser ke
teknologi 64-bit.

Peluncuran ini diawali
dengan peluncuran

produk-produk
motherboard yang
akan mendukung

prosesor tersebut oleh
vendor-vendor partner

setia AMD.

amun, untuk
memiliki sistem
berbasis prosesor
terbaru ini, pengguna

komputer di Indonesia terutama
para fanatik AMD tampaknya
akan mengalami kesulitan. Tidak
seperti prosesor Intel yang

mudah ditemukan di gerai-gerai
pusat perbelanjaan komputer,
prosesor AMD agak sulit
mencarinya, untuk tidak
mengatakannya bikin pusing.
Jangan kata untuk prosesor yang
dirilis kemarin sore, prosesor
yang telah diumumkan
peluncurannya beberapa bulan
yang lalu-pun cukup sulit
menemukannya.

Hal ini diamini pula oleh
para pemilik toko komputer.
Untuk mendapatkan prosesor
AMD terbaru, mereka harus
inden hingga 1-2 bulan. Redaksi
PCplus pun menemukan hal yang
serupa tidak hanya di tanah air.
Saat kunjungan ke Computex
Taipei 2003 yang lalu, prosesor
AMD kecepatan tertinggi yang
beredar di pasaran Taiwan adalah
Athlon XP 2600+. Di atas itu,
tidak ada yang menjual sama
sekali.

Melihat kenyataan yang
terjadi di lapangan, untuk
sementara ini kami lebih
berkonsentrasi untuk pengujian-
pengujian sistem yang dapat
ditemukan di pasaran. Untuk itu,
pada edisi kali ini kami akan

mengangkat pengujian kinerja
chipset untuk AMD keluaran
produsen-produsen yang sedang
seru-serunya bersaing, yaitu VIA
dan nVidia. Produk yang akan
kita ukur kinerjanya adalah
KT400A dan KT600 dari VIA, serta
nForce2 dan nForce2 Ultra 400
dari nVidia. Memang saat ini ada
pula chipset yang dirilis oleh SiS

untuk sistem AMD, seperti
SiS746FX atau SiS748 yang lebih
baru, namun tidak banyak
vendor motherboard yang
memanfaatkan chipset ini.

VIA KT400A DAN VIA
KT600

Chipset KT400A merupakan
penerus VIA KT400. Peningkatan
yang signifikan adalah
dukungan yang lebih luas untuk
modul-modul memori DDR400.
Seperti kita ketahui, pada
motherboard dengan chipset VIA
KT400, tidak banyak modul
memori DDR400 yang dapat
digunakan.

Melalui teknologi yang
disebut FastStream64, KT400A
ini dapat menyediakan akses
lebih cepat ke memori sistem
dengan bandwidth yang dapat
mencapai 3,2GB per detik atau
sekitar 20 persen lebih cepat dari
KT400.

Untuk southbridge-nya,
northbridge KT400A ini dapat
berpasangan dengan southbridge
VT8235 dan 8237. Produk
motherboard KT400A versi awal
ataupun versi ekonomis masih

menggunakan southbridge
VT8235, sedangkan produk
KT400A terbaru ataupun yang
ditujukan untuk kelas menengah
ke atas lebih memilih untuk
menyertakan southbridge VIA
KT8237. Kelebihan southbridge
ini adalah terletak pada
ketersediaannya fitur Serial ATA
dan RAID.

Mengenai VIA KT600,
perbedaannya dengan KT400A
terletak pada kemampuannya
untuk mendukung prosesor AMD
Athlon XP dengan core Barton
yang sudah menggunakan
FSB400. Selain tingkat
kestabilannya yang sudah lebih
baik dari KT400A jika dipasangi
modul memori DDR400, memori
controller dan teknologi
FastStream64 yang juga sudah
dimiliki chipset pendahulunya
sudah dioptimalkan sehingga
mampu bersaing dengan 128-bit
Dual Channel interface milik
nForce 2.

Untuk southbridge-nya,
northbridge KT600 ini dipasang
dengan VIA VT8237. Artinya, fitur
Dual Channel Serial ATA yang
mendukung dua perangkat Serial
ATA, dukungan terhadap empat
buah perangkat Parallel ATA
serta fasilitas RAID 0, RAID 1, dan
RAID 0+1 yang mendukung
standar Serial ATA dan ATA 133
sudah pasti disediakan. Kecuali
kalau vendor motherboard lebih
memilih untuk men-disable fitur
ini atau menggunakan chip VIA
VT8235 yang lebih lawas.

NFORCE2 DAN NFORCE2
ULTRA 400

Seperti kita ketahui, ada lebih
dari satu jenis produk nForce2
yang tersedia di pasaran. Yang
menggunakan chip northbridge
IGP atau SPP dan ada pula yang
menggunakan southbridge MCP
atau MCP-T.

Yang menggunakan
northbridge IGP adalah
motherboard nForce2 yang
memiliki fitur grafis terintegrasi
sekelas GeForce-4 MX, sedangkan
yang menggunakan northbridge
SPP adalah versi yang hanya
menyediakan fasilitas slot AGP 8X.
Southbridge untuk chipset
nForce2 yang terdiri dari dua
macam yaitu MCP dan MCP-T
sendiri merupakan kependekan
dari Media and Communications
Processor, sedangkan T pada MCP-
T, merupakan kependekan dari
Turbo yang maksudnya adalah
memiliki fitur yang lebih lengkap.

Pada chip southbridge MCP-T
disediakan dukungan untuk dual
network controller, fasilitas
hardware sound processing, dan
IEEE1394 FireWire controller yang
terintegrasi, sedangkan pada chip
southbride MCP fitur ini tidak
tersedia.

Selain ketiga fasilitas
tersebut, fitur lain yang tersedia
pada chip southbridge adalah
sama, seperti dukungan Ultra ATA/
133 dan mendukung hingga 6
port USB 2.0. Seperti pada chipset
VIA, pada nForce2 Ultra 400 hanya
diberikan sedikit perbaikan di
sana sini seperti terhadap dukung-
an prosesor, memori dan tentunya
kinerja yang sedikit lebih baik.

PENGUJIAN
Kami menggunakan prosesor

AMD Athlon XP 3000+ pada
pengujian kali ini. Meskipun
sudah menggunakan core Barton,

Uji Empat Chipset AMD Terkini:
VIA KT400A vs VIA KT600

vs nForce2 vs nForce2
Ultra 400

N

Muhammad Firman
firman@e-pcplus.com

namun prosesor AMD yang kami
pakai ini masih menggunakan FSB
333MHz. Untuk clock speed-nya
sendiri, prosesor ini bekerja pada
2167MHz. Untuk motherboard-
nya, kami menggunakan produk
AOpen AK77-400 (VIA  KT400A),
Abit KV7 (VIA KT600), Asus A7N8X
(nForce2), dan Albatron KX18D
Pro II (nForce2 Ultra 400).

Untuk memorinya, kami
menggunakan dua keping Corsair
XMS DDR400 yang masing-masing
memiliki kapasitas 256MB. Agar
lebih imbang, kami tetap
menggunakan dua keping
memori tersebut pada sistem
motherboard yang menggunakan
chipset VIA meskipun tidak
tersedia fitur dual channel
memory.

Kinerja grafis kami ukur
dengan menggunakan kartu VGA
ber-chipset ATi Radeon 9600Pro
128MB buatan Gigabyte,
sedangkan sistem operasi Win-
dows XP Professional kami
instalasikan di harddisk Seagate
Barracuda ATA 7200.7 kapasitas
40GB. Demikian pula dengan
software uji yang kami pakai yaitu
Sysmark 2002, Sisoft Sandra
Professional 2003, Quake 3 Arena,
dan 3DMark 2001.

Untuk driver, kami
menggunakan VIA Hyperion 4.46
untuk KT400A dan KT600, driver
nForce versi 2.42 untuk nForce2
dan nForce2 Ultra 400, serta ATi
Catalyst 3.4 untuk kartu grafis.

Sebelum kita menengok ke
hasil pengujian, yang perlu dicatat
adalah angka-angka hasil uji yang
terpampang pada pengujian kali
ini adalah hasil uji pada kinerja
default. Meskipun pada masing-
masing motherboard yang kami
gunakan bus-nya sudah dinaikkan,
namun setting lainnya seperti FSB
prosesor, memori dan lain lainnya
kami set pada posisi normal.

ARE/PCplus

Mencari motherboard AMD tidak sesulit mencari prosesornya.
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Dari hasil pengujian, kita
dapat melihat bahwa terjadi
peningkatan kinerja antara
KT400A dengan KT600 dan
nForce2 dengan nForce2 Ultra 400
meskipun tidak terlalu signifikan.
Saat ini, kinerja motherboard
dengan chipset VIA KT600 sudah
mampu bersaing dengan Nforce2
(meskipun masih sedikit tertinggal
dengan nForce2 Ultra).

Dari segi kelengkapan fitur,
perbedaannyapun tidak lagi ter-
lalu banyak. Dengan sudah
terintegrasinya Serial ATA serta
RAID pada KT600, keunggulan
utama nForce2 hanya tinggal
pada ketersediaannya onboard
sound yang lebih baik lewat
teknologi Sound Storm.

Kesimpulan kami, chipset
VIA KT600 ini merupakan
solusi yang lebih baik,
khususnya untuk pengguna
yang ingin memiliki sistem
berbasis AMD dengan selisih
price performance terbaik.
Produk motherboard KT600 yang
sudah dapat dimiliki dengan
hanya merogoh kocek sekitar
80-90 dolar AS, umumnya terpaut
cukup jauh dengan motherboard
chipset nForce2 apalagi nForce2
Ultra. Produk-produk ini
umumnya paling murah dijual
pada kisaran harga di atas 100
dolar-an. Tetapi, kalau Anda
memang ingin memiliki sistem
berbasis AMD K7 yang maksimal,
silahkan menggunakan
motherboard dengan chipset
nVidia nForce2 Ultra 400.  PC+
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LAN Party Pro875:

Mobo Papan Atas yang
Kaya Fitur dari DFI

www.dfi.com.tw
195 dolar AS

GN-BTD01:

Bluetooth Dongle
dari Gigabyte

Nusantara Eradata
www.gigabyte.com.tw

☎ (021) 6018218
37 dolar AS

SysMark 2002
Rating :323
Internet Content :436
Office Productivity:239

3D Mark 2001
640 x 480  16bit :17462
640 x 480  32bit :16933
800 x 600  16bit :15909
800 x 600  32bit :15531
1024 x 768  16bit :13790
1024 x 768  32bit :13251

Quake III Arena
640 x 480  16bit :397,2fps
640 x 480  32bit :396fps
800 x 600  16bit :376,9fps
800 x 600  32bit :369,2fps
1024 x 768  16bit :320,9fps
1024 x 768  32bit :294,7fps

Dewasa ini banyak
sekali peranti dan komponen
(terutama yang bersifat mobile)
yang mengandalkan bluetooth
sebagai antarmuka koneksinya.
Bluetooth merupakan standar
komunikasi melalui frekuensi
radio 2,4GHz yang dibangun
oleh berbagai pengembang
alat-alat elektronika.

Dengan “si gigi biru” ini,
komunikasi antarperanti dapat
dilakukan tanpa kabel sehingga
membuat penempatan alat-alat
tersebut menjadi lebih fleksibel.
Apalagi, berbeda misalnya
dengan koneksi inframerah,
peranti yang dikomunikasikan
tidak harus ditempatkan saling
berhadapan dan dalam jarak
terbatas.

Penggunaan bluetooth
yang fleksibel tersebut sudah
sangat marak sebagai jalur
untuk komunikasi data dan
suara pada peranti-peranti
mobile, seperti headset, ponsel,
dan PDA. Beberapa notebook
kelas high end juga telah
menyediakan standar

komunikasi ini. Sayangnya, masih
sedikit PC yang menyediakan
aternatif koneksi ini secara built-
up dalam unitnya.

Bagi Anda yang mempunyai
peranti ber-bluetooth dan butuh
menghubungkannya ke PC,
sekarang sudah tersedia berbagai
pilihan alat untuk membuat PC
atau notebook Anda juga ber-
bluetooth. Salah satu alat yang
paling populer karena
penggunaannya yang praktis dan
ukuran yang biasanya mini
adalah bluetooth adapter atau
bluetooth dongle.

Gigabyte merupakan
perusahaan yang ikut
meramaikan pasar bluetooth ini
dengan produk bluetooth dongle
GN-BTD01. Alat yang mungil ini
harus dicolokkan ke port USB
(Universal Serial Bus) untuk
membuat PC atau notebook
Anda menjadi berfasilitas
bluetooth.

Bentuknya yang mungil,
hanya berukuran 24x76x8mm
dan berbobot 62gram,
memudahkan dicolokkan

langsung ke colokan USB yang
umumnya terletak di bagian
belakang PC. Kalau dirasa terlalu
repot harus mencari lobang
sempit di punggung PC, tersedia
kabel untuk menjadi
perpanjangan USB sepanjang
satu meter. Port USB serasa
berpindah ke atas meja!

GN-BTD01 mendukung
Bluetooth versi 1.1 yang sudah
mengatasi berbagai masalah
ketidakkompatibelan pada versi
sebelumnya. Jarak jangkau
maksimal antara dongle dengan
peranti ber-bluetooth yang bisa
ditangani oleh peranti ini adalah
10 meter. Kecepatan transfer
datanya 723kbps.

Anda perlu melakukan
sedikit proses instalasi yang
tergolong mudah sebelum bisa
menggunakan peranti ini.
Langkah paling penting dalam
instalasi ini adalah penentuan
nama dan spesifikasi komputer.
Jika tergabung ke jaringan LAN,
biasanya nama komputer sudah
ditentukan. Nama ini perlu
ditentukan agar peranti nirkabel

mudah
melakukan
identifikasi nantinya.

Instalasi ini juga
penting untuk menciptakan
berbagi folder yang
dibutuhkan untuk kegiatan
komunikasi antara PC
dengan peranti nirkabel.
Redaksi menemukan bahwa
hasil transfer file dari ponsel
3650 melalui Bluetooth
ditempatkan secara default
pada suatu folder pada
folder My Document.

Setelah proses instalasi
selsesai dan kita memasuki tahap
sinkronisasi peranti, maka akan
kita temukan bahwa antarmuka
file yang digunakannya “sangat
Windows”. Ini memudahkan
kegiatan eksplorasi file kita.

Keamanan juga cukup
diperhatikan. Peranti yang
mencoba mengakses PC lewat
GN-BTD01 harus mendapatkan
permisi terlebih dahulu. Kalau
agak terganggu dengan popup-
nya, kita bisa memberi permisi

untuk 5 atau 30 menit ke
depan. Ada opsi untuk
memberikan permisi tanpa
batas waktu, namun pilihan ini
dinonaktifkan pada waktu diuji
coba di redaksi. Besar
kemungkinan demi alasan
keamanan itu tadi. (fbi)

ARE/PCplus

DFI yang baru
muncul kembali di
Indonesia, produk-produk
terbarunya langsung
menggebrak pasar. Dengan
kemasan jual yang menarik plus
beberapa fitur tambahan yang
seru, perusahaan yang berbasis
di Taiwan ini menawarkan
motherboard dengan
kemampuan yang baik. Salah
satu seri yang dipasarkan
beberapa waktu lalu adalah
LAN Party Pro875.

Dari namanya, bisa ditebak,
seri ini menggunakan chipset
high end bikinan Intel i875
sebagai pengatur lalu lintas
data utamanya. Sementara,
untuk chipset south bridge yang
merupakan chipset pendukung,
DFI mengusung Intel ICH5R

yang dapat mendukung
pemakaian beberapa fitur
menarik.

Seperti juga produk sejenis
lainnya, produk yang
menggunakan warna dasar hitam
plus oranye untuk warna soket-
soketnya ini mendukung
penggunaan prosesor Intel
Pentium-4 soket 478 dengan FSB
mulai dari 400MHz, 533Mhz,
hingga 800MHz. Selain itu,
teknologi hyper-threading yang
ada pada prosesor Intel terbaru
juga didukung oleh produk yang
juga menyertakan power switch
dan reset switch tambahan ini.

Untuk dukungan terhadap
memorinya, DFI juga
menyediakan 4 buah soket DIMM
184 pin yang mampu
menampung memori DDR hingga

4GB. Selain itu, LAN Party Pro875
ini juga mampu bekerja dalam
sistem dual channel pada memori
DDR PC-3200.

Untuk Fitur-fitur yang
ditawarkan, produk yang sudah
menyertakan fitur Gigabit LAN
controller ini menyertakan
sebuah port AGP 8X, 5 buah PCI,
dua buah port serial ATA. Untuk
harddisk tipe paralel ATA, selain
menyertakan dua buah port IDE,
produk yang juga menyertakan
fitur wake on LAN maupun wake
on keyboard/mouse ini
mengusung pula 2 buah port
untuk RAID.

Sementara, untuk interface
dengan perangkat lain, produk
yang sudah menyertakan port S/
PDIF ini menyertakan pula dua
buah port PS/2, sebuah port
paralel, dua buah port serial, dan
sebuah port audio ini. Sebagai
tambahan, 4 buah port USB yang
bisa diekspansi hingga 8 buah
juga dipasang mati pada body-
nya.

Menariknya, DFI juga
menyertaka fitur Diagnostic LED
yang dapat dijadikan indikator

kerja dari dari keseluruhan sistem.
Empat buah LED yang disertakan
bisa dijadikan pedoman jika salah
satu fitur pada sistem yang
menggunakan Phoenix-Award
BIOS ini mengalami gangguan.

PCplus  seperti biasa menguji
produk ini dengan menggunakan
Intel Pentium-4 3GHz FSB 800MHz,
memori Kingston PC-3200 512MB
2 keping, harddisk Barracuda ATA
7200.7 40GB, CD-ROM drive Asus
50X, kartu grafis MSI GeForce-4 Ti-
4800 128MB, power supply Enlight
420W, dan monitor Samsung
SyncMaster 900NF, Windows XP
SP1, driver Detonator XP 44.03,
INF 5.00.1012, dan software
benchmarking standar.

Dari segi performa,
berdasarkan uji yang dilakukan
dibanding produk-produk sejenis
yang pernah diuji DFI LAN Party
Pro875 ini rata-rata punya nilai
yang tidak jauh berbeda dengan
yang lain. Namun, untuk game
yang berbasis OpenGL, produk ini
tergolong paling tinggi dari
semua.

Pada kemasan jualnya, DFI
menyertakan beberapa buah CD

driver, sebuah buku manual,
sebuah buku tentang fitur yang
ada, dan sebuah brosur
petunjuk instalasi. Yang
menarik, FDI menyertakan pula
sebuah ransel yang dapat
digunakan untuk mengangkut
CPU. (sil)

ARE/PCplus
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Colin Mcrae Rally 3:
Balapan Plus Strategi

Arman Kania
aruman_8@yahoo.com

Tidak begitu banyak
game berjenis racing

(adu balap) di PC.
Kebanyakan game

yang keluar lebih
banyak berjenis RPG

atau FPS. Namun
demikian, belum lama
ini telah dirilis sebuah

game racing yang
mungkin dapat

membawa Anda
melupakan jenis game

lain sejenak. Colin
Mcrae Rally 3 (CMR3),

itulah nama game
racing yang baru-baru

ini dikeluarkan oleh
Codemasters. Game

ini mencoba
menembus pasar

game bertipe balapan
lain, misalnya: Touring

Car, dan kejuaraan
World Rally Champi-

onship (WRC).

JENIS DAN KARAKTER
TREK BALAPAN

Dalam WRC, trek yang
dipakai merupakan trek-trek
yang terdapat di alam, bukan
trek buatan seperti halnya
balapan Formula 1. Setiap trek
disebut sebagai Special Stage
(SS). Pada umumnya, masing-
masing SS ini saling menyam-
bung sehingga membentuk trek
satu arah yang cukup panjang.
Selain itu, terdapat Super
Special Stage (SSS).

Trek dalam WRC hanya satu
arah, maka tiap peserta berlomba
secara bergiliran. Selanjutnya,
akan dibandingkan siapa yang
tercepat. Namun demikian,
dalam SSS perlombaan dilakukan
secara simultan, karena dalam
SSS trek yang digunakan adalah
trek sirkular, mirip dengan trek
mobil Tamiya.

Mobil yang digunakan dalam
WRC adalah mobil-mobil biasa
seperti Mitsubishi Evolution Vii
atau Ford Focus yang
dimodifikasi agar mempunyai
ketahanan dalam membabat
trek-trek alam.

Ketika memulai permainan,
sebaiknya Anda langsung
memilih pilihan Stages untuk
sedikit “mencicipi” game ini dan
juga untuk melihat kemampuan
PC anda. Setelah itu, Anda bisa
meningkatkan atau menurunkan
setting untuk game ini di bagian
Option-nya. Bila memiliki
graphic card kelas atas, Anda
bisa mengaktifkan mode FSAA

(Full Screen Anti-Aliasing)
untuk meningkatkan kualitas
gambar.

Setelah siap, Anda bisa
mencoba mode utama game ini,
yaitu mode Championship. Dalam
mode ini, Anda akan berperan
sebagai Colin Mcrae dan
mengendarai Ford Focus. Setelah
itu Anda akan menjumpai nama-
nama negara pada musim balap
tersebut. Terdapat 8 negara
dengan kurang lebih 56 trek di
dalamnya. Setelah itu, Anda akan
menjumpai layar pra-lomba. Di
sini kita bisa melihat info trek
yang akan dibabat, men-set
mobil atau pilihan untuk
langsung balapan. Tapi akan
lebih baik bila Anda meramu
dahulu taktik yang akan
digunakan. Karena setting yang
akan Anda gunakan akan dipakai
selama 3 SS.

SETING (PENGATURAN)
MESIN DAN SIASAT
MELAJU

Setting yang bisa diubah
cukup banyak, mulai dari mesin,
transmisi, suspensi, ban, dan

lainnya. Sebagai contoh, pada
mesin kita akan menemui sistem
launch control untuk
menghindari terjadi “spinning”
yang hanya memberikan efek
kelajuan yang kecil.

Untuk transmisi, semakin
tinggi setting, maka akselerasi
mobil semakin kurang. Tapi, top
speed yang dicapai semakin
tinggi.  Anda bisa mencoba
setting dalam mode Shake-
down. Data-data hasil setting
Anda akan kelihatan di pilihan
telemetry.

Dalam game ini, tingkat
kesulitan tiap-tiap trek berbeda,
Mulai dari trek di Australia yang
lebar dan berpasir, sampai trek
yang cukup sulit seperti di
Jepang, di mana kita akan
balapan di jalan-jalan dalam
kompleks di pegunungan. Pada

TIPS dan TRIK

• Jangan selalu menekan
gas. Kombinasikan gas,
rem, dan rem tangan
sesuai keadaan.

• Jangan terlalu sering
melompat, karena
hanya akan menambah
rusak mobil.

• Karena game ini tidak
memakai CD ketika
dimainkan, Anda bisa
menyalakan CD Audio
sambil bermain.

Persyaratan Minimum

• Windows 98SE/ME/2000/
XP

• DirectX 9
• Pentium III atau Athlon

750MHz
• 128MB RAM
• Graphics Card 32MB
• Sound Card DirectX 9

Compatible
• 3,5GB ruang Harddisk

ESRB Rating

Semua Umur

trek berpasir, daya cengkeram,
ban tidak begitu baik. Berbeda
dengan trek jalanan.

KUALITAS VISUAL DAN
AUDIO

Tingkat kerealistisan game
ini bisa dibilang hampir

sempurna. Model-
model mobilnya
cukup realistis
dan mendekati
aslinya. Tidak
heran karena
game ini memiliki
lisensi resmi.
Pengendalian
tiap-tiap mobil
pun berbeda.

Ketika kita
balapan,
pergerakan mobil
Anda akan
terlihat cukup
nyata. Mobil akan
lebih condong ke
kiri ketika kita
berusaha untuk
belok ke kanan,
begitu juga
sebaliknya.
Komponen-
komponen
mobilnya pun

hampir realistis. Knalpot mobil
akan mengeluarkan api ketika
terjadi pergantian gigi. Bunyi-
bunyi gesekan dan bunga api
yang dihasilkan ketika body
mobil menyentuh objek-objek di
sekitarnya. Ada tiga antena di
atas Ford Focus yang bergerak-
gerak. Bahkan piringan rem akan
merah menyala bila Anda
mengerem secara mendadak.

Tapi hal yang paling keren
adalah kerealistisan kerusakan
mobil. Hampir tiap bagian mobil
bisa rusak. Body mobil bisa
penyok, bemper bisa copot, kaca-
kaca bisa pecah bila terbentur.
Bahkan, lampu-lampu mobil pun
bisa hancur. Kita harus
menyelesaikan 3 SS dahulu baru
bisa memperbaiki mobil.

Game CMR3 ini bukan hanya
bagus dalam hal grafiknya saja,

tetapi suaranya pun cukup
mantap. Tiap-tiap mobil mem-
punyai karakteristik suara mesin
yang berbeda-beda. Suara-suara
lainnya pun juga baik. Tapi,
game ini lebih unggul dalam hal
grafiknya. Efek debu-debu
jalanan yang berterbangan,
kotoran-kotoran yang menem-
pel di badan mobil, hingga efek
hujan yang cukup nyata. Ini bisa
dilihat ketika mobil kita berhen-
ti. Titik-titik hujan cenderung
pecah ketika menyentuh body
mobil. Berbeda dengan game
balapan kebanyakan, di mana
efek hujannya hanya “numpang
lewat”.

Kesimpulannya, game ini
merupakan salah satu game
balapan terbaik saat ini. In the
mean time, Happy Racing...and
drive safely….vroom…
vrroom…. PC+
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Dari”Desktop
Publishing”

ke”Desktop Video
Editing”

T.J Setyoadi
dino@e-pcplus.com

K

Pada akhir tahun 80-
an, komputer untuk

me-layout majalah
atau mendesain

brosur mulai
diperkenalkan. Untuk
menghasilkan cetakan

yang berkualitas
tinggi dan layak

untuk dijadikan koran
atau majalah, masih

diperlukan suatu
komputer khusus dan

printer yang khusus
pula, seperti MCS

(Modular Composer
System). Dengan CPU

dan printer yang
sebesar lemari
pakaian, yang

dihasilkan MCS adalah
teks yang berbentuk
kolom-kolom sesuai

dengan kolom koran
yang akan dibuat.

emudian
muncul laser
printer. Dengan
harga yang jauh lebih

murah dibandingkan dengan
MCS namun dengan kualitas
cetakan yang hampir sama,
mulailah peran komputer
desktop (PC) dalam dunia
percetakan. Saat itu kita bisa
me-layout langsung koran atau
majalah dengan menggunakan
PC seusai dengan keinginan
kita, kemudian dicetak di laser
printer. Kemampuan PC pun
terus bertambah, kini tidak
hanya teks, tapi juga gambar.
Memanipulasi gambar dengan
PC kini bukanlah hal yang sulit.

Kini dunia video editing
pun sudah melangkah jauh
menuju era digital. Jika
beberapa tahun lalu untuk

menghasilkan film yang
berkualtas harus menggunakan
peralatan khusus, atau paling
tidak komputer yang harus
disambung dengan peralatan
khusus, kini Anda bisa
mengucapkan selamat tinggal
kepada peralatan tersebut.

Perkembangan video
editing digital sendiri tergolong
lambat. Kamera digital sudah
tersedia lebih dari 5 tahun yang
lampau. Untuk meng-capture
video dari kamera hanya
dibutuhkan colokan firewire
(IEEE 1394), yang bentuk port-

nya tidak lebih besar dari port
USB. Hanya saja software
pendukungnya baru berkembang
sejak tahun lalu.

Ambil contoh Ulead Video
Studio (UVS) yang kini sudah
sampai ke versi 7.0. UVS dengan
mudah mengenali capture card
yang tersedia di komputer Anda,
mulai dari capture card analog
(untuk kamera Hi-8 atau VHS)
sampai de-
ngan port
firewire. Be-
gitu kamera
Anda tancap-
kan ke port
firewire, saat
itu pula UVS
siap untuk
mengcapture
video secara
real time, arti-
nya untuk film
1 jam Anda
membutuhkan
waktu 1 jam
untuk
mentransfer
film tersebut
ke dalam harddisk Anda.

Dalam proses capture, baik
itu melalui jalur analog ataupun
digital, Anda bisa memilih format
penyimpanan. Anda bisa memilih
format AVI, DV, MPEG, VCD,
SVCD, atau DVD. Apapun pilihan
formatnya, proses capture-nya
tetap real time, tidak peduli
komputer Anda AMD Duron 800

MHz atau
Pentium IV
2,4 GHz.

Proses
editing meng-
gunakan UVS
pun tidak
sulit, semua
menu telah
disederhana-
kan dan
ditempatkan
sedemikian
rupa sehingga
mudah untuk
digunakan.
Bahkan untuk
sebagian
besar fasilitas
UVS cukup

digunakan dengan cara drag and
drop. Ambil contoh efek yang
ada di samping kanan, lalu geser
saja ke clip video yang sedang
kita edit. Lalu hasil efek tersebut
dapat kita lihat saat itu juga,
tidak perlu menunggu hasil
render terlebih dahulu.

Untuk title atau judul video
yang bisa bergerak dan berputar
dalam bentuk 3 dimensi, bisa di-
lakukan dengan mudah menggu-
nakan Ulead Cool 3D. Dengan
menggunakan software ini,
hanya dalam waktu hitungan
menit kita bisa menghasilkan

tulisan/objek 3 dimensi yang
bergerak ke sana ke mari sesuai
dengan keinginan kita. Setelah
jadi, tinggal gabungkan saja
dengan video clip yang sudah
ada di UVS.

Untuk me-render hasil
video yang kita edit, UVS punya
rekor yang cukup mengagum-
kan. Tanpa tambahan alat apa-
pun, dengan menggunakan

AMD Duron 800 MHz, memori
512 MB, VGA Card 32 MB, hard-
disk 40 MB, UVS mampu me-
render video clip yang sudah
diedit (dipotong, ditambahi,
musik ditimpa dengan lagu lain,
dan sebagainya) sepanjang 1
jam hanya dalam waktu 20 me-
nit! Itu artinya investasi untuk
proses video editing tidak ma-
hal, cukup dengan komputer se-
kelas Pentium III, firewire card,
dan CD-RW, kita sudah bisa punya
studio video editing sendiri.

Namun perlu dicatat bahwa
kecepatan proses render sangat
bergantung dengan sumber vi-
deo clip yang kita punya. Proses
render terlama yang dilakukan
oleh UVS adalah 1 : 4, artinya
untuk film 1 jam perlu waktu 4
jam untuk proses rendernya.
Memang ada kiat-kiat tertentu
untuk mencapai hasil yang
maksimal.

Untuk mengenal lebih da-
lam proses video editing seder-
hana namun dengan hasil pro-
fesional serta UVS, Anda bisa
mengikuti workshop wirausaha
video editing yang diselengga-
rakan pada tanggal 24-25 Okto-
ber mendatang di Hi-Tech Mall
Surabaya. Cukup isi formulir
pendaftaran yang ada pada
tabloid ini, lalu daftarkan diri
Anda ke Mualim/Irwan Jl. Raya
Gubeng 98 Surabaya, telp. 031-
5049492, atau Ririn, PT Sasana
Boga, parkir mobil Lt. I THR Mall
Surabaya, Jl. Kusumabangsa
116-118, telp. 031-5316557.
Untuk peserta luar Surabaya
harap menghubungi Adi
Baskoro 081 846 7353 atau
Lukman 081 5525 7104. PC+

Mengerjakan video editing amatir, semiprofesional,
maupun profesional bisa dilakukan dengan PC.
Kalau ditekuni, bisnis ini sangat menjanjikan dan
berpotensi membuka lahan kerja baru.

Proses penggarapannya mudah, hasilnya bisa
langsung dinikmati

D
IN

O
/P

C
pl

us



| 29

plusHarga IV • 08 - 14 Oktober 2003
PCplus 147

Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga Dalam Dolar AS

MOTHERBOARD

VIA P4PB-Ultra+RAID  P4X400,
ATX, FSB533, DDR333/400, RAID 103
VIA P4PB400-L  P4X400, ATX,
FSB533, DDR333/400 68
VIA P4PB266EN, P4X266, ATX,
FSB 533, 3 DDR 68
VIA P4MA-Pro, Via P4M266,
M-ATX, FSB 400, VGA, LAN 59

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 105
Asus P4PE/L 1394, i845PE, AGP4X,
DDR, 6PCI, USB2.0, Hyper-threading 133
Asus P4PE/L , i845PE, AGP4X, DDR,
6PCI, USB2.0, Hyper-threading 100
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 236
Asus P4P800 Deluxe, i865,
FSB 800, ATA100, 4DDR 174
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800,
4DDR, RAID, LAN, audio 158
Asus P4C800, i875, FSB800,
4DDR, RAID, Audio, Gigabit LAN 210
Asus P4B533, i845E, FSB533,
ATA100, 3DDR, audio 84
Asus P4S533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 74
Asus P4S8X/L 1394, SiS648,
FSB533, 3DDR, AGP8x, audio,
Serial ATA, 1394 131
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 89
Asus P4S533-X, SiS645dx, FSB533,
2DDR, audio, VGA onboard 70
Asus A7V8X/L 1394, KT400, ATA133,
AGP8x, FSB266, 3DDR, audio,
LAN, 1394 126
Asus A7V600, VIA KT600, 6 PCI,
3DDR, AGP8x 112
Asus A7N8X-X, NForce2, ATA133,
5 PCI, 3DDR, audio dolby, AGP8x 107
Asus A7V8X/L, VIA KT400, 6 PCI,
3DDR, SATA, ATA133 116

APLUS AP973, i845G, FSB 533MHz,
2DDR, Intel Graphic, ATX, AC97 76
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 76
APLUS AP978 Ii845GL, ATX, 400FSB,
SOUND AC97, 2 SDRAM 54
APLUS AP971A+ VIA P4M266, ATX,
400FSB, SOUND AC97, 2 SDRAM,
S3 Savage4 4XAGP 50
APLUS AP976E2, VIA P4X266E,
FSB 533MHz, 2DDR,M- ATX, AC’97 50
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A2 VIA P4M266A,
ATX, 533FSB, SOUND AC97, 2DDR 52
APLUS AP971A VIA  P4M266A,
M.ATX, 533FSB, SOUND AC97,
2SDRAM 50
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 875P Neo i875P, ATX, FSB800,
2DIMM, ATA100, AGP8X, 6PCI 110
MSI 645E MAX-U, SiS645DX, ATX,
FSB533, 3DIMM, ATA133, AGP4X, 6PCI 74

MSI 651M COMBO-L, SiS 651, m-ATX,
FSB533, 2DIMM, ATA133, AGP4X 73
MSI 648 MAX, SiS 648x, ATX, FSB533,
3DIMM, ATA133, AGP8X, 6PCI 80
MSI 655 MAX FISR, SiS655, ATX,
FSB533, 4DIMM, ATA133, SATA,
AGP8X 160
MSI 655 MAX LS, SiS655, ATX,
FSB533, 4DIMM, ATA133, SATA,
AGP8X 110
MSI 645GLM, I845gl, Matx, FSB400,
2DIMM, ATA100, AGP4X, 3PCI 73
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 90
MSI 865PE Neo2, I865pe, ATX, FSB800,
2GBDDR, ATA133, AGP8X, 5PCI 130
MSI K7N2 Delta-L, nForce2, ATX,
FSB400, 3GB DDR, ATA133,
AGP8X, 5PCI 110
MSI K8T Neo-FIS2R, VIA K800T800,
ATX, FSB800, 3DDR, ATA133,
AGP8X, 5 PCI 185
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 77

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 77
Gigabyte GA-7VA, VIA KT400,
ATX, Soket A, ATA133 89
Gigabyte GA-7N400-L1, nForce2 ultra,
ATX, Soket A, ATA133, Raid, Firewire 112
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-8SG800,  SiS 648,
ATX, FSB800, ATA133, AGP8X, 5PCI 82
Gigabyte GA-8ST800, SiS 645DX,
ATX, FSB800, ATA133 73
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 187
Gigabyte GA-8IE800, i845E,ATX,
FSB533, ATA100 87
Gigabyte GA-8IPE1000, i865PE, ATX,
FSB800, 4DDR, 5PCI 132
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 107
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 242

DFI LAN Party Pro875, i875P, ATX,
FSB800, AGP8X, 2SATA 195
DFI LAN Party KT400A, VIA KT400A,
ATX, FSB400, AGP8X, 1SATA 130
DFI LAN Party NF II Ultra, nForce 2,
ATX, FSB400, AGP8X, 1SATA 155

DFI PS83-BL, i865PE, ATX, FSB800,
AGP8X, 2SATA 90
DFI 648FX-ALE, i648FX, ATX,
FSB800, AGP8X, DDR 400 75
DFI P4X800-AL, VIA P4X400, ATX,
FSB533, AGP8X, ATA133 57
DFI KT400A Infinity, VIA KT400A,
ATX, FSB333, AGP8X, 1SATA 92

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 78
Iwill P4SE, i865PE, soket 478,
FSB 800, DDR, Audio, ATA100,
Serial ATA 110
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing,
SCSI 999

Soyo K7V Dragon Ultra. VIA KT333,
 6ch audio, AGP Pro, LAN10/100 145
Soyo K7V Dragon Lite. VIA KT333,
6ch audio, AGP 4x 85
Soyo P4X400, VIA P4X400, RAID,
6ch audio, AGP PRO, 6 PCI 155
Soyo P4I Fire Dragon, i845D, DDR266,
RAID, 6ch audio, AGP PRO, 6 PCI 120
Soyo P4S Dragon Ultra,
Sis645A2+961, RAID, 6ch audio,
AGP PRO, 6 PCI 140
Soyo P4IS2, i845, SDRAM, AC97,
6PCI, AGP4X 60

Abit IC7  i875P, FSB800MHz, 4 DDR,
AGP 8X, 5 PCI 145
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 103
Abit BE7-G, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 127
Abit BE7-S, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 117
Abit BD7, i845D, FSB 533MHz,
2DDR, AGP 4X, 5 PCI 85
Abit BG7E, i845GE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 100
Abit IC7G i875/ICH5-R, FSB 800MHz,
4 RIMM, AGP 8X, 5 PCI 194
Abit SR7-8X, SiS 648, FSB 533MHz,
3 DDR, AGP 8X, 5 PCI 95
Abit IS7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 135
Abit BD7E, i845DDX, FSB 533MHz,
2 DDR, AGP 8X,  5 PCI 75

Abit KV7, Via KT600/8235,
FSB 400MHz, 4 DDR, AGP 8x, 6 PCI 94
Abit NF7S, nVidia nForce2,
FSB 333MHz, 3 DDR, AGP 8X, 3 PCI 119
Abit KD7-A, Via KT400, FSB 333MHz,
4DDR, AGP 8X, 6 PCI 86
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 97
Abit NF7-M, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 113

MEMORI

Visipro 128MB (4 IC) PC 133 27
Visipro 128MB (8 IC) PC 133 35
Visipro 256MB (8 IC) PC-133 46
Visipro 256MB (16 IC) PC-133 65
Visipro 512MB PC-133 92
Visipro 128MB (8 IC) PC-2100 28
Visipro 256MB (8 IC) PC2100 49
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 94
Visipro 128MB (4 IC) PC-2700 30
Visipro 128MB (8 IC) PC-2700 30
Visipro 256MB (8 IC) PC2700 50
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 96
Visipro 256MB PC3200 (8IC) 56
Visipro 512MB PC3200 102
Visipro 64MB PC800 36
Visipro 128MB PC800 (8IC) 52
Visipro 256MB PC800 (8IC) 105

Nexus SDRAM PC-133 64MB 15.5
Nexus SDRAM PC-133 128MB 20.5
Nexus SDRAM PC-133 256MB 37
Nexus DDR PC-2100 128MB 23
Nexus DDR PC-2100 256MB 42.5
Nexus DDR PC-2700 256MB 44.5
Nexus DDR PC-2700 512MB 90

V-Gen SDRAM PC-133 (8IC) 64MB 16
V-Gen SDRAM PC-133 (4IC) 128MB 24
V-Gen SDRAM PC-133 (8IC) 128MB 31
V-Gen SDRAM PC-133 (8IC) 256MB 43
V-Gen SDRAM PC-133 (16IC) 256MB 61
V-Gen SDRAM PC-133 (16IC) 512MB 86
V-Gen DDR PC-2100  128MB 26
V-Gen DDR PC-2100  256MB 44

V-Gen DDR PC-2700  256MB 47
V-Gen DDR PC-2100  512MB 87
V-Gen DDR PC-2700  512MB 92
V-Gen DDR PC-3200  256MB 49
V-Gen DDR PC-3200  512MB 94
V-Gen RDRAM PC-800 128MB 51
V-Gen RDRAM PC-800 256MB 98

NCPRO 256MB DDR PC-3200 47
NCPRO 256MB DDR PC-2700 44
NCPRO 512MB DDR PC-2700 89
NCPRO 128MB DDR PC-2100 18
NCPRO 256MB DDR PC-2100 33

COMPACT FLASH

NCPRO Flash memory 32MB 16
NCPRO Flash memory 64MB 17.5
NCPRO Flash memory 128MB 29
NCPRO Flash memory 256MB 58.5

Visipro Flash Memory 64MB 26
Visipro Flash Memory 128MB 42
Visipro Flash Memory 256MB 70
Visipro Flash Memory 512MB 125

SMART MEDIA CARD

NCPRO Flash Memory 32MB 12
NCPRO Flash Memory 64MB 19.5
NCPRO Flash Memory 128MB 27.5

Kingston Flash Memory 64MB 25
Kingston Flash Memory 128MB 39

USB FLASH MEMORI/
MP3/PEN DRIVE

Prolink USB Pen Drive, MP3 64MB 85
Prolink USB Pen Drive, MP3 128MB 110
Prolink USB Pen Drive, MP3 256MB 165

NCPRO pen drive 128MB 37
NCPRO pen drive 256MB 59.5
NCPRO pen drive 512MB 115
NCPRO pen drive 128MB USB2.0 44

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3, 128MB, MP3 115
DigiSound II, 128MB, multi MP3,
voice recording, display 140
MagicStar 128 Turbo, USB 2.0, 128MB 65
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KURSUS

DIKLAT KOMPUTER BERSERTIFIKAT Rp.100.000,-
1.Teknik Komputer+MoBo+Hardisk+Copy Bios
2. Network LAN + EDP + Admin + PC Kloning
3. Design Grafis 4. Private 5. Jarak jauh OK
GRATIS: CD-Modul-Sertifikat-Drink-Konsultasi

DIKLAT JARINGAN PC KLONING TANPA HARDISK
Komp lama bisa secepat P.4 - RAM 8 jadi 64
BELAJAR JARAK JAUH BISA - BERGARANSI
EXSYSCOM : 021.78889003 - 0815.997.1234
Jl.Raya Depok - Depan UI - Blk.Halte - Jakarta 12640

IZZAH COM Kursus “PAKET HEMAT” Merakit PC
75rb LAN 75rb WebDesign 150rb Photoshop 85rb
MS.Office 85rb Pwr Point 75rb Praktis, Cpt, Certifi-
cate Jl.Rawamangun Timur/78 Ph.47867273
http://izzahcomp.tripod.com

LAIN-LAIN

Domain E.com/. Net/.org Rp.105.000/ Thn
Web & Mail Hosting Rp.9100/Bln Anti Virus
FREE: Design Web,Forward Web, Biaya setup
Dapatkan: CD,Sticker,T-shirt (Terbatas)
www.Dhewastudio.com  HP.0815.9228166

Koleksi CD Digital Imaging Photo, Clipart,
CD Interactive Edutainment, Majalah
Interactive,dll. Katalog gratis bisa hubungi
ke:galeriku@hotmail.com atau kirim alamat E-mail
anda via SMS ke:0817-224210

IKLAN BARIS

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm ATA133,
2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 64
Maxtor 6Y060L 60GB 7200rpm
ATA133, 8MB Cache, dual processor 73
Maxtor 6Y080L 80GB 7200rpm
ATA133, 8mb cache, dual processor 80
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 109
Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 175
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 250

Seagate Ux/Cuda 5400.1 40GB ATA 100 59
Seagate Barracuda ATA IV /V 80GB
7200RPM ATA100 80
Seagate Barracuda 7200.7 40GB
ATA100 62
Seagate Barracuda 7200.7 80GB
ATA100 80
Seagate Barracuda 7200.7 120GB
ATA V/100 108
Seagate Barracuda 7200.7 Plus
160GB ATA V/100 (8MB cache) 165
Seagate Barracuda SATA 80GB,
ATA100 125
Seagate Barracuda SATA 120GB,
ATA100 143

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 52
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 54
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 58
Maxtor 4R060J/4D060H,
60GB 5400rpm, ATA-133, 2MB cache 67
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 80
Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache Call
Maxtor 4G160H, 160GB, 5400rpm,
9,0ms, ATA100, 2MB cache,
dual processor 165
Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 112
Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 135
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 185
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 260

Western Digital WDC 5400rpm cache
2MB 20GB 53
Western Digital WDC 5400rpm cache
2MB 40GB 57
Western Digital WDC 7200rpm cache
2MB 40GB 67
Western Digital WDC 7200rpm cache
8MB 40GB 79
Western Digital WDC 7200rpm cache
8MB 80GB 112
Western Digital WDC 7200rpm cache
2MB 100GB 135
Western Digital WDC 7200rpm cache
2MB 120GB 160
Western Digital WDC 7200rpm cache
8MB 160GB 210

Samsung HDD 20GB 5400rpm 56
Samsung HDD 40GB 5400rpm 70

EXTERNAL DRIVE

Maxtor 5000DV 160GB, USB 2.0,
8MB Cache, 7200rpm 299
Maxtor 7000 200GB USB 2.0,
8MB Cache, 7200rpm 370

Intel Xeon Pentium-4 3,06
512KB cache L2, 533MHz 756

HEATSINK FAN

Coolermaster HAC-V81 (X-Dream) 21
Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19
Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000 ALCU 35

VGA CARD

Asus V9280 SuperFast 128MB 221
Asus V9180 Magic/T 64MB MX440-8X 84
Asus V9950 Ultra/ DLX,
GeForceFX 5900, AGP 8x,
128MB DDR 620
Asus V9520 Magic/T GeForceFX 5200,
128MB, AGP8X 95
Asus V9520 Home Theater-128MB 195
Asus V9280 SuperFast/TVD,
Ti4200-128MB 221
Asus V9950 Ultra/TVD,
GeForce FX5900, 256MB 583

Asus V9180 SE/T 64MB, MX-440-8X 55

Abit GF3 Ti 200, 64MB DDR 120
Abit GF2 T400, AGP 4X,
64MB SDRAM, TV-out, 64
Abit GF2 MX400, AGP 4X,
64MB SDRAM 59
Abit GF2 T200, AGP4X,
32MB SDRAM, TV-out 56
Abit GF2 MX200, AGP 4X,
32MB SDRAM 49

PixelView GeForce FX 5200 ultra,
128MB DDR 4ns, GPU 250MHz,
RAM Clock 500MHz, TV-out, DVI Port 88
PixelView GeForce FX5600tv,
128MB DDR, 3,6ns, GPU400MHz,
RAM550MHz, TV-out, DVI Port 155
PixelView GeForce FX 5600 Vivo,
128MB DDR, GPU 400MHz,
RAM 550MHz 160
PixelView GeForce 5600 Ultra,
256MB 3,3ns, GPU 325MHz, DVI port 190
PixelView GeForce FX 5900 256MB
DDR II, 2,2ns, GPU 400Mhz 460
PixelView FX5800, AGP8X, DDRII,
VIVO, DVI 355
PixelView FX5600H, AGP8X,
DDR 3,5ns, VIVO, DVI 195
PixelView FX5600, AGP8X,
128MB DDR, 3,6ns, DVI, VIVO 175
PixelView FX5200ut, AGP8X,
128MB DDR, TV OUT, DVI 88

MSI G4 MX440SET, AGP4X,
64MB SDR, TV OUT 53

MSI G4MX440 T8X, AGP4X,
64MB SDR, TV OUT 56
MSI MX440-TD8X, AGP8X,
64MB DDR, DVI, TV OUT, DUAL CRT 73
MSI Ti4200-TD8X64, AGP8X,
64MB DDR, DVI 150
MSI FX5200-T128, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 91
MSI FX5200-TDR128, 128MB DDR,
DVI, VIDEO IN, TV OUT 120
MSI FX5600-VTDR, AGP8X,
128MB DDR, DVI, VIDEO IN, TV OUT 215

Elsa Gloria4 980XGL nVidia Quadro4
900XGL, 128MB DDR, 650MHz DVI-I 802
Elsa Gloria4 750XGL nVidia Quadro4
750XGL, 128MB DDR, 650MHz DVI-I 475
Elsa Synergy4, nVidia Quadro4
550XGL, 128MB DDR, 500MHz, DVI-I 301
Elsa Gladiac 518, nVidia GF4 MX440,
64MB DDRTV 83
Elsa Gladiac 517SEP nVidia GF4
MX440, 64MB DDR, video out, DVD 59
Elsa Gladiac 511, nVidia GF2 mx00,
64MB DDRAM, 47

Sapphire Radeon 9700 Atlantis,
128MB DDR, DVI VO 276
Sapphire Radeon 9500 Atlantis,
128MB DDR,DVI TVO 170
Sapphire Radeon 9000 Pro,
128MB DDR, VIVO (PAL) 106
Sapphire Radeon 7000,SDR,
TV-OUT(PAL),128MB 276
Sapphire Radeon 9800Pro
128MB DDR, DVI, AGP8X 470

SCSI HARD-DISK 7200RPM &
10K RPM

Maxtor KU018L/J 18 GB Atlas,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 160
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 185
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 455

IBM IC35LO36UWD, 36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200
Quantum XC009J, 18GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 80
IBM IC35L009, 9GB, 68pin, 10Krpm,
SCSI160,  8MB cache 115
IBM DPSS 9170W, 9,1GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 95

Seagate Medalist Pro 4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah 10Krpm,
36,7GB U320, 36ES, 63,2ms, 4MB 190
Seagate Cheetah 10Krpm, 73GB,
U320, 36ES, 63,2ms, 4MB 530
Seagate Cheetah 15Krpm 18,4GB,
U160, x 3,9ms, 8MB cache 219
Seagate Cheetah 15Krpm 36,7GB,
U320, x 3,9ms, 8MB cache 397

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI, 640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300, 1300MB,
external firewire 450

PROSESOR

Athlon Xp 1800+ (Thoroughbred A) 45
Athlon XP 1900+ (Palomino) 52
Athlon Xp 2000+ (Thoroughbred A) 54
Athlon Xp 2100+ (Thoroughbred A) 57
Athlon XP 2200+ ((Thoroughbred A) 62
AthlonXP 2400+ fan (Thoroughbred B) 73
AthlonXP 2600+ (FSB333) + fan 88
AthlonXP 2800+ (Barton FSB333) 165
AthlonXP 3000+ (Barton FSB333) 215

Intel Pentium-4 1,6GHz)-423 126
Intel Pentium-4 1,8GHz, box, 478 138
Intel Pentium-4 3,06GHz, box),
478 Call
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 Call
Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 Call
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 180
Intel Pentium-4 2,53GHz,
512KB cache L2, FSB 533, 478 Call
Intel Pentium-4 2,66GHz,
(512) FSB 533 211
Intel Pentium-4 2,8GHz
(512) FSB 533 280
Intel Pentium-4 2,4GHz, 512KB,
FSB800, 478 196
Intel Pentium-4 3.0GHz, 512KB,
FSB800, 478 Call
Intel Celeron 1,7GHz, c/128 64
Intel Celeron 1,8GHz, c/128 73
Intel Xeon Pentium-4 1,8GHz
512KB cache L2, MPGA 194
Intel Xeon Pentium-4 2,0AGHz,
512KB cache L2, MPGA 239
Intel Xeon Pentium-4 2,4AGHz,
512KB cache L2,FSB 533, MPGA 250
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Pemenang Kuis Edisi 143/III/2002:
HADIAH SOUVENIR PCplus

1. Luqmanul Hakim
Jl. Budimulia RT.12/13 No.9
Pademangan Barat - Jakarta 14420

2. Apriandi RS.
Jl. Melati III B6/13 Perum PUP Bekasi Utara
Jawa Barat 17125

3. Amran Didik P.
Jl. Letjen Soeprapto Gg. V/36
Bondowoso - Jawa Timur 68211

4. Eddy Hartanto
Jl. Kertosentono 3 Malang
Jawa Timur 65145

5. Supriadi
Jl. Sudimoro 8 RT.3/6 Malang
Jawa Timur 65142

KUIS Kemarin dulu si Ciplus ditanya oleh Febi. "Ke warnet yuk, kita
main game online? Sekarang lagi ada game yang heboh nih", kata si
Febi. "Game online? Boleh juga sih. Tapi kapan-kapan aja deh, aku lagi

mau tamatin game Vietcong", kata si Ciplus. Setelah ia tamat main Vietcong, sekarang si Ciplus ingin
main game online. "Apa namanya ya?", pikir si Ciplus. Tolong dong si Ciplus, sebutkan 3 saja
game online yang sedang marak saat ini! Tuliskan jawaban tersebut di sehelai kartu pos dengan
mencantumkan alamat yang jelas dan sudah dibubuhi Kupon Kuis asli (di pojok kanan). Jangan
menunda-nunda, karena jawaban sudah harus masuk ke meja Redaksi PCplus paling lambat tanggal
03 November 2003. PCplus akan memberikan 5 buah kaos PCplus untuk 5 orang pemenang
yang menjawab dengan benar dan beruntung! Buruan!!!

Para pemenang tidak dibebani pungutan atau biaya apapun atas undian ini
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Jawaban Kuis No. 143/III/2002: Indosat M2, CBN, Biznet

DigiColor TNT2/M64 nVIDIA,
32 MB SDR, CRT 24
DigiColor GF2 MX400 nVidia,
64 MB SDR, CRT 34
DigiColor GF4 MX440se nVidia
LMA II, 64 MB 128-bit DDR 350 Mhz,
CRT+TV out 49
DigiColor GeForce FX5200,
nVidia LMA II, 64 MB 128-bit,
CRT, TV out                               80
DigiColor GeForce FX5600
nVidia LMA II, 128 MB 128-bit DDR,
Tv- out 165
DigiColor GeForce FX5600
nVidia LMA II 256MB 128-bit DDR,
TV-out                                     198

Impact mx440 64mb DDR,
AGP8X tv out 47
Impact Ti4200 64mb, tv out,dvi 130
Impact Ti4200 128mb, AGP 8X,
128ddr tv out,dvi,vivo 155
Impact GeForceFX5200 128MB DDR,
tv out,dvi,vivo, AGP8X 80

Gigabyte R9700 Pro, radeon 9700pro,
TV-out S/RCA, DVI port DVI-I 342
Gigabyte R9500 , radeon 9500,
TV-out S/RCA, DVI port DVI-I 167
Gigabyte R9000 Pro, ATI Radeon
9000Pro, 64MB DDR, TV-out,
S-Video, Twin View, DVI Port 97
Gigabyte R9000, ATI Radeon 9000,
64MB,  DDR, TV-out 73
Gigabyte R9600 Pro,
ATI Radeon 9600 Pro, 128MB DDR 212
Gigabyte R-9800 Pro, Radeon 9800Pro,
380MHz/ 680MHz, 256MB 547
Gigabyte R-9200 (VIVO), Radeon 9200,
250MHz/ 400MHz, 128MB 117

Gigacube Radeon 9800 Pro 256MB 550
Gigacube Radeon 9800 Pro 128MB 440
Gigacube Radeon 9700 Pro 128MB 340
Gigacube Radeon 9600 Pro 128MB 185
Gigacube Radeon 9600  128MB 160
Gigacube Radeon 9200  128MB 98
Gigacube Radeon 9100  128MB 85
Gigacube Radeon 9000  64MB 60

CD-RW DRIVE

Samsung CD ROM 52X 18

Aopen CD-ROM 56X OEM 23
Aopen CD-RW3248 32x12x48 50
Aopen CD-RW4850 48x12x50x 80
Aopen CD_RW 40x12x48 box 60
Aopen external CD-RW 40x12x48 box 135
Aopen DVD + CD RW combo
ultra slim, box 290

ION CD ROM 52X 19

Mitsumi CD-ROM 54x 22
Mitsumi CD-RW 48x24x48 48

Asus CD-RW external 5224 A-U
(USB) 52x24x48 136
Asus external slim combo SCB 2408-D 210
Asus DVD-R/RW 4x2x12x 268
Asus CRW 5224A, 52x24x48 53
Asus DVD 16x 44

TDK CDRW 52x24x48 D
second edition black 50
TDK CDRW 52x24x48 D
second edition white 48
TDK CDRW 48x16x48 USB
External 2.0 115
TDK CDRW 52x24x52 int IDE
loose pack 65
TDK DVD-RW 440 250

RICOH CD RW 32x10x40 90

Plextor CD RW 8x8x24 external
USB slim 150
Plextor CD RW 24x10x40 external
USB slim 185
Plextor CD RW 24x10x40 external USB 120
Plextor CD RW 12x10x32 SCSI external 285
Plextor CD RW Combo DVD
8x8x24 ext USB 2.0 255

Pioneer DVD ROM  A06 265
Pioneer DVD-RW  A05 (2X8) 225

Whale CD ROM 56x 20
Whale CD-RW 52x24x52 47

TV TUNER

MSI TV Anywhere, conexant
CX23883, remote, video editing 52
Jetway USB, TV tuner, radio,
remote USB 67

PixelView Play TV USB 2.0,
ext USB TV tuner + FM radio, remote 90
PixelView Play TV HD/s,
TV tuner card + FM radio, remote 55
PixelView Play TV HD,
TV tuner card + FM radio 43

MONITOR

Prolink Chameleon 150A 275
Prolink Chameleon 170A 445
Prolink Chameleon 170V 470
Prolink Chameleon 170T 550

BenQ FP567s , LCD 15" 269
BenQ FP767, LCD 17" 399
BenQ FP731 , LCD 17" 379
BenQ FP581s , LCD 15" 329
BenQ FP781 , LCD 17" 459
BenQ FP591 , LCD 15" 480
BenQ FP791 , LCD 17" 605
BenQ FP882 , LCD 18" 725

LCD Monitor Colortac LM 15Xn 298
LCD Monitor Colortac LM 17Xn 495

EIZO L355 LCD 15"/38cm 340
EIZO L565 LCD 17"/45cm 675
EIZO F77 CRT 21"/55cm 750
EIZO L685 LCD 18"/46cm 1215
EIZO Placeo  (LCD panel 17"/45cm) 790

Acer AC501, CRT 15" 79
Acer AC711, CRT 17" 99
Acer AF705, CRT 17" real flat 159
Acer AC915, CRT 19" 209
Acer AL506, LCD 15" 260
Acer AL511, LCD 15" 250

Acer AL1531, LCD 15" 379
Acer AL1722 M, LCD 17" 519
Acer AL922, LCD 19" 979

UPS

Prolink Pro 600D, 600VA,
AVR 160-270V, 54
Prolink Pro 600S, 600VA,
AVR 160-270V, software monitor 59
Prolink Pro 1200, 1200VA,
AVR 160-270V, software monitor 99

Nexus N-600B, 600VA with AVR 46
Nexus N-600S, 600VA
with AVR +software 51
Nexus N-1200B, 1200VA with AVR 82
Nexus N-1200S, 1200VA
with AVR + software 87
Nexus B-12V7AH,
Battery UPS 12V 7AH 12

MOUSE

Samsung Smart Bettle PS2 12
Samsung Smart Bettle USB 12
Samsung Cyber Bettle USB 13

Comfort MUS 4D 4
Aopen keyboard KB-858P 107 key 10

SM 100 optic Mini PS2 13
SOM 3100 Optic Wheel LED PS2 13
SOM 3200 Optic Wheel PS2 12.5
SCM 5100 Cordless Optic Combo 26
SOM 3500 Optical Neon Mouse 14
SW 1000 Wheel PS2, lose pack 5.5
SW 1000 Wheel w/ LED PS2 6.5

Nexus 8D5-P, 8D scroll ball PS/2 7
Nexus 8D5-U, 8D scroll ball USB 7,5
Nexus 8D6-P, 8D Scroll ball PS/2 11,5
Nexus 8D6-C, 8D scroll ball,
optical mouse combo 12
Nexus RF2-P, RF scroll,
ball mouse PS/2 10,5
Nexus RFI-P, RF scroll,
optical mouse PS/2 22
Nexus RF2U+KB1, RF scroll,
ball mouse, + RF keyboard 31
Nexus 3DN-U, mouse blue scroll,
optical USB 9

Whale Optical Mouse PS/2 11
Whale Optical Mouse USB 12

PRINTER

CANON PRINTER BJC-55 266
CANON PRINTER BJC-2100SP 62
CANON PRINTER i70 265
CANON PRINTER S2SPx 56
CANON PRINTER i950 300
CANON PRINTER  S200SPx 58
CANON PRINTER  S820 175
CANON PRINTER  S830D 410
CANON PRINTER  i550 165
CANON PRINTER  i850 225
CANON PRINTER  S530D 195
CANON PRINTER  i320 82

Samsung laser printer ML1210 210
Samsung laser printer ML1450 300

Lexmark Z-605 4800x1200, USB, 14ppm 59
Lexmark Z-55 3600x1200, USB,
paralel, 17ppm 170
Lexmark Z-65 4800x1200, USB, 21ppm 235
Lexmark Z-65n 4800x1200, 21ppm,
SUB & ethernet 299
Lexmark Z-42 2400x1200, USB,
paralel, 10ppm 125
Lexmark X-5150 All in One
4800x1200, USB, 19ppm, A4 280
Lexmark X-1150 All in One
4800x1200, USB, 19ppm, A4 138

SCANNER

CANON CANOSCAN D-646UEX 55
CANON CANOSCAN FS-4000US 700
CANON CANOSCAN 5000F 208
CANON CANOSCAN Lide50 125
CANON CANOSCAN 3000F 143
CANON CANOSCAN 5000F 208
CANON CANOSCAN Lide-20 65
CANON CANOSCAN Lide-30 95

Prolink Winscan Pro 2448U,
1200x2400 opt res, ccd,
48 bit color, USB 82

Astra 2500 545.000,-
Astra 4600 850.000,-
Astra 4700 1.575.000,-
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